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Chapter 1

はじめに

このドキュメントは、Quantum GISのオリジナルユーザーガイドです.このドキュメントで説明されるソフト
ウェアとハードウェアは,ほとんどの場合は登録商標であり,そのあつかいは法に従うものとします.Quantum
GIS のライセンスは GNU の General Public License（GPL）に従います. 詳細は Quantum GIS Homepage
http://www.qgis.orgを参照して下さい.

このドキュメントの詳細,データ,結果等は著者と編集者の最善の知識と責任により記述され,検証されてい
ます.それにもかかわらず,内容に関して誤りがある可能性があります.

従って,すべてのデータは義務や保証を負うわけではありません. 著者,編集者ならびに出版者は,誤りとそ
こから生じる結果について,いかなる責任も負いません.誤りがあれば指摘をいただくことをいつでも歓迎
します.

This document has been typeset with reStructuredText. It is available as reST source code via github and online
as HTML and PDF via http://documentation.qgis.org. Translated versions of this document can be downloaded in
several formats via the documentation area of the QGIS project as well. For more information about contributing
to this document and about translating it, please visit: http://www.qgis.org/wiki/.

このドキュメントにおけるリンク

このドキュメントには内部リンクと外部リンクがあります. 外部リンクをクリックするとインターネットの
アドレスを開きますが,内部リンクをクリックするとこのドキュメント内を移動します. PDFフォームでは,
内部リンクは青色で表示され,外部リンクは赤色で表示され、いずれもシステムブラウザにより処理されま
す.HTMLフォームでは,内部,外部リンク双方ともブラウザは同様の表示と処理を行います.

ユーザ,インストールとコーディングガイドの著者と編集者:

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jrgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann

Sponsors

The update of this user manual was kindly sponsored by Kanton Solothurn, Switzerland.

Copyright (c) 2004 - 2013 QGIS Development Team

インターネット: http://www.qgis.org

このドキュメントのライセンス

GNU Free Documentation License V1.3または、フリーソフトウェア財団によって発行されたそれ以降のバー
ジョンの規約に基づき、同ライセンスに必要とされる形式に沿っていない表紙、背表紙、不可変更部分を
除いて、このドキュメントに対する複製、頒布、および/または　改変を許可しています。ライセンスのコ
ピーは、付録に含まれています。（参照： gfl_appendix）

1

http://www.qgis.org
https://github.com/qgis/QGIS-Documentation
http://documentation.qgis.org
http://www.qgis.org/wiki/
http://www.so.ch/departemente/bau-und-justiz/amt-fuer-geoinformation.html
http://www.qgis.org




Chapter 2

記述ルール

このセクションではこのマニュアル全般にわたる統一した記述ルールについて列挙します.このマニュアル
で利用する記述ルールは以下のとおりです:

GUI記述ルール

GUIの記述スタイルは GUIの外観をまねるように意図されています.一般的にこれの目的は non-hoverの
外観を利用することです,ですからユーザーは GUIの外観を見てマニュアルの操作手引きと同じようなも
のを見出せます.

• メニューオプション: :メニュー選択:‘レイヤ –>ラスタレイヤの追加 ‘または :メニュー選択:‘設定 –>
ツールバー –>デジタイジング ‘

• ツール: ラスタレイヤの追加

• ボタン : [デフォルトとして保存]

• ダイアログボックスタイトル: レイヤプロパティ

• タブ: 一般情報

• チェックボックス: 描画

• ラジオボタン: Postgis SRID EPSG ID

• 数値選択:

• 文字列選択:

• ファイルのブラウズ:

• 色選択:

• スライダ:

• テキスト入力:

影はクリック可能な GUIコンポーネントを表します.

テキストまたはキーボードについての記述ルール

このマニュアルではテキストに関するスタイル,キーボードコマンド,クラスやメソッドのコーディングを
別のエンティティにするスタイルを含みます.これらは実際の見かけには依存しません.

• ハイパーリンク: http://qgis.org

• キーボード押下の組み合わせ: press Ctrl+B, Ctrlキー押下とホールドと Bキーを同時に押すことを
意味します.

• ファイル名: lakes.shp

3
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• クラス名: NewLayer

• メソッド: classFactory

• サーバ: myhost.de

• ユーザ入力テキスト: qgis --help

Lines of code are indicated by a fixed-width font

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

プラットフォーム依存の操作

GUIの操作や少量のテキストはインラインで記述できます: クリック ファイル QGIS → QGIS終了.

これは Linux, UnixとWindowsプラットフォームではファイルメニューオプションを最初にクリックしてか
らドロップダウンメニューから終了することを示します.また, Macintosh OSXプラットフォームでは,QGIS
メニューオプションを最初にクリックしてドロップダウンメニューから終了することを示しています.より
文字数の多い箇所では次のようにリスト形式で表示します:

• Linux Unixの部分です;

• Windowsの場合です;

• MacOSXについての部分です.

次のように、パラグラフの先頭に付けて区別することもあります.

Linux、Unix、Macintosh OSXプラットフォーム向けの解説です.文章中の解説手順に基づいて作業し
てください.

Windowsプラットフォーム向けの解説です.文章中の解説手順に基づいて作業してください.

ユーザーガイド中のスクリーンショットはいろいろなプラットフォームで作成されています.その時のプラッ
トフォームはプラットフォームの種別を示すアイコンが図のキャプションの最後に表示されます.
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Chapter 3

序文

地理情報システム (GIS)のすばらしい世界へようこそ!

Quantum GIS (QGIS)はオープンソースの地理情報システムです.このプロジェクトは 2002年 5月に開始
され,同じ年の 6月 SourceForgeのプロジェクトを立ち上げました. （かつては高価で独占的ソフトであっ
た)GISソフトウェアを作成する作業は困難を伴いました.このソフトウェアはだれでもパーソナルコンピュー
タを使って地理情報に関する基本的作業に使う有効な手段になります.QGISは多くの Unix,Windows,OS X
で動作します.QGISは　 Qt toolkit (http://qt.nokia.com)と C++で開発されています.これによっては QGIS
は軽快で使いやすいグラフィカルユーザーインターフェース (GUI)を利用できるようになりました.

QGISはGISの一般的は機能や特徴をそなえた使いやすいシステムになることをねらってます.最初のQGIS
の開発目標は GISデータの表示システムでした.多くの人が GISのデータを見たいという要求を持ってい
たのでこの目標は達成されました.QGISは多くの種類のラスタデータとベクタデータをサポートします.ま
たプラグイン方式を利用することで新たなデータ形式に簡単に対応できます.

QGISは GNU General Public License (GPL)でリリースされています. QGISはこのライセンスで開発され
ているのであなたはソースコードを調べたり改造することができます.いつでも無料でGISプログラムにア
クセスでき,自由に改造できます. その場合 QGISのライセンスの全てを適用する必要があります.ライセン
スの詳細は Appendix GNU General Public License.を参照してください.

ちなみに: Up-to-date Documentation
The latest version of this document can always be found in the documentation area of the QGIS website at
http://documentation.qgis.org

3.1 GIS入門

地理情報システム (GIS) (Mitchell 2005文献と Web参照)とは地理空間データを作成,表示,検索,解析する
ためのソフトウェアのことです. 空間データは同じ意味で別の言い方がいくつかあります.地理データ, GIS
データ,地図データ,位置データ,座標データ,地理空間データなどです.

空間データを利用するアプリケーションには様々な機能があります.地図作成機能が空間データ利用に最も
わかりやすい仕事でしょう.地図プログラムは空間データにアクセスしてそれを描画して可視化します.通
常はコンピュータの画面や紙を利用して地図を表示します.アプリケーションでは静的な地図（単純なイ
メージ）かダイナミックに表示を変えられる地図を表示します.ダイナミックな地図はデスクトッププログ
ラムかWebページを使って地図のみかけを変えることができます.

多くの人たちは空間情報アプリケーションの機能は地図を作成するだけだと誤解しています.しかし空間
データ解析は空間情報アプリケーションの別の重要な機能です.いくつかの典型的な解析処理はコンピュー
タの計算処理を含んでいます:

1. 位置間の距離計算

2. ある領域内の面積集計 (たとえば平方メートル)

5
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3. どの地物が他の地物と重なりあっているかの判定

4. 地物間の重なり部分の集計

5. ある位置から指定した距離内にある地物の数

6. 等々...

これらのことは単純なことのように見えるかもしれません.しかしこれらの機能はいろいろな方法で多くの
分野に適用できます.分析の結果を地図上に表示することは経営の意思決定をサポートするレポートとして
頻繁に使われます.

最近の位置情報サービスでは多くの機能を紹介しています.それらの機能の多くは地図と解析処理の組み
合わせで構成されています.たとえば携帯電話であなたの位置を記録できます.あなたが適切なソフトウェ
アを持っていれば歩いていける距離にあるレストランを携帯電話で探せます.これは空間情報テクノロジー
のを使った新しいアプリケーションです.この機能のためには空間データを解析して結果を一覧にするこ
とが必要です.

3.1.1 それは何か新しい機能なんでしょうか?

いいえちがいます.空間情報サービスをモバイルで利用するための新しい機器はたくさんあります.そのた
めに多くのオープンソース空間情報アプリケーションは利用できますが,既存の空間情報用ハードウェアと
ソフトウェアはなにか新しいものではありません.グローバルポジショニングシステム (GPS)レシーバー
は 10年以上もの間様々な産業で使われるようになり,ありふれたデバイスになりました.同じようにデスク
トップマッピングと解析ツールは大きなコマーシャルマーケットを形成しています.たとえば自然資源管理
の産業などが主要な対象です.

新しいことというのは最新のハードウェアとソフトウェアが利用されていることと,誰がそれを使っている
かということです.旧来のマッピングと解析ツールのユーザーは GISアナリストか CADツール利用と同じ
ようなデジタルマッピングについて高度に訓練されたユーザーです.現在は家庭用 PCの計算能力とオープ
ンソースソフトウェア (OSS)パッケージの利用によってホビイスト,プロフェッショナル,WEB開発者等の
大群が空間データを扱えるようになりました.学習曲線は低下しています.コストも低下しています.空間情
報テクノロジの進化は加速しています.

どのように空間データは保存されているでしょうか？一言でいえば 2つのタイプの空間データの利用が今
日では幅広い支持を集めています.これに加えて伝統的な表形式データも空間アプリケーションで幅広く利
用されています.

3.1.2 ラスタデータ

空間データの一つのタイプはラスタデータまたは単に”ラスタ”とよばれます.ラスタデータとして最もわ
かりやすい例がデジタル衛星写真や航空写真です. 標高の陰影図やデジタル標高モデルも典型的なラスタ
データといえます. 任意のタイプの地図地物はラスタデータとしてあらわすことができます.しかし制限が
あります.

ラスタデータはセルによって構成される規則的な格子,またはピクセルで構成されるイメージで形成され
ています.それらは固定の行と列でできています.それぞれのセルは数値と地理上のサイズ (例 30x30メー
ター)を持っています.

複数の重なったラスタは 1個の色の値を使って表現されます (例　一つのラスタは赤、緑、青の値の重ね合
わせでカラーイメージを作成します).衛星イメージは複数の”バンド”で構成されます.それぞれのバンド
は特有の光学波長持ち分離させられており,空間的に重ね合わせられます.また広範なラスタはより大きな
ファイルサイズが必要になることが想像できます.

ラスタのセルサイズが小さくなればさらに詳細がわかりますが,これはファイルスペースの増大もまねきま
す. セルのサイズを記憶する目的と,解析またはマッピングに利用するためのセルサイズのバランスを見出
すことが計略として必要です.
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3.1.3 ベクタデータ

ベクタデータも地理情報アプリケーションで利用されます.あなたが三角法と空間幾何学の授業で起きてい
たならばベクタデータの特徴になじんでいるはずです.簡単にいうとベクタとは座標群を利用して位置を表
す方法です. それぞれの座標は xと yの値で表現されている地理座標システムを参照しています.

これは学校で教えている x軸と y軸で表わされるデカルト座標系を参考にしています.あなたもこのような
グラフを退職後の貯えの減少や複合ローンの利息の増加計算に使ったかもしれません.しかしこの概念は空
間データ解析とマッピングの本質的要素です.

あなたの目的に合致した空間情報表示方法はたくさんあります.これは地図投影という分野で別の日に勉強
すべき分野です.

ベクタデータには 3種類の形態があります,それぞれ進歩してさらに複合して構築されています.

1. 点 -単一座標 (x y)で個別の地理的位置を表します

2. Lines - Multiple coordinates (x1 y1, x2 y2, x3 y3, ... xn yn) strung together in a certain order, like drawing
a line from Point (x1 y1) to Point (x2 y2) and so on. These parts between each point are considered line
segments. They have a length and the line can be said to have a direction based on the order of the points.
Technically, a line is a single pair of coordinates connected together, whereas a line string is multiple lines
connected together.

3. 多角形 -複数のラインが 2点以上の連続で並び,最後の点が最初の点と等しい場合を多角形とします.
三角形,円,四角形,etcはすべて多角形です. 多角形の特徴は固定領域が内部にあることです.

3.1. GIS入門 7





Chapter 4

特徴

QGISは通常の GISの機能を本体のコア機能と多くのプラグインで提供してます. ここでは簡潔に 6つのカ
テゴリーに分けて特徴を説明します.

4.1 データを見る

異なる形式,投影法のベクタ,ラスタデータを内部形式に変換することなくそのまま閲覧したりオーバーレ
イ表示することができます. 利用できるデータ形式は以下の通りです:

• Spatially-enabled tables and views using PostGIS, SpatiaLite and MSSQL Spatial, vector formats supported
by the installed OGR library, including ESRI shapefiles, MapInfo, SDTS, GML and many more, see section
Working with Vector Data.

• Raster and imagery formats supported by the installed GDAL (Geospatial Data Abstraction Library) library,
such as GeoTiff, Erdas Img., ArcInfo Ascii Grid, JPEG, PNG and many more, see section Working with
Raster Data.

• GRASSデータベース (location/mapset)の GRASSラスタとベクタ. GRASS GISの統合参照.

• Web Map Service (WMS)またはWeb Feature Service (WFS)の OGC準拠オンライン空間データサー
ビス,セクション Working with OGC Data参照.

• OpenStreetMap data, see sectionオープンストリートマップ.

4.2 データの検索と表示地図の構成

表示地図の構成と空間データの検索のために使いやすいグラフィカルユーザーインターフェースを使えま
す多くの便利なツールがグラフィカルユーザーインターフェースに含まれています:

• QGISブラウザ

• On the fly projection

• Map composer

• Overview panel

• Spatial bookmarks

• Identify/select features

• Edit/view/search attributes

• Feature labeling

• Change vector and raster symbology

9
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• Add a graticule layer - now via fTools plugin and as decoration

• Decorate your map with a north arrow scale bar and copyright label

• Save and restore projects

4.3 データの作成、編集、管理と出力

様々な形式のベクタ形式地図を作成,編集,管理,出力することができます.ラスタデータは GRASSにイン
ポートして編集できます.また他の形式で出力できます. QGISでは以下のことができます:

• Digitizing tools for OGR supported formats and GRASS vector layer

• Create and edit shapefiles and GRASS vector layers

• Geocode images with the Georeferencer plugin

• GPS tools to import and export GPX format, and convert other GPS formats to GPX or down/upload directly
to a GPS unit (on Linux, usb: has been addedto list of GPS devices)

• Visualize and edit OpenStreetMap data

• Create PostGIS layers from shapefiles with the SPIT plugin

• Improved handling of PostGIS tables

• Manage vector attribute tables with the new attribute table (see section Working with the Attribute Table) or
Table Manager plugin

• Save screenshots as georeferenced images

4.4 データ解析

You can perform spatial data analysis on PostgreSQL/PostGIS and other OGR supported formats using the fTools
Python plugin. QGIS currently offers vector analysis, sampling, geoprocessing, geometry and database manage-
ment tools. You can also use the integrated GRASS tools, which include the complete GRASS functionality of
more than 400 modules (See Section GRASS GISの統合). Or you work with SEXTANTE, which provides pow-
erful a geospatial analysis framework to call native and third party algorithms from QGIS, such as GDAL, SAGA,
GRASS, fTools and more (see section SEXTANTE).

4.5 インターネットへの地図公開

QGIS can be used to export data to a mapfile and to publish them on the Internet using a webserver with UMN
MapServer installed. QGIS can also be used as a WMS, WMS-C or WFS and WFS-T client, and as WMS or WFS
server (see section Working with OGC Data).

4.6 プラグインを使ったQGIS機能の拡張

QGISではプラグインアーキテクチャーで個別の機能拡張要求に対応できます. QGISで提供するライブラ
リを利用してプラグインを作成することができます. また C++言語か Pythonスクリプトを利用して新たな
アプリケーションを作成することもできます!
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4.6.1 コアプラグイン

1. Add Delimited Text Layer (Loads and displays delimited text files containing x,y coordinates)

2. Coordinate Capture (Capture mouse coordinates in different CRS)

3. データベース管理 (交換,編集とレイヤとテーブルの閲覧,SQLクエリの実行)

4. Diagram Overlay (Placing diagrams on vector layer)

5. Dxf2Shp Converter (Convert DXF to Shape)

6. GPS Tools (Loading and importing GPS data)

7. GRASS (GRASS GIS integration)

8. GDALTools (Integrate GDAL Tools into QGIS)

9. Georeferencer GDAL (Adding projection information to raster using GDAL)

10. Heatmap tool (Generating raster heatmaps from point data)

11. Interpolation plugin (interpolate based on vertices of a vector layer)

12. Mapserver Export (Export QGIS project file to a MapServer map file)

13. Offline Editing (Allow offline editing and synchronizing with database)

14. OpenStreetMap plugin (Viewer and editor for openstreetmap data)

15. Oracle Spatial GeoRaster support

16. Plugin Installer (Download and install QGIS python plugins)

17. Raster terrain analysis (Raster based terrain analysis)

18. Road graph plugin (Shortest Path network analysis)

19. SPIT (Import Shapefile to PostgreSQL/PostGIS)

20. SQL Anywhere Plugin (Store vector layers within a SQL Anywhere database)

21. Zonal statictics plugin (Calculate count, sum, mean of raster for each polygon of a vector layer)

22. Spatial Query plugin (Makes spatial queries on vector layers)

23. eVIS (Event Visualization Tool)

24. fTools (Tools for vector data analysis and management)

4.6.2 外部 Pythonプラグイン

QGIS offers a growing number of external python plugins that are provided by the community. These plugins
reside in the official plugins repository, and can be easily installed using the Python Plugin Installer (See Section
QGIS外部プラグインをロードする).

4.7 バージョン 1.8の新機能

Please note that this is a release in our ‘cutting edge’ release series. As such it contains new features and extends
the programmatic interface over QGIS 1.0.x and QGIS 1.7.0. We recommend that you use this version over
previous releases.

This release includes hundreds of bug fixes and many new features and enhancements that will be described in
this manual.

QGIS Browser

A stand alone app and a new panel in QGIS. The browser lets you easily navigate your file system and connection
based (PostGIS, WFS etc.) datasets, preview them and drag and drop items into the canvas.

4.7. バージョン 1.8の新機能 11
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DB Manager

The DB manager is now officially part of QGIS core. You can drag layers from the QGIS Browser into DB
Manager and it will import your layer into your spatial database. Drag and drop tables between spatial databases
and they will get imported. You can use the DB Manager to execute SQL queries against your spatial database
and then view the spatial output for queries by adding the results to QGIS as a query layer. You can also create,
edit, delete, and empty tables, and move them to another schema.

Terrain Analysis Plugin

A new core plugin was added for doing terrain analysis (slope, aspect, hillshade, relief and ruggedness index).

New symbol layer types

• Line Pattern Fill

• Point Pattern Fill

• Ellipse renderer (render ellipse and also rectangles, triangles, crosses)

New plugin repository

Note that the old repository is now no longer supported by default; plugin authors are kindly requested to move
their plugins to the new repository. Get the QGIS Plugins list at http://plugins.qgis.org/plugins/.

More new features

• Support for nesting projects within other projects to embed content from other project files

• Group Selected: Option to group layers to a group

• Message log: Lets you keep an eye on the messages QGIS generates during loading and operation

• GUI Customization: Allows setting up simplified QGIS interface by hiding various components of main
window and widgets in dialogs

• Action Tool is now accessible from the map tools toolbar and allows you to click on a vector feature and
execute an action

• New scale selector: select from a list of predefined scales

• Pan To Selected tool: Pans the map to selected feature(s); does not change the zoom level

• Copy and paste styles between layers

• Updated CRS selector dialog

• Define Legend-independent drawing order

• MSSQL Spatial Support - you can now connect to your Microsoft SQL Server spatial databases using QGIS

• Print Composers allows to have multiple lines on legend items using a specified character

• Expression based labeling

• Heatmap Plugin - a new core plugin has been added for generating raster heatmaps from point data

• The GPS live tracking user interface was overhauled and many fixes and improvements were added to it

• The menu was re-organised a little - we now have separate menus for Vector, Raster, Web and many plugins
were updated to place their menus in the new Vector, Raster and Web top level menus

• Offset Curves - a new digitising tool for creating offset curves was added

• New tools in the Vector menu to Densify geometries and Build spatial index

• Export/add geometry column tool can export info using layer CRS, project CRS or ellipsoidal measurements

• Model/view based tree for rules in rule-based renderer

• Improvements in Spatial Bookmarks

• New Plugin metadata in metadata.txt

12 Chapter 4. 特徴

http://plugins.qgis.org/plugins/


QGIS User Guide,リリース 1.8

• Refactored postgres data provider: support for arbitrary key (including non-numeric and multi column),
support for requesting a certain geometry type and/or srid in QgsDataSourceURI

• Added gdal_fillnodata to GDALTools plugin

• Support for PostGIS TopoGeometry datatype

• Python bindings for vector field symbol layer and general updates to the Python bindings

• Added a Benchmark program

• Added Row cache for attribute table

• UUID generation widget for attribute table

• Added support of editable views in SpatiaLite databases

• added expression based widget in field calculator

• Creation of event layers in analysis lib using linear referencing

• Load/save layer styles in the new symbology renderer from/to SLD document

• QGIS Server can act as WFS Server

• WFS Client support is now a core feature in QGIS

• Option to skip WKT geometry when copying from attribute table

• Support loading of zipped and gzipped layers

• The QGIS test suite now passes all tests on major platforms and nightly tests

• You can set tile size for WMS layers

4.7. バージョン 1.8の新機能 13





Chapter 5

はじめましょう

本章では,QGISのインストール,QGISウェブページにあるサンプルデータ,最初の実行と,ラスタとベクタ
のレイヤの表示を行うサンプル実行について説明します.

5.1 インストール

QGIS のインストールはとても簡単です。 MS Windows 用と Mac OS X 用の標準インストールパッケー
ジがあります. 各種 GNU/Linux 用バイナリパッケージ (rpm と deb) とインストールマネージャに追加す
るソフトウェアレポジトリが提供されています. バイナリパッケージの最新の情報は QGISウェブサイト
http://qgis.osgeo.org/download/にあります.

5.1.1 ソースからのインストール

If you need to build QGIS from source, please refer to the installation instructions. They are distributed with the
QGIS source code in a file called ‘INSTALL’. You can also find it online at https://github.com/qgis/Quantum-
GIS/blob/master/INSTALL

5.1.2 外部メディアへのインストール

QGISではデフォルトの作業環境パス (例. ~/.qgis Linuxの場合)を上書きする -configpathオプション
があります.ユーザー設定と QSettingsもこのディレクトリに設定されます.たとえばこのオプションを使う
とユーザーは QGISのインストレーションをすべての外部プラグインと設定込みで USBフラッシュメモリ
等で持ち運ぶことができます.

5.2 サンプルデータ

ユーザガイドには、QGISサンプルデータセットをもとにした例があります.

Windowsインストーラには|qg|サンプルデータセットをダウンロードするオプションがあります. これ
にチェックを入れると My Documents フォルダにサンプルデータがダウンロードされ GIS Database
フォルダにデータが作成されます. Windowsエキスプローラをこのフォルダに移動すると便利です. サンプ
ルデータセットインストールチェックボックスを選択しないことも|qg|初期インストールで指定することが
できます

• サンプル GISデータを利用する場合;

• QGISウェブサイト http://download.qgis.orgからダウンロードして下さい;または

• もし上記の方法がうまくいかない場合|qg|をアンインストールしてデータインストールオプションを
チェックして再インストールして下さい.

15

http://qgis.osgeo.org/download
https://github.com/qgis/Quantum-GIS/blob/master/INSTALL
https://github.com/qgis/Quantum-GIS/blob/master/INSTALL
http://download.qgis.org


QGIS User Guide,リリース 1.8

GNU/LinuxとMac OSXの rpm, debまたは dmg等のパッケージではデータセットのインストールは
用意されていません.サンプルデータセットを利用したい場合は:file:qgis_sample_data を ZIPまたは TAR
アーカイブ形式で http://download.osgeo.org/qgis/data/からダウンロードしてあなたのシステム上で unzipま
たは untarを行ってください Alaskaデータセットにはユーザガイドのスクリーンショットで使われている
がすべての GISデータセットが含まれています,また小規模な GRASSデータベースが含まれています. サ
ンプルデータセットの投影法は Alaska Albers Equal Areaで単位は feetです. EPSGコードは 2964です.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",

DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,

AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],

PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],

UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],

AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

もし QGISを GRASSのグラフィカルなフロントエンドとして利用したい場合,サンプルロケーション (例.
Spearfish または SouthDakota) を 公式 GRASS GIS ウェッブサイト http://grass.osgeo.org/download/data.php
　で見つけることができます.

5.3 サンプルセッション

Now that you have QGIS installed and a sample dataset available, we would like to demonstrate a
short and simple QGIS sample session. We will visualize a raster and a vector layer. We will use
the landcover raster layer qgis_sample_data/raster/landcover.img and the lakes vector layer
qgis_sample_data/gml/lakes.gml.

5.3.1 QGISの起動

• QGISを起動するにはコマンドプロンプトで “QGIS“とタイプするかプリコンパイルされたバイナ
リを利用する場合はアプリケーションメニューから起動できます.

• QGISを起動するにはスタートメニューまたはデスクトップのショートカットを使うか QGISプロ
ジェクトファイルをダブルクリックして下さい.

• QGISを起動するためにはスタートメニューかデスクトップショートカットの利用,または QGIS
プロジェクトファイルをダブルクリックして下さい.

5.3.2 ラスタレイヤとベクタレイヤのサンプルデータセットからのロード

1. Click on the Load Raster icon.

2. フォルダ qgis_sample_data/raster/,を開いて ERDAS Img file landcover.imgを選択した
後 [Open]をクリックします.
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3. ファイル名が表示されていないならファイルの種類コンボボックス (ダイアログの下部)が正しく設
定されているか確認してください.この場合は, “Erdas Imagine Images (*.img, *.IMG)”.となってい
るか確認して下さい.

4. ここで Load Vector アイコンをクリックします.

5. Add Vector Layer ダイアログで Fileがソースタイプとして選択されている必要があります . ここ
で [Browse]をクリックしてベクタレイヤを選択して下さい.

6. Browse to the folder qgis_sample_data/gml/, select “GML” from the filetype combobox, then select
the GML file lakes.gml and click [Open], then in Add Vector dialog click [OK].

7. いくつかの湖が表示されている場所を拡大して下さい.

8. 地図凡例にある lakes layerをダブルクリックして Propertiesダイアログを開いて下さい.

9. Styleタブをクリックして塗りつぶし色として青を選択して下さい.

10. Labelsタブをクリックして Display lablesチェックボックスをチェックしてラベル表示を有効にし
て下さい.NAMESフィールドをラベルが含まれているフィールドとして選択して下さい.

11. ラベルを読みやすくするために白のふちどり（バッファ)をラベルのまわりに設定することができま

す.,リストの左にある “Buffer”をクリックして Buffer labels? をチェックしてください.そして 3
をバッファサイズとして選択して下さい.

12. Click [Apply], check if the result looks good and finally click [OK].

You can see how easy it is to visualize raster and vector layers in QGIS. Let’s move on to the sections that follow
to learn more about the available functionality, features and settings and how to use them.

5.4 QGISの起動と終了

あなたはセクションサンプルセッションで QGISの起動方法を学んだはずです. ここではその部分の復習
と QGISが提供しているコマンドラインオプションについて説明します.

• QGISが PATHに設定されている場所にインストールされている場合コマンドプロンプトで: qgis
とタイプするかデスクトップまたはアプリケーションメニューにあるリンク（またはショートカット）
をダブルクリックすると QGISを起動することができます.

• スタートメニューまたはデスクトップショートカットの利用または QGISプロジェクトファイル
のダブルクリックで QGISを開始できます.

• アプリケーションフォルダーにあるアイコンをダブルクリックしてください.もし shellからQGISを
起動したい場合は次のコマンドを実行して下さい, /path-to-installation-executable/Contents/MacOS/Qgis.

QGISを終了するためには以下のメニューオプションをクリックしてください|nix| File QGIS → Quit
またはショートカット Ctrl+Q.

5.5 コマンドラインオプション

QGISはコマンドラインから起動すると多くのオプションを指定できます. オプションのリストは qgis
--helpとコマンドラインで入力すると取得できます. QGISで利用できるステートメントは以下のとおり
です:

qgis --help
Quantum GIS - 1.8.0-Lisboa ’Lisboa’ (exported)
Quantum GIS (QGIS) is a viewer for spatial data sets, including
raster and vector data.
Usage: qgis [options] [FILES]

options:
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[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--help] this text

FILES:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - Supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - Supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

ちなみに: Example Using command line arguments
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on startup
using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

コマンドラインオプション --snapshot

このオプションを使うと PNG形式でカレントビューのスナップショットを作れますこの機能によってたく
さんのプロジェクトをもっている場合でも簡単にスナップショットを作ることができます

このオプションを使うと 800x600ピクセルの PNGファイルが作成されます. --widthと ‘‘–height‘‘をコ
マンドライン引数に加えることでサイズの調整ができます. ‘‘–snapshot‘‘の後にファイル名を指定できます.

コマンドラインオプション --lang

Based on your locale QGIS, selects the correct localization. If you would like to change your language,
you can specify a language code. For example: --lang=it starts QGIS in italian localization. A list of
currently supported languages with language code and status is provided at http://hub.qgis.org/wiki/quantum-
gis/GUI_Translation_Progress

コマンドラインオプション --project

QGISをすでに存在するプロジェクトファイルとともに起動することが可能です.それはコマンドラインに
--projectオプションをつけてその後にプロジェクト名を追加するだけで実行できます.そうするとプロ
ジェクトファイルに記述されたレイヤをロードして QGISが起動します.

コマンドラインオプション --extent

ある地図の領域を指定してQGISを起動する場合はこのオプションを使います.この場合下記のようにカン
マで区切られた書式の領域指定で領域を包含する長方形を指定する必要があります:

--extent xmin,ymin,xmax,ymax

コマンドラインオプション --nologo

このコマンドライン引数を指定すると QGIS起動時にスプラッシュスクリーンを表示しません.

コマンドラインオプション --noplugins

起動時にプラグインのトラブルがある場合スタートアップ時にプラグインのロードを無効にすることがで
きます.それらのプラグインは後にプラグインマネージャで有効にすることができます.

Command line option --nocustomization
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Using this command line argument existing GUI customization will not be applied at startup.

コマンドラインオプション --optionspath

QGISの設定情報をコンピュータ内の複数の場所に作成しておけます.そしてQGISの起動時にこのオプショ
ンを利用してどの設定を利用するのかを指定できます. Optionsを参照して利用しているオペレーティング
システムがどこに設定ファイルを保存しているかをチェックして下さい.現在 QGISシステムでどのファイ
ルに設定を書き込むべきかを特定する方法がありません. それゆえ新しい設定を作成する場合は既存の設定
ファイルをコピーしたあとでファイルの名前を変更して下さい.

コマンドラインオプション --configpath

This option is similar to the one above, but furthermore overrides the default path (~/.qgis) for user configuration
and forces QSettings to use this directory, too. This allows users to e.g. carry QGIS installation on a flash drive
together with all plugins and settings.

5.6 プロジェクト

The state of your QGIS session is considered a Project. QGIS works on one project at a time. Settings are either
considered as being per-project, or as a default for new projects (see Section Options). QGIS can save the state of

your workspace into a project file using the menu options File → Save Project or File → Save Project As.

Load saved projects into a QGIS session using File → Open Project or File → Open Recent Project.

If you wish to clear your session and start fresh, choose File → New Project. Either of these menu options
will prompt you to save the existing project if changes have been made since it was opened or last saved.

以下の情報はプロジェクトファイルに保存されます:

• 追加されたレイヤ群

• シンボライゼーションを含むレイヤプロパティ

• マップビューの投影法

• 最後に表示された領域座標

プロジェクトは XML形式で保存されます.よって、方法がわかれば QGISを利用しなくてもプロジェクト
ファイルを編集することができます.ファイルの形式は以前の QGISのバージョンに比較すると頻繁に更新
されます.古い QGISのプロジェクトファイルはプロパティを設定することはできません.この問題を解決
するためには Settings → Optionsで表示される Generalタブで選択設定できます:

Prompt to save project changes when required

Warn when opening a project file saved with an older version of QGIS

5.7 出力

QGISのセッションから出力を行う方法はたくさんあります.セクションプロジェクトでプロジェクトファ
イルに出力する方法は解説しました.ここではその他の外部ファイルに出力する方法の例を説明します:

• Menu option File → Save as Image opens a file dialog where you select the name, path and type of image
(PNG or JPG format). A world file with extension PNGW or JPGW saved in the same folder georeferences
the image.

• Menu option File → New Print Composer opens a dialog where you can layout and print the current
map canvas (see Sectionプリントコンポーザ).
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Chapter 6

QGIS GUI

When QGIS starts, you are presented with the GUI as shown below (the numbers 1 through 5 in yellow ovals refer
to the six major areas of the interface as discussed below):

Figure 6.1: QGIS GUI with Alaska sample data

ノート: ウィンドウの装飾（タイトルバーとか）は利用しているオペレーティングシステムやウィンドウ
マネージャによって見かけが異なります.

QGISの GUIは 5つの領域に分割されています:

1. メニューバー

2. ツールバー

3. 地図凡例

4. 地図ビュー

5. ステータスバー

これらの 5つの QGISインターフェースについては次のセクションで詳しく説明します.さらに 2つのセ
クションでキーボードショートカットとコンテキストヘルプについて解説します.
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6.1 メニューバー

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the icons of the corresponding tools
as they appear on the toolbar, as well as keyboard shortcuts. Keyboard shortcuts can also be configured manually
(shortcuts presented in this section are the defaults), using the [Configure Shortcuts] tool under Settings.

Although most menu options have a corresponding tool and vice-versa, the menus are not organized quite like the
toolbars. The toolbar containing the tool is listed after each menu option as a checkbox entry. Some menu options
only appear, if the corresponding plugin is loaded. For more information about tools and toolbars, see Section
ツールバー.

6.1.1 File

メニューオプション ショートカット リファレンス ツールバー

新規プロジェクト Ctrl+N seeプロジェクト ファイル

プロジェクトを開く Ctrl+O seeプロジェクト ファイル
最近使ったプロジェクトを開く→ seeプロジェクト

プロジェクトの保存 Ctrl+S seeプロジェクト ファイル

プロジェクトを名前をつけて保存 Ctrl+Shift+S seeプロジェクト ファイル

イメージで保存 see出力

新プリントコンポーザ Ctrl+P seeプリントコンポーザ ファイル

コンポーザマネージャ seeプリントコンポーザ ファイル
Print Composers → seeプリントコンポーザ

終了 Ctrl+Q
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6.1.2 Edit

メニューオプション ショートカット リファレンス ツールバー

取り消し Ctrl+Z see Advanced digitizing 先進的なデジタイズ

再実行 Ctrl+Shift+Z see Advanced digitizing 先進的なデジタイズ

地物の切り取り Ctrl+X see Digitizing an existing layer デジタジング

地物のコピー Ctrl+C see Digitizing an existing layer デジタジング

地物のペースト Ctrl+V see Digitizing an existing layer デジタジング

地物の追加 Ctrl+. see Digitizing an existing layer デジタジング

Move Feature(s) see Digitizing an existing layer デジタジング

選択物の削除 see Digitizing an existing layer デジタジング

地物の簡素化 see Advanced digitizing 先進的なデジタイズ

リングの追加 see Advanced digitizing 先進的なデジタイズ

部分の追加 see Advanced digitizing 先進的なデジタイズ

リングの削除 see Advanced digitizing 先進的なデジタイズ

部分の削除 see Advanced digitizing 先進的なデジタイズ

地物の変形 see Advanced digitizing 先進的なデジタイズ

オフセットカーブ see Advanced digitizing 先進的なデジタイズ

地物の分割 see Advanced digitizing 先進的なデジタイズ

選択地物の結合 see Advanced digitizing 先進的なデジタイズ

Merge attr. of selected Features see Advanced digitizing 先進的なデジタイズ

ノードツール see Digitizing an existing layer デジタジング

ポイントシンボルを回転する see Advanced digitizing 先進的なデジタイズ

After activating Toggle editing mode for a layer, you will find the Add Feature icon in the Edit menu depend-
ing on the layer type (point, line or polygon).

6.1.3 Edit (extra)

メニューオプション ショートカット リファレンス ツールバー

地物の追加 see Digitizing an existing layer デジタジング

地物の追加 see Digitizing an existing layer デジタジング

地物の追加 see Digitizing an existing layer デジタジング
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6.1.4 View

メニューオプション ショートカット リファレンス ツールバー

地図のパン 地図ナビゲーション

選択部分に地図をパンする 地図ナビゲーション

拡大 Ctrl++ 地図ナビゲーション

縮小 Ctrl+- 地図ナビゲーション
選択→ see地物の選択と選択解除 属性

地物情報表示 Ctrl+Shift+I 属性
計測→ see計測 属性

全域表示 Ctrl+Shift+F 地図ナビゲーション

レイヤの領域にズーム 地図ナビゲーション

選択部分のズーム Ctrl+J 地図ナビゲーション

直前の表示領域にズーム 地図ナビゲーション

次表示領域にズーム 地図ナビゲーション

Zoom Actual Size 地図ナビゲーション
地図整飾→

整飾参照

マップチップス 属性

新しいブックマーク Ctrl+B see空間ブックマーク 属性

ブックマークを見る Ctrl+Shift+B see空間ブックマーク 属性

再読み込み Ctrl+R 地図ナビゲーション
タイルスケールスライダ see Tilesets タイルスケール

6.1.5 Layer

メニューオプション ショートカット リファレンス ツールバー
New → see Creating a new Vector layer レイヤの管理
埋め込みレイヤとグループ ... seeプロジェクトの入れ子

ベクタレイヤの追加 Ctrl+Shift+V see Working with Vector Data レイヤの管理

ラスタレイヤの追加 Ctrl+Shift+R see QGISにラスタデータをロードする レイヤの管理

PostGISレイヤの追加 Ctrl+Shift+D see PostGIS Layers レイヤの管理

SpatiaLiteレイヤの追加 Ctrl+Shift+L see SpatiaLite Layers レイヤの管理

Add MSSQL Spatial Layer Ctrl+Shift+M see MSSQL Spatial Layers レイヤの管理

WMSレイヤの追加 Ctrl+Shift+W see WMS Client レイヤの管理

デリミテッドテキストレイヤの追加 seeデリミテッドテキストプラグイン レイヤの管理

新規 GPXレイヤの作成 see GPSプラグイン レイヤの管理

Oracle GeoRasterレイヤの追加 see Oracle GeoRasterプラグイン レイヤの管理

SQL Anywhereレイヤの追加 see SQL Anywhereプラグイン レイヤの管理

WFSレイヤの追加 レイヤの管理

スタイルのコピー seeスタイルタブ
次のページに続く
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Table 6.1 –前のページからの続き
メニューオプション ショートカット リファレンス ツールバー

スタイルの貼り付け seeスタイルタブ

属性テーブルのオープン 属性

編集を保存する デジタジング

編集モード切替 デジタジング
名前をつけて保存...
選択をベクタファイルとして保存... Working with the Attribute Table参照

レイヤの削除 Ctrl+D
レイヤの CRSを設定する Ctrl+Shift+C
レイヤの CRSをプロジェクトに設定する
プロパティ
クエリ...

ラべリング

全体図に追加 Ctrl+Shift+O レイヤの管理

全体図に全て追加

全体図から全て削除

全てのレイヤを表示 Ctrl+Shift+U レイヤの管理

全てのレイヤを隠す Ctrl+Shift+H レイヤの管理

6.1.6 Settings

メニューオプション ショートカット リファレンス ツールバー
パネル→ seeパネルとツールバー
ツールバー→ seeパネルとツールバー
フルスクリーンモードへ切り替え Ctrl-F

プロジェクトプロパティ ... Ctrl+Shift+P seeプロジェクト

カスタム CRS ... seeカスタム空間参照システム
スタイルマネージャ... see Style Manager
ショートカットの構成 ...
カスタマイゼーション ... see Customization
オプション ...

Options参照
スナッピングオプション ...

6.1.7 Plugins

メニューオプション ショートカット リファレンス ツールバー

Pythonプラグインを呼び出す see QGISプラグイン

プラグインの管理 seeプラグインの管理
Pythonコンソール
GRASS → see GRASS GISの統合 GRASS
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6.1.8 Vector

メニューオプション ショートカット リファレンス ツールバー
解析ツール→ see fToolsプラグイン
座標入力→ see座標取得プラグイン
データマネジメントツール→ see fToolsプラグイン
Dxf2Shp → see Dxf2Shpコンバータープラグイン ベクター
ジオメトリツール→ see fToolsプラグイン
ジオプロセッシングツール→ see fToolsプラグイン
GPS → see GPSプラグイン ベクター
調査ツール→ see fToolsプラグイン
道路グラフ→ see道路グラフプラグイン
空間検索→ see空間検索プラグイン ベクター

6.1.9 Raster

メニューオプション ショートカット リファレンス ツールバー
ラスタ計算機 seeラスタ計算機
Georeferencer → seeジオレファレンサプラグイン ラスタ
ヒートマップ→ seeヒートマッププラグイン ラスタ
データ補間→ seeデータ補間プラグイン ラスタ

Terrain Analysis see Raster Terrain Analysis Plugin
地域統計→ see地域統計プラグイン ラスタ
投影法→ see GDALツールズプラグイン
変換→ see GDALツールズプラグイン
抽出→ see GDALツールズプラグイン
解析→ see GDALツールズプラグイン
その他→ see GDALツールズプラグイン
GdalTools設定 see GDALツールズプラグイン

6.1.10 Database

メニューオプション ショートカット リファレンス ツールバー
DBマネージャ→ see DB Managerプラグイン データベース
eVis → see eVisプラグイン データベース
オフライン編集→ seeオフライン編集プラグイン データベース
Spit → see SPITプラグイン データベース

6.1.11 Web

メニューオプション ショートカット リファレンス ツールバー
MapServerエキスポート ... → see MapServer Exportプラグイン Web
メニュー:OpenStreetMap –> seeオープンストリートマップ OpenStreetMap
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6.1.12 Help

メニューオプション ショートカット リファレンス ツールバー

ヘルプコンテンツ F1 ヘルプ

What’s This? Shift+F1 ヘルプ
API文書

QGISホームページ Ctrl+H

QGISのバージョンをチェックする

アバウト

QGISスポンサー

Please not that for Linux the Menu Bar items listed above are the default ones in KDE window manager. In
GNOME, Settings menu is missing and its items are to be found here:

プロジェクトプロパティ ファイル
オプション 編集
ショートカットの構成 編集

スタイルマネージャ 編集

カスタム CRS 編集
パネル→ ビュー
ツールバー→ ビュー
フルスクリーンモードへ切り替え ビュー
タイルスケールスライダー ビュー
ライブ GPSトラッキング ビュー

6.2 ツールバー

ツールバーではメニューのほとんどと同じ機能を提供している上に対話的に地図を操作する機能を提供し
ています.ツールバーのそれぞれのアイテムではポップアップヘルプが提供されています.マウスでアイテ
ムの上を動かすとツールの簡単な説明が表示されます.

Every menubar can be moved around according to your needs. Additionally every menubar can be switched off
using your right mouse button context menu holding the mouse over the toolbars (read alsoパネルとツールバー).

ちなみに: ツールバーの復元
If you have accidentally hidden all your toolbars, you can get them back by choosing menu option Settings →
Toolbars →. If a toolbar disappears under Windows, which seems to be a problem in QGIS from time to time,
you have to remove \HKEY_CURRENT_USER\Software\QuantumGIS\qgis\UI\state in the registry.
When you restart QGIS, the key is written again with the default state, and all toolbars are visible again.

6.3 地図凡例

The map legend area lists all the layers in the project. The checkbox in each legend entry can be used to show or
hide the layer.

レイヤは選択してドラッグで上下に移動することによって Zオーダリングを変えることができます.Zオー
ダリングとは,凡例のリストでの表示順が地図表示のレイヤ表示順になることです.

Layers in the legend window can be organised into groups. There are two ways to do so:
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1. Right click in the legend window and choose Add Group. Type in a name for the group and press Enter.
Now click on an existing layer and drag it onto the group.

2. Select some layers, right click in the legend window and choose Group Selected. The selected layers will
automatically be placed in a new group.

To bring a layer out of a group you can drag it out, or right click on it and choose Make to toplevel item. Groups
can be nested inside other groups.

グループ用チェックボックスを使うとクループ内全レイヤの表示,非表示を 1回のクリックで行えます.

The content of the right mouse button context menu depends on whether the selected legend item is a raster or a

vector layer. For GRASS vector layers Toggle editing is not available. See section Digitizing and editing a GRASS
vector layer for information on editing GRASS vector layers.

ラスタレイヤ選択時のマウス右ボタンメニュー

• Zoom to layer extent

• Zoom to best scale (100 %)

• Show in overview

• Remove

• Set Layer CRS

• Set Project CRS from Layer

• プロパティ

• Rename

• Copy Style

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order

Additionally, according to layer position and selection

• Make to toplevel item

• Group Selected

ベクタレイヤ選択時のマウス右ボタンメニュー

• Zoom to layer extent

• Show in overview

• Remove

• Set Layer CRS

• Set Project CRS from Layer

• Open attribute table

• Toggle editing (not available for GRASS layers)

• Save as

• Save selection as

• Query

• Show Feature Count

• プロパティ
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• Rename

• Copy Style

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order

Additionally, according to layer position and selection

• Make to toplevel item

• Group Selected

レイヤグループ用マウス右ボタンメニュー

• Zoom to group

• Remove

• Set group CRS

• Rename

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order

It is possible to select more than one layer or group at the same time by holding down the Ctrl key while selecting
the layers with the left mouse button. You can then move all selected layers to a new group at the same time.

You are also able to delete more than one Layer or Group at once by selecting several Layers with the Ctrl key
and pressing Ctrl+D afterwards. This way all selected Layers or groups will be removed from the layerlist.

6.3.1 Working with the Legend independent layer order

Since QGIS 1.8 there is a widget that allows to define a legend independent drawing order. You can activate it in
the menu Settings → Panels. Determine the drawing order of the layers in the map view here. Doing so makes it
possible to order your layers in order of importance, for example, but to still display them in the correct order (see

figure_layer_order). Checking the control rendering order box underneath the list of layers will cause a revert
to default behavior.

6.4 地図ビュー

This is the “business end” of QGIS - maps are displayed in this area! The map displayed in this window will
depend on the vector and raster layers you have chosen to load (see sections that follow for more information on
how to load layers). The map view can be panned (shifting the focus of the map display to another region) and
zoomed in and out. Various other operations can be performed on the map as described in the toolbar description
above. The map view and the legend are tightly bound to each other - the maps in view reflect changes you make
in the legend area.

ちなみに: マウスホィールを使って地図をズームします
You can use the mouse wheel to zoom in and out on the map. Place the mouse cursor inside the map area and
roll the wheel forward (away from you) to zoom in and backwards (towards you) to zoom out. The mouse cursor
position is the center where the zoom occurs. You can customize the behavior of the mouse wheel zoom using the
Map tools tab under the Settings → Options menu.
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Figure 6.2: Define a legend independent layer order

ちなみに: 矢印キーとスペースバーを使った地図パンニング
矢印を使って地図のパンを行えます.マウスカーソルを地図内に置いて右矢印キーを押すと東にパンします.
左矢印を押すと西にパンします.上矢印キーを押すと北へパンします。下矢印を押すと南にパンします。ま
たスペースバーをパンに利用できます:スペースバーを押したままでマウスを動かすと地図をパンできます.

6.5 ステータスバー

ステータスバーにはマウスポインターがマップビュー内を移動した時の位置の地図座標（たとえばメート
ルか度数）が表示されます.座標表示の左側は小さいボタンになっていてマウスの位置座標の表示かマップ
ビューの拡大、縮小した場合の現在の四隅の座標表示を行うかの切り替えを行います.

Next to the coordinate display you find the scale display. It shows the scale of the map view. If you zoom in or out
QGIS shows you the current scale. Since QGIS 1.8 there is a scale selector which allows you to choose between
predefined scales from 1:500 until 1:1000000.

ステータスバーの中にあるプログレスバーには各レイヤをマップビューに描画する処理の進行状況が表示
されます. ラスタレイヤで統計処理をするような場合プログレスバーは非常に長い処理の進行状態を表示
することになります.

If a new plugin or a plugin update is available, you will see a message at the far right of the status bar. On the right
side of the status bar is a small checkbox which can be used to temporarily prevent layers being rendered to the

map view (see Sectionレンダリング below). The icon immediately stops the current map rendering process.

To the right of the render functions you find the EPSG code of the current project CRS and a projector icon.
Clicking on this opens the projection properties for the current project.

ちなみに: マップキャンバスにおける正しい縮尺を計算する
When you start QGIS, degrees is the default unit, and it tells QGIS that any coordinate in your layer is in degrees.
To get correct scale values, you can either change this to meter manually in the General tab under Settings →
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Project Properties or you can select a project Coordinate Reference System (CRS) clicking on the CRS status

icon in the lower right-hand corner of the statusbar. In the last case, the units are set to what the project projection
specifies, e.g. ‘+units=m’.
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Chapter 7

一般ツール

7.1 キーボードショートカット

QGIS provides default keyboard shortcuts for many features. You find them in Sectionメニューバー. Additionally
the menu option Settings → Configure Shortcuts allows to change the default keyboard shortcuts and to add new
keyboard shortcuts to QGIS features.

Figure 7.1: Define shortcut options (KDE)

構成はとても簡単です。リストから機能を選択し [変更], [無し]を設定または **デフォルトを設定]**をク
リックして下さい. あなた自身の構成を作成したら,その設定を XMLファイルで保存して他の QGISイン
ストレーションでロードして利用することができます.

7.2 コンテキストヘルプ

特定のトピックでヘルプが必要な場合多くのダイアログに実装されている Helpボタンでコンテキストヘル
プを利用することができます-サードパーティプラグインでは専用のウェッブページを指し示すことを注意
して下さい.
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7.3 レンダリング

デフォルトで QGISレンダラはマップキャンパスに含まれる全ての可視レイヤ表示を更新しますイベント
はマップキャンバスに含まれるもののリフレッシュを引き起こします:

• レイヤの追加

• パンまたはズーム

• QGISウィンドウのリサイズします

• レイヤまたはレイヤ群の表示、非表示を変更します

QGISではいくつもの方法で描画プロセスを管理できます.

7.3.1 スケール依存レンダリング

縮尺によって異なる描画方法を定義できます.あるレイヤが描画される最少と最大の縮尺を定義できます.縮
尺依存レンダリングの定義を行うためには,地図凡例でレイヤ名をダブルクリックすると表示されるプロパ
ティ画面を開いて下さい.画面の一般情報タブで最小と最大の縮尺値を設定した後に,|checkbox|:guilabel:
縮尺依存レンダリングを使用するチェックボックスをクリックして下さい.

QGISステータスバーでスケール値を見ることで,そのレイヤを表示するのと表示しないスケール値を決め
ることができます.

7.3.2 地図レンダリングの制御

地図レンダリングは以下の方法で制御することができます:

Suspending Rendering

描画を中止したい場合はステータスバーの右側角にある Render‘チェックボックスをクリックしてくだ
さい. |checkbox| :guilabel:‘Render‘がチェックされていない場合, QGISはセクション :ref:‘redraw_eventsに
記述されているあらゆるイベントに反応せずキャンバスに再描画を行いません.地図描画を行わないほうが
いい場合は以下のような場合があります:

• 沢山のレイヤを追加して描画する前に描画方法を編集したい場合

• データ量が多いレイヤを追加して描画する前に縮尺依存描画条件を指定したい場合

• データ量が多いレイヤを追加して描画する前に特定の位置にズームしておきたい場合

• 上記の場合のいくつかの組み合わせ

Checking the Render checkbox enables rendering and causes an immediate refresh of the map canvas.

Setting Layer Add Option

新しくレイヤを追加した時に,すぐに描画しないオプションを設定できます.これはレイヤが地図に追加さ
れた時に,地図凡例の可視属性チェックボックスがデフォルトでチェックされないことを意味します.このオ
プションを指定するためには設定→オプション→を選択して:guilabel:レンダリングタブをクリックして

ください. By default new layers added to the map should be displayed のチェックを解除してください.す
ると,地図に追加されたレイヤの表示属性は不可視の状態がデフォルトになります.
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描画の中断

To stop the map drawing, press the ESC key. This will halt the refresh of the map canvas and leave the map
partially drawn. It may take a bit of time between pressing ESC and the time the map drawing is halted.

ノート: 現在描画中断機能は利用できません -これは qt4のポートに依存しています,なぜならばユーザー
インターフェース (UI)に問題が発生してクラッシュするからです.

Updating the Map Display During Rendering

You can set an option to update the map display as features are drawn. By default, QGIS does not display any
features for a layer until the entire layer has been rendered. To update the display as features are read from
the datastore, choose menu option Settings → Options click on the Rendering tab. Set the feature count to an
appropriate value to update the display during rendering. Setting a value of 0 disables update during drawing (this
is the default). Setting a value too low will result in poor performance as the map canvas is continually updated
during the reading of the features. A suggested value to start with is 500.

Influence Rendering Quality

To influence the rendering quality of the map you have 2 options. Choose menu option Settings → Options click
on the Rendering tab and select or deselect following checkboxes.

• 線のジャギーを目立たなくします (描画パフォーマンスが低下します)

• ポリゴンの不正な塗りつぶしを修正します

7.4 計測

計測は投影座標系 (e.g., UTM)と投影されていないデータ内で機能します。ロードされたマップは地理座標
系（緯度/経度）で定義され、ラインや面積の計測結果は正確ではないでしょう。必要に応じ、適切なマップ
の座標系（ref:‘label_projections‘のセクションを参照）を設定することで解決します。すべての計測モジュー
ルはデジタイジングモジュール由来のスナップ設定が使用されています。ベクターレイヤのラインやエリ
アにそって計測をしたい場合、これは便利です。

計測ツールを選択するためには をクリックして使いたいツールを選択してください.

7.4.1 距離,面積と角度の計測

QGIS is able to measure real distances between given points according to a defined ellipsoid. To configure
this, choose menu option Settings → Options, click on the Map tools tab and choose the appropriate ellipsoid.
There you can also define a rubberband color and your preferred measurement units (meters or feet) and angle
units (degrees, radians and gon). The tools then allows you to click points on the map. Each segment-length as
well as the total shows up in the measure-window. To stop measuring click your right mouse button.

Areas can also be measured. In the measure window the accumulated area size appears. In addition, the
measuring tool will snap to the currently selected layer, provided that layer has its snapping tolerance set. (See
Sectionスナップ許容量と検索半径の設定). So if you want to measure exactly along a line feature, or around a
polygon feature, first set its snapping tolerance, then select the layer. Now, when using the measuring tools, each
mouse click (within the tolerance setting) will snap to that layer.

You can also measure angles, selecting Measure Angle tool. The cursor becomes cross-shaped. Click to
draw the first segment of the angle you wish to measure, then move the the cursor to draw the desired angle. The
measure is displayed in a popup dialog.
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Figure 7.2: Measure Distance (KDE)

Figure 7.3: Measure Area (KDE)

7.4.2 地物の選択と選択解除

QGISツールバーはマップキャンバスで地物を選択するためにいくつかのツールを提供しています。１つま
たはいくつかの地物をクリックのみで選択する場合は |mActionSelect|をクリックし、あなたのツールを選
択します。

• Select single feature

• 矩形による地物選択

• 多角形による地物選択

• フリーハンドによる地物選択

• 半径による地物選択

To deselect all selected features click on Deselect features from all layers.

7.5 整飾

QGISの装飾には著作権ラベル、北向き矢印とスケールバーが含まれています。これらは地図製作の要素と
して投下することで、マップを ’装飾 ’するために用いられます。

ノート: QGIS 1.8以前では同じ機能は整飾プラグインで提供されています.

Figure 7.4: Measure Angle (KDE)
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7.5.1 著作権ラベル

Copyright label adds a Copyright label using the text you prefer to the map.

Figure 7.5: The copyright Dialog

1. メニューの ‘View –> Decorations –> Copyright Label‘を選択します。ダイアログが表示されます (
figure_decorations_1を参照すること)。

2. マップ上に配置したいテキストを入力します。例に示す通り HTMLを使用することができます。

3. guilabel:Placementのドロップダウンリストの’Bottom Right’からラベルの配置を選択します。

4. Make sure the Enable Copyright Label checkbox is checked

5. **[OK]**をクリックします。

In the example above (default) QGIS places a copyright symbol followed by the date in the lower right hand corner
of the map canvas.

7.5.2 北向き矢印

North Arrow places a simple north arrow on the map canvas. At present there is only one style available. You
can adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine
the direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow you have
four options, corresponding to the four corners of the map canvas.

Figure 7.6: The North Arrow Dialog

7.5. 整飾 37



QGIS User Guide,リリース 1.8

7.5.3 スケールバー

Scale Bar adds a simple scale bar to the map canvas. You control the style and placement, as well as the
labeling of the bar.

Figure 7.7: The Scale Bar Dialog

QGISは、あなたのマップフレームと同じ単位スケールを表示することをサポートしています。もしレイヤ
の単位がメートルであるなら、フィート単位のスケールバーを作成することはできません。同様に、小数
単位を使用している場合はメートル単位で距離を表示するスケールバーを作成することはできません。

スケールバーを追加するために：

1. メニューの ‘View –> Decorations –> Copyright Label‘を選択します。ダイアログが表示されます (
figure_decorations_1を参照すること)。

2. guilabel:Placementのドロップダウンリストの’Bottom Right’からラベルの配置を選択します。

3. guilabel:‘Scale bar style‘の’Tick Down’リストからスタイルを選択します。

4. guilabel:‘Color of bar‘の ‘black’でバーの色を選択するか、デフォルト色の黒色を使用します。

5. バーのサイズとそのラベル（guilabel:‘Size of bar‘の ‘30 degrees’）を設定します。

6. Make sure the Enable scale bar checkbox is checked

7. :guilabel:‘Automatically snap to round number on resize‘オプションで、キャンバスサイズが変更さ
れた時に、切りの良い数字にスナップされるように選択することができます。

8. **[OK]**をクリックします。

ちなみに: Settings of Decorations
.qgsプロジェクトを保存する際、方位記号、スケールバーと著作権ラベルに加えた変更はそのプロジェク
トに保存され、次回プロジェクトをロードした際に復元されます。

7.6 アノテーションツール

The Text Annotation tools in the attribute toolbar provides the possibility to place formatted text in a balloon
on the QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Double click on the item opens a dialog with various options. There is the text editor to enter the formatted text
and other item settings. E.g. there is the choice of having the item placed on a map position (displayed by a marker
symbol) or to have the item on a screen position (not related to the map). The item can be moved by map position
(drag the map marker) or by moving only the balloon. The icons are part of GIS theme, and are used by default in
the other themes too.

The Move Annotation tool allows to move the annotation on the map canvas.
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Figure 7.8: Annotation text dialog

7.6.1 注記の書式設定

Additionally you can also create your own annotation forms. The Form Annotation tool is useful to dis-
play attributes of a vector layer in a customized qt designer form (see figure_custom_annotation). It is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see QGIS blog
http://blog.qgis.org/node/143 for more information.

Figure 7.9: Customized qt designer annotation form

ノート: If you press Ctrl+T while an Annotation tool is active (move annotation, text annotation, form annota-
tion), the visibility states of the items are inverted.

7.7 空間ブックマーク

空間ブックマークを使用すると地理的な場所を”ブックマーク”し、あとでその位置に戻ることができます。
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7.7.1 ブックマークの作成

ブックマークを作るには：

1. 関心のある領域にズームまたはパンします。

2. Select the menu option View → New Bookmark or press Ctrl-B.

3. ブックマークを説明する名称（255文字まで）を入力します。

4. Press Enter to add the bookmark or [Delete] to remove the bookmark.

同じ名称で複数のブックマークを所有できることにご注意ください。

7.7.2 ブックマークの操作

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Geospatial Bookmarks
dialog allows you to zoom to or delete a bookmark. You can not edit the bookmark name or coordinates.

7.7.3 ブックマークへのズーム

From the Geospatial Bookmarks dialog, select the desired bookmark by clicking on it, then click [Zoom To]. You
can also zoom to a bookmark by double-clicking on it.

7.7.4 ブックマークの削除

ブックマークを削除するには ‘地理空間ブックマーク ‘ダイアログにてそれを選択し、**[削除]**をクリック
します。選択を確定するには **[はい]**をクリックし、削除をキャンセルするには **[いいえ]**をクリッ
クします。

7.8 プロジェクトの入れ子

If you want to embed content from other project files into your project you can choose Layer → Embed Layers
and Groups.

7.8.1 埋め込みレイヤ

次のダイアログで、他のプロジェクトのレイヤを埋め込むことができます。

1. Press to look for another project from the Alaska dataset.

2. プロジェクトファイルの grasslandを選択します。あなたはプロジェクトの中身を表示することがで
きます。(see figure_embed_dialog_を参照してください)

3. Press Ctrl and klick on the layers grassland and regions. The layers are embedded in the map legend and
the map view now.

埋め込まれている間が編集できる間は、スタイルやラベリングのようなプロパティは変更することができ
ません。

Removing embedded layers

Right-click on the embedded layer and choose Remove .
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Figure 7.10: Select layers and groups to embed

7.8. プロジェクトの入れ子 41





Chapter 8

QGISの設定

QGIS is highly configurable through the Settings menu. Choose between Panels, Toolbars, Project properties,
Options and Customization.

8.1 パネルとツールバー

In the Panels→ menu you can switch on and off QGIS widgets. The Toolbars→ menu provides the possibility to
switch on and off icon groups in the QGIS toolbar (see figure_panels_toolbars).

Figure 8.1: The Panels and Toolbars menu

ちなみに: Activating the QGIS Overview
QGISでは追加されたレイヤの全範囲のビューを提供するオーバービューパネルを提供します。これは:menus-
election:‘設定 –>パネル ‘メニューの下から選択することができます。ビュー内で現在のマップ範囲を示す
長方形があります。これによって現在見ているマップのどのエリアかを決定することができます。マップ
オーバービューのレイヤにラベリングが設定されていても、ラベルはマップのオーバービューにレンダリ
ングされないことに注意してください。オーバービューで現在の領域を示す赤い四角形をクリック・ドラッ
グすると、メインマップのビューもそれに応じて更新されます。

ちなみに: Show Log Messages

Since QGIS 1.8 it’s possible to track the QGIS messages. You can activate Log Messages in the menu Settings
→ Panels and follow the messages in the General and Plugin tab during loading and operation.
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8.2 プロジェクトのプロパティ

設定→ Project Properties or :menuselection:‘設定 –>プロジェクトのプロパティ‘で表示されるプロジェ
クトのプロパティウィンドウで、プロジェクトの特定のオプションを設定します。これらを含んでいます：

• In the General tab the project title, selection and background color, layer units, precision, and the option to
save relative paths to layers can be defined. You can define the layer units (only used when CRS transfor-
mation is disabled) and the precision of decimal places to use.

• CRS座標参照システムタブではこのプロジェクトの CRSを選択し、異なった CRSのレイヤを表示
する際にラスタおよびベクタレイヤのオンザフライ再投影することを可能にします。

• ３つ目の:guilabel:‘Identifiable layers‘タブで、どのレイヤが identify toolに対応するかを設定（または
無効化）することができます。（複数のレイヤの識別を無効にするには :ref:‘gui_options‘のMap tools
の段落を参照）

• The tab OWS Server allows to define information about the QGIS mapserver Service Capabilities, the Extent

and the CRS Restrictions as well as the WFS Capabilities. Activating the Add WKT geometry to feature
info response will allow to query the WMS layers.

8.3 Options

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. The tabs where you can optimize your options are:

8.3.1 General Tab

• Prompt to save project changes when required

• Warn when opening a project file saved with an older version of QGIS

• Change Selection and Background color

• Change the QGIS Style

• Change the icon theme (choose between ‘default’, ‘classic’ and ‘gis’)

• Change icon size between 16, 24 and 32 pixel.

• Change the menu size

• Define double click action in legend (choose between ‘open layer properties’ and ‘open ‘) attribute table.

• Capitalize layer names in legend

• Display classification attribute names in legend

• Create raster icons in legend

• Hide splash screen at startup

• Show tips at startup

• Open identify results in a dock window (QGIS restart required)

• Open snapping options in a dock window (QGIS restart required)
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• Open attribute table in a dock window

• Add PostGIS layers with double click and select in extended mode

• Add new layers to selected or current group

• Copy geometry in WKT representation from attribute table

• Attribute table behavior (choose between ‘Show all features’ (default), ‘Show selected features’,’Show
features in current canvas’)

• Attribute table row cache

• Define Representation for NULL values

• Prompt for raster sublayers . Some rasters support sublayers - they are called subdatasets in GDAL.
An example is netcdf files - if there are many netcdf variables, GDAL sees every variable as a subdataset.
The option is to control how to deal with sublayers when a file with sublayers is opened. You have the
following choices:

– ‘Always’: always ask (if there are existing sublayers)

– ‘If needed’: ask if layer has no bands, but has sublayers

– ‘Never’: never prompt, will not load anything

– ‘Load all’: never prompt, but load all sublayers

• Scan for valid items in the browser dock . The ‘Check extension’ option was designed to speed up
the loading of a directory, which can be time-consuming when ‘Check file contents’ is activated and there
are many files (tens or hundreds).

• Scan for contents of compressed files (.zip) in browser dock This option was also designed to speed
up the loading of a directory. You have the following choices:

– ‘Basic Scan’: checks that the extension is supported by one of the drivers

– ‘Full Scan’: opens every file to check it is valid

– ‘Passthru’: don’t use this option it will be removed in the next QGIS version

8.3.2 GDAL tab

GDAL is a data exchange library for raster files. In this tab you can define which GDAL driver to be used for a
raster format as in some cases more than one GDAL driver is available.

8.3.3 Plugins tab

• Add Path(s) to search for additional C++ plugin libraries.

8.3.4 Rendering Tab

• By default new layers added to the map should be displayed

• Define Number of features to draw before updating the display.

• Use render caching where possible to speed up redraws

• Make lines appear less jagged at the expense of some drawing performance

• Fix problems with incorrectly filled polygons
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• Use new generation symbology for rendering

• Define the default Raster settings for visualisation: ‘RGB band selection’, Use standard deviation and
‘Contrast Enhancement’

• Add/remove Path(s) to search for Scalable Vector Graphics (SVG) symbols

Additionally you can define whether to save the path for svg textures absolute or relative in the General tab of the
Settings → Project Properties menu.

8.3.5 Map tools Tab

• The Mode setting determines which layers will be shown by the Identify tool. By switching to ‘Top down’
or ‘Top down, stop at first’ instead of ‘Current layer’ attributes for all identifiable layers (see the Project
properties section under: プロジェクト to set which layers are identifiable) will be shown with the Identify
tool.

• Open feature form, if a single feature is identified

• Define Search radius for identifying and displaying map tips as a percentage of the map width

• Define Ellipsoid for distance calculations

• Define Rubberband color for measure tools

• Define Decimal places

• Keep base unit

• Define preferred measurement units (‘meters’ or ‘feet’)

• Define preferred angle units (‘Degrees’, ‘Radians’ or ‘Gon’)

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Define Zoom factor for wheel mouse

8.3.6 Overlays Tab

• Define Placement algorithm for labels, symboly and diagrams (choose between ‘Central point’
(standard), ‘Chain’, ‘Popmusic tabu chain’, ‘Popmusic tabu’ and ‘Popmusic chain’)

8.3.7 Digitizing Tab

• Define Rubberband Line color and Line width

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’)

• Define Default snapping tolerance in map units or pixel

• Define search radius for vertex edits in ‘map units’ or ‘pixel’

• Show markers only for selected features

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’) and vertex
Marker size.

• Suppress attributes pop-up windows after each created feature

• Reuse last entered attribute values
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• Validate geometries Editing complex lines/polygons with many nodes can end up with very slow rendering.
This is because the default validation procedures in QGIS can use a lot of time. To speed up rendering it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

The next 3 options refer to the Offset Curve tool in Advanced digitizing. Through the various settings, it is
possible to influence the shape of the line offset. These options are possible from GEOS 3.3 .

• Join style for curve offset

• Quadrantsegments for curve offset

• Miter limit for curve offset

8.3.8 CRS Tab

The CRS tab is divided in two areas. The first area allows to define the default CRS for new projects.

• Select a CRS and Always start new projects with this CRS.

• Enable on the fly re-projection by default

The second area allows to define the action, when a new layer is created, or when a layer without CRS is loaded.

• Prompt for Coordinate Reference System (CRS)

• Use project Coordinate Reference System (CRS)

• Use default Coordinate Reference System (CRS) displayed below

8.3.9 Locale Tab

• Overwrite system locale and Locale to use instead

• Information about active system locale

8.3.10 Network Tab

Figure 8.2: Proxy-settings in QGIS
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• Use proxy for web access and define ‘Host’, ‘Port’, ‘User’, and ‘Password’.

• Set the Proxy type according to your needs.

– Default Proxy: Proxy is determined based on the application proxy set using

– Socks5Proxy: Generic proxy for any kind of connection. Supports TCP, UDP, binding to a port (in-
coming connections) and authentication.

– HttpProxy: Implemented using the “CONNECT” command, supports only outgoing TCP connections;
supports authentication.

– HttpCachingProxy: Implemented using normal HTTP commands, it is useful only in the context of
HTTP requests

– FtpCachingProxy: Implemented using an FTP proxy, it is useful only in the context of FTP requests

• Define Cache settings (path and size)

• Define WMS search address, default is http://geopole.org/wms/search?search=\%1\&type=rss

• Define Timeout for network requests (ms) - deeingebundenfault is 60000

Excluding some URLs can be added to the text box below the proxy-settings (see Figure_Network_Tab) by press-
ing the [Add] button. After that double-click into the just created URL-field and enter the URL you would like to
exclude from using the proxy. Obviously the button [Remove] removes the selected entry.

If you need more detailed information about the different proxy-settings, please refer to the manual of the under-
lying QT-library-documentation at http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

ちなみに: Using Proxies
Using proxies can sometimes be tricky. It is useful to ‘trial and error’ the above proxy types and check if they
succeed in your case.

You can modify the options according to your needs. Some of the changes may require a restart of QGIS before
they will be effective.

• settings are saved in a texfile: $HOME/.config/QuantumGIS/qgis.conf

• you can find your settings in: $HOME/Library/Preferences/org.qgis.qgis.plist

• settings are stored in the registry under:

\HKEY\CURRENT_USER\Software\QuantumGIS\qgis

8.4 Customization

The customization tool is a new development in QGIS 1.8.. It lets you (de)activate almost every element in the
QGIS user interface. This can get very useful if you have a lot of plug-ins installed that you never use and that are
filling your screen.

QGIS Customization is divided into five groups. In Docks you find the dock windows. Dock windows are
applications that can be started and used as a floating, top-level window or embedded to the QGIS main window

as a docked widget (see also パネルとツールバー). In Menus you can hide entries in the Menu bar. In the

Status Bar features like the coordinate information can be daectivated. In Toolbars you can (de)activate

the toolbar icons of QGIS and in Widgets you can (de)activate dialogs as well as their buttons.

With Switch to catching widgets in main application you can click on elements in QGIS you want to be
hidden and find the corresponding entry in Customization (see figure_customization). You can also save your
various different setups for different use cases as well. Before your changes are applied, you need to restart QGIS.
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Figure 8.3: The Customization dialog
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Chapter 9

投影法の利用方法

QGISでは、定義済みでない CRS(Coordinate Reference System=空間参照系)を持つレイヤのために、グロー
バルかつプロジェクトワイドな CRSを定義することができます。また、カスタム空間参照系を定義でき
ますし、実行時でのベクタレイヤの投影 (オンザフライプロジェクション)をサポートしています。これら
の機能によって、異なる CRSを持つレイヤを表示させ、確実にオーバレイさせることができるようになり
ます。

9.1 投影法サポート概要

QGISは、約 2700の CRSをサポートしています。これら CRSの個々の定義は、QGISとともにインストー
ルされている SQLiteデータベースに格納されています。通常、データベースを直接操作する必要はありませ
ん。実際にそういうことを行うと、投影法サポートが失敗することになりかねません。カスタムCRSはユー
ザデータベースに格納されます。カスタム空間参照系の管理に関する情報は :ref:‘sec_custom_projections‘の
章を参照してください。

QGISで使用可能な CRSは、 European Petroleum Search Group (EPSG)と Institut Geographique National de
France (IGNF)が定義した EPSGの定義をもとにし、GDALで使用された spatial_referencesテーブルから
多く抽出しました。EPSG IDはデータベース内にあり、QGISで CRSを指定する際に使うことができます。

オンザフライ投影を使用するには、使用するデータに空間参照系情報が含まれている必要があり、含まれ
ていない場合にはグローバルな CRS、レイヤに対して指定した CRS、またはプロジェクトに対して指定し
た CRSかを定義しなければなりません。 QGISが使用する PostGISレイヤは、レイヤが生成される時に指
定されていた空間参照系 IDを使用します。OGRデータでは、QGISは、フォーマットごとに特有になって
いる CRSを設定する手段が存在することを前提としています。シェープファイルの場合は、Well Known
Text (WKT)での CRS設定を含むファイルを意味します。投影法ファイルは同じシェープファイルと同じ
ベース名を持ち、拡張子が prjです。たとえば、:alaska.shpというシェープファイルに対しては、投影法
ファイルは :file:‘alaska.prj‘という名前になります。

新しい CRS を選択した時、レイヤで利用される単位は 編集 (Gnome, OSX) または:guilabel:設定 (KDE,
Windows)メニューにある|mActionOptions| :guilabel:‘プロジェクトのプロパティ‘ダイアログの:guilabel:‘一
般情報 ‘タブで自動的に変更されます。

9.2 投影法の指定

QGISは新規プロジェクトにおいてグローバルなデフォルト投影法を使って起動します。グローバルデフォ
ルト CRS は PSG:4326 - WGS 84 (proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs) で、
QGISで事前に定義されています。このデフォルトは図１が示す通り、新規プロジェクトを開始した際、デ
フォルトの座標参照系を定義するのに使用された最初のセクションで**[選択...]**ボタンをクリックして
変更できます。この選択は、その後の QGISセッションで使用するために保存されます。
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Figure 9.1: CRS tab in the QGIS Options Dialog

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Edit → Options (Gnome, OSX) or Settings → Options
(KDE, Windows).

The options shown in figure_projection_1 are:

• Prompt for CRS

• Use project CRS

• Use default CRS displayed below

CRSの情報なしに特定のレイヤの座標参照系を定義したい場合はラスタ (一般情報タブを参照)およびベ
クタ ( General Tabを参照)プロパティダイアログの:guilabel:‘一般情報 ‘タブで行うことができます。すで
にレイヤで CRSが定義されている場合は、:ref:‘figure_vector_properties_1‘で示すように表示されます。

ちなみに: マップ凡例の CRS
Right-clicking on a layer in the Map Legend (Section地図凡例) provides two CRS short cuts. Set layer CRS takes
you directly to the Coordinate Reference System Selector dialog (see figure_projection_2). Set project CRS from
Layer redefines the project CRS using the layer’s CRS

9.3 Define On The Fly (OTF) Reprojection

QGIS supports OTF reprojection for both raster and vector data. However, OTF is not activated by default. To use

OTF projection, you must activate the Enable on the fly CRS transformation checkbox in the CRS tab of the

Project Properties dialog.

これを達成する方法は３つあります：

1. Select Project Properties from the Edit (Gnome, OSX) or Settings (KDE, Windows) menu.

2. ステータスバーの右下角にある|geographic| :sup:‘CRSステータス ‘アイコンをクリックします。

3. Turn OTF on by default, by selecting the CRS tab of the Options dialog and selecting Enable ‘on the fly’
reprojection by default.
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If you have already loaded a layer, and want to enable OTF projection, the best practice is to open the Coordinate

Reference System tab of the Project Properties dialog, select a CRS, and activate the Enable on the fly CRS

transformation checkbox. The CRS status icon will no longer be greyed-out and all layers will be OTF projected
to the CRS shown next to the icon.

Figure 9.2: Projection Dialog

The Coordinate Reference System tab of the Project Properties dialog contains five important components as
shown in Figure_projection_2 and described below.

1. Enable on the fly CRS transformation - this checkbox is used to enable or disable OTF projection. When
off, each layer is drawn using the coordinates as read from the data source and the components described
below are inactive.When on, the coordinates in each layer are projected to the coordinate reference system
defined for the map canvas.

2. Coordinate Reference System - this is a list of all CRS supported by QGIS, including Geographic, Pro-
jected and Custom coordinate reference systems. To define a CRS, select it from the list by expanding the
appropriate node and selecting the CRS. The active CRS is preselected.

3. Proj4 text -投影変換エンジンである Proj4で使われる文字列です。この文字列は読み取り専用で、情
報提供のために提供されます。

4. Filter - if you know the EPSG code, the identifier or the name for a Coordinate Reference System, you can
use the search feature to find it. Enter the EPSG code, the identifier or the name.

5. 最近利用した座標参照系 -日常のGISでの作業でよく使う CRSがあるなら、ダイアログの下部に「ク
イックアクセス」ボタンとして表示されます。これらのひとつをクリックすると、CRSを選択でき
ます。

ちなみに: プロジェクトプロパティダイアログ
編集 (Gnome, OSX)または設定 (KDE, Windows)メニューから:guilabel:‘プロジェクトのプロパティ‘ダイア
ログを開いた場合は、 :guilabel:‘座標参照系 ‘タブをクリックし、CRS設定を表示します。

9.3. Define On The Fly (OTF) Reprojection 53



QGIS User Guide,リリース 1.8

Opening the dialog from the CRS status icon will automatically bring the Coordinate Reference System tab
to the front.

9.4 カスタム空間参照システム

QGISが使用しなければならない CRSを提供していない場合は、カスタム CRSを定義できます。CRSを定

義するには:menuselection:編集 (Gnome, OSX)または設定 (KDE, Windows)メニューから カスタム CRS
を選択します。カスタム CRSは QGISのユーザデータベースに格納されます。また、このデータベース
には、カスタム CRSだけでなく、空間ブックマークと他のカスタムデータが格納されます。

Figure 9.3: Custom CRS Dialog

Defining a custom CRS in QGIS requires a good understanding of the Proj.4 projection library. To begin, refer to
the Cartographic Projection Procedures for the UNIX Environment - A User’s Manual by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf ).

このマニュアルでは ‘‘proj.4‘‘の利用と関連のコマンドラインユーティリティについて記述されています。こ
の地図作成パラメータはこのユーザマニュアルで記述された ‘‘proj.4‘‘で使用されており QGISで使ってい
たものと同じです。

The Custom Coordinate Reference System Definition dialog requires only two parameters to define a user CRS:

1. 記述可能な名称

2. Proj4書式による地図作成パラメータ.

新しい CRSを作成するには 新規 ボタンをクリックして、名称と CRSパラメータを入力します。その

後 保存 ボタンをクリックして CRSを保存します。

注新しい CRSを表現するには、パラメータは +proj= -ブロックで開始されていなければいけません。

テスト ‘ブロック内の**[計算]**ボタンをクリックし、CRSパラメータを:guilabel:‘パラメータ ‘フィール
ドにペーストして、まともな結果が得られるかを見ることで、CRSパラメータをテストできます。知って
いるWGS84緯度経度の値を:guilabel:‘North、 :guilabel:‘East‘フィールドにそれぞれ入力します。 [計算 ]を
クリックして、出てきた結果と、定義した CRSでの知っている値とを比較します。
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Chapter 10

QGISブラウザ

The QGIS Browser is a new panel in QGIS that lets you easily navigate in your database. You can have access
to common vector files (e.g. ESRI shapefile or MapInfo files), databases (e.g.PostGIS or MSSQL Spatial) and
WMS/WFS connections. You can also view your GRASS data (to get the data into QGIS see GRASS GIS の統
合).

Figure 10.1: Qgis browser as a standalone application to view metadata, preview and attributes

データのプレビューに QGISブラウザを使います。ドラッグアンドドロップによって、簡単にデータをマッ
プと凡例に表示できます。

1. QGISブラウザの有効：ツールバーで右クリックし、 :guilabel:‘ブラウザ ‘をクリックします。

2. 凡例ウィンドウにパネルをドラッグします。

3. guilabel:‘ブラウザ ‘タブをクリックします。

4. あなたのデータベースを参照し qgis_sample_dataから shapefileフォルダを選択します。

5. Press the Shift key and klick on airports.shp and alaska.shp .

6. マウスの左ボタンを押し、マップキャンバスにファイルをドラッグアンドドロップします。
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7. レイヤ上で右クリックし:guilabel:‘レイヤの CRSをプロジェクトに設定する ‘を選択します。より詳
細な情報は:ref:‘label_projections‘を参照ください。

8. Click on Zoom Full to make the layers visible.

QGISブラウザはスタンドアロンアプリケーションとして実行することも可能です。

QGISブラウザの起動

• コマンドプロンプトで “qbrowser”と入力します。

• |win|スタートメニューまたはデスクトップのショートカットをつかって QGISを起動するか、QGIS
プロジェクトファイルをダブルクリックします。

• QGIS ブラウザはあなたのアプリケーションフォルダでまだ利用可能になっていません。し
かし、それは簡単に利用可能にすることができます。Finder で Go → Go to map...‘を使用し、
‘/Applications/QGIS.app/Contents/MacOS/bin‘‘フォルダを見つけます。:kbd:‘option - command‘のコン
ビネーションを使用し、アプリケーションフォルダにマウスの左ボタンを押しながら**qbrowser.app**
にドラッグします。これで、QGISブラウザを起動するために使用できるリンクを作成します。

In figure_browser_standalone_metadata you can see the enhanced functionality of Qgis browser. The Param
tab provides the details of your connection based datasets like PostGIS or MSSQL Spatial. The Metadata tab
contains general information about the file (see Metadata Tab). With the Preview tab you can have a look at your
files without importing them into your QGIS project. It’s also possible to preview the attributes of your files in the
Attributes tab.
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Working with Vector Data

11.1 Supported Data Formats

QGIS uses the OGR library to read and write vector data formats (GRASS vector and PostgreSQL support is
supplied by native QGIS data provider plugins),including ESRI Shapefiles, MapInfo and Microstation file for-
mats; PostGIS, SpatiaLite, Oracle Spatial databases and many more. The vector data can also be loaded in
read mode from zip and gzip archives into QGIS. At the date of this document, 69 vector formats are sup-
ported by the OGR library (see OGR-SOFTWARE-SUITE 文献と Web 参照). The complete list is available
at http://www.gdal.org/ogr/ogr_formats.html.

ノート: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries or the GDAL/OGR installation of your OS was not build to support the format you want to
use. Only those formats that have been well tested will appear in the list of file types when loading a vector into
QGIS. Other untested formats can be loaded by selecting *.*.

Working with GRASS vector data is described in Section GRASS GISの統合.

This section describes how to work with several common formats: ESRI Shapefiles, PostGIS layers and SpatiaLite
layers. Many of the features available in QGIS work the same, regardless of the vector data source. This is by
design and includes the identify, select, labeling and attributes functions.

11.1.1 ESRI Shapefiles

The standard vector file format used in QGIS is the ESRI Shapefile. Support is provided by the OGR Simple
Feature Library ( http://www.gdal.org/ogr/ ).

A shapefile actually consists of several files. The following three are required:

1. .shp file containing the feature geometries.

2. .dbf file containing the attributes in dBase format.

3. .shx index file.

Shapefiles also can include a file with a .prj suffix, which contains the projection information. While it is very
useful to have a projection file, it is not mandatory. A shapefile dataset can contain additional files. For further
details see the ESRI technical specification at: http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Loading a Shapefile

To load a shapefile, start QGIS and click on the Add Vector Layer toolbar button or simply type
Ctrl+Shift+V. This will bring up a new window (see figure_vector_1).
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Figure 11.1: Add Vector Layer Dialog

From the available options check File. Click on button [Browse]. That will bring up a standard open file
dialog (see figure_vector_2) which allows you to navigate the file system and load a shapefile or other supported

data source. The selection box Filter allows you to preselect some OGR supported file formats.

You can also select the Encoding type for the shapefile if desired.

Figure 11.2: Open an OGR Supported Vector Layer Dialog

Selecting a shapefile from the list and clicking [Open] loads it into QGIS. Figure_vector_3 shows QGIS after
loading the alaska.shp file.

ちなみに: Layer Colors
When you add a layer to the map, it is assigned a random color. When adding more than one layer at a time,
different colors are assigned to each layer.

Once loaded, you can zoom around the shapefile using the map navigation tools. To change the style of a layer,
open the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the
legend and choosing Properties from the popup menu. See Sectionスタイルタブ for more information on setting
symbology of vector layers.

ちなみに: Load layer and project from mounted external drives on OS X
On OS X, portable drives that are mounted besides the primary hard drive do not show up under File → Open
Project as expected. We are working on a more OSX-native open/save dialog to fix this. As a workaround you can
type ‘/Volumes’ in the File name box and press return. Then you can navigate to external drives and network
mounts.
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Figure 11.3: QGIS with Shapefile of Alaska loaded

Improving Performance Shape

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Use these steps to create the index:

• Load a shapefile.

• Open the Layer Properties dialog by double-clicking on the shapefile name in the legend or by right-clicking
and choosing Properties from the popup menu.

• In the tab General click the [Create Spatial Index] button.

Problem loading a shape .prj file

If you load a shapefile with .prj file and QGIS is not able to read the coordinate reference system from that file,
you have to define the proper projection manually within the General tab of the Layer Properties dialog of the
layer. This is due to the fact, that .prj files often do not provide the complete projection parameters, as used in
QGIS and listed in the CRS dialog.

For that reason, if you create a new shapefile with QGIS, two different projection files are created. A .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

11.1.2 Loading a MapInfo Layer

To load a MapInfo layer, click on the Add Vector Layer toolbar button or type Ctrl+Shift+V, change the

file type filter Filter : to ‘Mapinfo File [OGR]’ and select the MapInfo layer you want to load.
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11.1.3 Loading an ArcInfo Binary Coverage

To load an ArcInfo binary coverage, click on the Add Vector Layer toolbar button or press Ctrl+Shift+V to

open the Add Vector Layer dialog. Select Directory. Change to Filter to ‘Arc/Info Binary Coverage’.
Navigate to the directory that contains the coverage files and select it.

Similarly, you can load directory based vector files in the UK National Transfer Format as well as the raw TIGER
Format of the US Census Bureau.

11.1.4 PostGIS Layers

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are the spatial indexing, filter-
ing and query capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than with OGR layers in QGIS.

Creating a stored Connection

The first time you use a PostGIS data source, you must create a connection to the PostgreSQL database that

contains the data. Begin by clicking on the Add PostGIS Layer toolbar button, selecting the Add PostGIS
Layer... option from the Layer menu or typing Ctrl+Shift+D. You can also open the Add Vector Layer dialog
and select Database. The Add PostGIS Table(s) dialog will be displayed. To access the connection manager,
click on the [New] button to display the Create a New PostGIS Connection dialog. The parameters required for a
connection are:

• Name: A name for this connection. Can be the same as Database

• Service: Service parameter to be used alternatively to hostname/port (and potentially database). This can
be defined in pg_service.conf

• Host: Name of the database host. This must be a resolvable host name the same as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: Port number the PostgreSQL database server listens on. The default port is 5432.

• Database: Name of the database.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speedups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. Following options are
available:

– disable: only try an unencrypted SSL connection

– allow: try a non-SSL connection, if that fails, try an SSL connection

– prefer (the default): try an SSL connection, if that fails, try a non-SSL connection;

– require: only try an SSL connection.

• Username: User name used to login to the database.

• Password: Password used with Username to connect to the database.

Optional you can activate following checkboxes:

• Save Username

• Save Password

• Only look in the geometry_columns table

• Only look in the ‘public’ schema
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• Also list tables with no geometry

• Use estimated table metadata

Once all parameters and options are set, you can test the connection by clicking on the [Test Connect] button.

ちなみに: QGIS User Settings and Security
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk. Your
customized settings for QGIS are stored based on the operating system:

• , the settings are stored in your home directory in .qgis/.

• , the settings are stored in the registry.

Loading a PostGIS Layer

Once you have one or more connections defined, you can load layers from the PostgreSQL database. Of
course this requires having data in PostgreSQL. See Section Importing Data into PostgreSQL for a discussion on
importing data into the database.

To load a layer from PostGIS, perform the following steps:

• If the Add PostGIS layers dialog is not already open, click on the Add PostGIS Layer toolbar button.

• Choose the connection from the drop-down list and click [Connect].

• Select or unselect Also list tables with no geometry

• Optionally use some Search Options to define which features to load from the layer or use the [Build
query] button to start the Query builder dialog.

• Find the layer(s) you wish to add in the list of available layers.

• Select it by clicking on it. You can select multiple layers by holding down the Shift key while clicking.
See Sectionクエリビルダー for information on using the PostgreSQL Query Builder to further define the
layer.

• Click on the [Add] button to add the layer to the map.

ちなみに: PostGIS Layers
Normally a PostGIS layer is defined by an entry in the geometry_columns table. From version 0.9.0 on, QGIS
can load layers that do not have an entry in the geometry_columns table. This includes both tables and views.
Defining a spatial view provides a powerful means to visualize your data. Refer to your PostgreSQL manual for
information on creating views.

Some details about PostgreSQL layers

This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time QGIS should
simply provide you with a list of database tables that can be loaded, and load them on request. However, if you
have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any QGIS
messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to load it.

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively the ctid column can be used as primary
key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).
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If the PostgreSQL layer is a view, the same requirement exists, but views do not have primary keys or columns
with unique constraints on them. In this case QGIS will try to find a column in the view that is derived from a
suitable table column. It does this by parsing the view definition SQL. However there are several aspects of SQL
that QGIS ignores these include the use of table aliases and columns that are generated by SQL functions.

If a suitable column cannot be found, QGIS will not load the layer. If this occurs, the solution is to alter the
view so that it does include a suitable column (a type of int4 and either a primary key or with a unique constraint,
preferably indexed).

11.1.5 Importing Data into PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, such as the SPIT plugin, or the command line
tools shp2pgsql or ogr2ogr.

SPIT Plugin

QGIS comes with a core plugin named SPIT (Shapefile to PostGIS Import Tool). SPIT can be used to
load multiple shapefiles at one time and includes support for schemas. See Section SPITプラグイン for more
information.

shp2pgsql

PostGIS includes a utility called shp2pgsql that can be used to import shapefiles into a PostGIS enabled database.
For example, to import a shapefile named lakes.shp into a PostgreSQL database named gis_data, use the
following command:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

This creates a new layer named lakes_new in the gis_data database. The new layer will have a spatial
reference identifier (SRID) of 2964. See Section 投影法の利用方法 for more information on spatial reference
systems and projections.

ちなみに: Exporting datasets from PostGIS
Like the import-tool shp2pgsql there is also a tool to export PostGIS-datasets as shapefiles: pgsql2shp. This is
shipped within your PostGIS distribution.

ogr2ogr

Beside shp2pgsql and SPIT there is another tool for feeding geodata in PostGIS: ogr2ogr. This is part of your
GDAL installation.

To import a shapefile into PostGIS, do the following:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres \
password=topsecret" alaska.shp

This will import the shapefile alaska.shp into the PostGIS-database postgis using the user postgres with the
password topsecret on host server myhost.de.

Note that OGR must be built with PostgreSQL to support PostGIS. You can see this by typing

ogrinfo --formats | grep -i post

If you like to use PostgreSQL’s COPY -command instead of the default INSERT INTO method you can export

the following environment-variable (at least available on and ):
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export PG_USE_COPY=YES

ogr2ogr does not create spatial indexes like shp2pgsl does. You need to create them manually using the nor-
mal SQL-command CREATE INDEX afterwards as an extra step (as described in the next section Improving
Performance).

Improving Performance

Retrieving features from a PostgreSQL database can be time consuming, especially over a network. You can
improve the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on
each layer in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed
up spatial searches of the data (GiST index information is taken from the PostGIS documentation available at
http://postgis.refractions.net).

The syntax for creating a GiST index is:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Note that for large tables, creating the index can take a long time. Once the index is created, you should per-
form a VACUUM ANALYZE. See the PostGIS documentation (POSTGIS-PROJECT文献と Web参照) for more
information.

The following is an example of creating a GiST index:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

11.1.6 Vector layers crossing 180°longitude

Many GIS packages don’t wrap vector maps, with a geographic reference system (lat/lon), crossing the 180 de-
grees longitude line (http://postgis.refractions.net/documentation/manual-1.4/ST_Shift_Longitude.html). As re-
sult, if we open such map in QGIS, we will see two far, distinct locations, that should show near each other. In
Figure_vector_4 the tiny point on the far left of the map canvas (Chatham Islands), should be within the grid, right
of New Zealand main islands.

Figure 11.4: Map in lat/lon crossing the 180°longitude line

A workaround is to transform the longitude values using PostGIS and the ST_Shift_Longitude function This
function reads every point/vertex in every component of every feature in a geometry, and if the longitude coordi-

11.1. Supported Data Formats 63

http://postgis.refractions.net
http://postgis.refractions.net/documentation/manual-1.4/ST_Shift_Longitude.html


QGIS User Guide,リリース 1.8

nate is < 0°adds 360°to it. The result would be a 0°- 360°version of the data to be plotted in a 180°centric
map.

Figure 11.5: Crossing 180°longitude applying the ST_Shift_Longitude function

Usage

• Import data to PostGIS (Importing Data into PostgreSQL) using for example the PostGIS Manager plugin
or the SPIT plugin

• Use the PostGIS command line interface to issue the following command (this is an example where “TA-
BLE” is the actual name of your PostGIS table)

gis_data=# update TABLE set the_geom=ST_Shift_Longitude(the_geom);

• If everything went right you should receive a confirmation about the number of features that were updated,
then you’ll be able to load the map and see the difference (Figure_vector_5)

11.1.7 SpatiaLite Layers

The first time you load data from a SpatiaLite database, begin by clicking on the Add SpatiaLite Layer toolbar

button or by selecting the Add SpatiaLite Layer... option from the Layer menu or by typing Ctrl+Shift+L.
This will bring up a window, which will allow you to either connect to a SpatiaLite database already known to
QGIS, which you can choose from the dropdown menu or to define a new connection to a new database. To define
a new connection, click on [New] and use the file browser to point to your SpatiaLite database, which is a file with
a .sqlite extension.

If you want to save a vector layer to SpatiaLite format you can do this by right clicking the layer in the legend.
Then click on Save as.., define the name of the output file, select ‘SpatiaLite’ as format and the CRS. Also you can
select ‘SQLite’ as format, and then add SPATIALITE=YES in the OGR data source creation option field. This
tells OGR to create a SpatiaLite database. See also http://www.gdal.org/ogr/drv_sqlite.html.

QGIS also supports editable views in SpatiaLite.

Creating a new SpatiaLite layer

If you want to create a new SpatiaLite layer, please refer to section Creating a new SpatiaLite layer.
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ちなみに: SpatiaLite data management Plugins
For SpatiaLite data management you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or DB
Manager (core plugin, recommended). They can be downloaded and installed with the Plugin Installer.

11.1.8 MSSQL Spatial Layers

QGIS also provides native MS SQL 2008 support. The Add MSSQL Spatial Layer is part of the new toolbar
button or available in the MS SQL node in the QBrowser tree, providing drag and drop import support.

11.2 ベクタプロパティダイアログ

The Layer Properties dialog for a vector layer provides information about the layer, symbology settings and
labeling options. If your vector layer has been loaded from a PostgreSQL/PostGIS datastore, you can also alter
the underlying SQL for the layer by invoking the Query Builder dialog on the General tab. To access the Layer
Properties dialog, double-click on a layer in the legend or right-click on the layer and select Properties from the
popup menu.

Figure 11.6: Vector Layer Properties Dialog

11.2.1 スタイルタブ

QGIS 1.4.0から新しいシンボロジーが平行して導入され,最終的には古いシンボロジーを置き換えら
れます. QGIS 1.8では多彩な進化や機能が提供されている新しいシンボロジーがデフォルトで利用されて
ます.

古いシンボロジーについては Old Symbology　の節で説明されています.

3種類のシンボルがあります:マーカーシンボル (ポイント用),ラインシンボル (ライン用)と塗りつぶしと
アウトライン洋シンボル (ポリゴン用)です.シンボルは 1個またはそれ以上のシンボルレイヤを構成でき
ます.いくつかのレイヤは色が固定されています-それらの色は変更できません.このことはマルチレイヤシ
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ンボルを定義するときに便利です.マーカーシンボルのサイズと角度を定義できるのと同じようにラインシ
ンボルの幅を定義できます.

利用可能なシンボルレイヤタイプ

• ポイントレイヤ

– フォントマーカー: フォントを使った描画.

– シンプルマーカー: ハードコーディングされたマーカーによる描画.

– SVGマーカー: SVGピクチャを使った描画.

– 楕円マーカー: 属性値を利用して楕円で描画を行う.

– ベクタフィールドマーカー r: 属性値で提供されるベクタフィールドの値で描画する.

• ラインレイヤ

– ライン整飾: ラインに整飾を加える,例えばラインの方向を示す矢印.

– マーカーライン: マーカーシンボルが繰り返し描画されるライン.

– シンプルライン: 普通の描画方法のライン (幅色　ペンスタイルの指定).

• ポリゴンレイヤ

– セントロイド塗りつぶし: ポリゴンセントロイドをハードコーディングマーカーで塗りつぶし
ます.

– SVG塗りつぶし: ポリゴンを SVGシンボルで塗りつぶします.

– シンプル塗りつぶし: ポリゴンの通常の描画方法です (塗りつぶし色,パターンとアウトライン
の指定).

– **ラインパターン塗りつぶし**: ポリゴンをラインパターンで塗りつぶします.

– ポイントパターン塗りつぶし: ポリゴンをポイントパターンで塗りつぶします.

– アウトライン:ライン整飾: ラインに整飾を加えます,例えばラインの方向を示す矢印.

– アウトライン: マーカーライン: ハードコーディングされたマーカーをアウトラインエリアとし
て使います.

– アウトライン:シンプルライン: 幅色　ペンスタイルを指定するアウトライン.

カラーランプ

カラーランプはレンダラ作成のために色の範囲を定義するのに使われます.このシンボルの色はカラーラン
プから設定されます.

3種類のカラーランプタイプがあります:

• 階調：1色からいくつかの他の色での線形グラデーション。

• ランダム：カラースペースの指定されたエリアからランダムに生成された色。

• ColorBrewer: 色のスキーマから色のエリアと色の階級数の定義を作成します。

カラーランプは **[追加]**ボタンをクリックし :guilabel:‘スタイルマネージャ‘の :guilabel:‘カラーランプ
‘タブで定義でき、カラーランプタイプを選択できます（vector_style_managerセクションを参照）。

スタイル

A style groups a set of various symbols and color ramps. You can define your prefered or frequently used symbols,
and can use it without having to recreate it everytime. Style items (symbols and color ramps) have always a name
by which they can be queried from the style. There is at least one default style in QGIS (modifiable) and the user
can add further styles. In the lower part of the Style tab there are four buttons for managing styles: Use [Restore
Default Style] to get back to your default settings, [Save As Default] to save your style as default, [Load Style...]
to get to your own styles and [Save Style] to save your own styles. Layer styles can also be transferred from one

layer to another layer. Activate a layer and choose Layer → Copy style and switch to another layer. Then

choose Layer → Paste style.
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レンダラ

The renderer is responsible for drawing a feature together with the correct symbol. There are four types of
renderers: single symbol, categorized (called unique color in the old symbology), graduated and rule-based. There
is no continuous color renderer, because it is in fact only a special case of the graduated renderer. The categorized
and graduated renderer can be created by specifying a symbol and a color ramp - they will set the colors for
symbols appropriately. 新世代シンボロジーで作業をする

In the Style tab you can choose one of the five renderers: single symbol, categorized, graduated, rule-based and
point displacement. For each data type (points, lines and polygons) vector symbol layer types are available (see
vector_symbol_types). Depending on the chosen renderer, the symbology Depending on the chosen renderer,
the Style tab provides different following sections. The new generation symbology dialog also provides a [Style
Manager] button which gives access to the Style Manager (see Section Style Manager). The Style Manager
allows you to edit and remove existing symbols and add new ones.

ちなみに: 複数シンボルを選択して変更する
The New Generation Symbology allows to select multiple symbols and right click to change color, transparency,
size, or width of selected entries.

単一シンボルレンダラ

The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. The
properties, that can be adjusted in the Style tab, depend partially on the type of the layer, but all types share
the following structure. In the top left part of the tab, there is a preview of the current symbol to be rendered. In
the bottom part of the tab, there is a list of symbols already defined for the current style, prepared to be used via
selecting them from the list. The current symbol can be modified using the [Change] button below the preview,
which opens a Symbol Properties dialog, or the [Change] button right of the preview, which opens an ordinary
Color dialog.

Figure 11.7: Single symbol line properties

In the Style tab you can apart from a general layer transparency also define to use millimeter or map units for the
size scale. In the [Advanced] button next to the [Save as style] button you can use data-defined size scale and
rotation. Here the Symbol levels → menu allows to enable and define the order in which the symbol layers are
rendered (if the symbol consists of more than one layer).

After having done any needed changes, the symbol can be added to the list of current style symbols (using the
[Save as style] button) and then easily be used in the future. Furthermore you can use the [Save Style] button to
save the symbol as a QGIS layer style file (.qml) or SLD file(.sld). Currently in version 1.8 SLDs can be exported
from any type of renderer: single symbol, categorized, graduated or rule-based, but when importing an SLD, either
a single symbol or rule-based renderer is created. That means that categorized or graduated styles are converted
to rule-based. If you want to preserve those renderers, you have to stick to the QML format. On the other hand, it
could be very handy sometimes to have this easy way of converting styles to rule-based.
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Categorized Renderer

The Categorized Renderer is used to render all features from a layer, using a single user-defined symbol, which
color reflects the value of a selected feature’s attribute. The Style tab allows you to select:

• The attribute (using the Column listbox)

• The symbol (using the Symbol dialog)

• The colors (using the Color Ramp listbox)

The [Advanced] button in the lower right corner of the dialog allows to set the fields containing rotation and size
scale information. For convenience, the list in the bottom part of the tab lists the values of all currently selected
attributes together, including the symbols that will be rendered.

The example in figure_symbology_2 shows the category rendering dialog used for the rivers layer of the QGIS
sample dataset.

Figure 11.8: Categorized Symbolizing options

You can create a custom color ramp choosing New color ramp... from the Color ramp dropdown menu. A dialog
will prompt for the ramp type: Gradient, Random, ColorBrewer, then each one has options for number of steps
and/or multiple stops in the color ramp. See figure_symbology_3 for an example of custom color ramp.

Figure 11.9: Example of custom gradient color ramp with multiple stops

Graduated Renderer

The Graduated Renderer is used to render all the features from a layer, using a single user-defined symbol, whose
color reflects the classification of a selected feature’s attribute to a class.

Like Categorized Renderer, it allows to define rotation and size scale from specified columns.
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Figure 11.10: Graduated Symbolizing options

Analogue to the categorized rendered, the Style tab allows you to select:

• The attribute (using the Column listbox)

• The symbol (using the Symbol Properties button)

• The colors (using the Color Ramp list)

Additionally, you can specify the number of classes and also the mode how to classify features inside the classes
(using the Mode list). The available modes are:

• Equal Interval

• Quantile

• Natural Breaks (Jenks)

• Standard Deviation

• Pretty Breaks

The listbox in the bottom part of the Style tab lists the classes together with their ranges, labels and symbols that
will be rendered.

The example in figure_symbology_4 shows the graduated rendering dialog for the rivers layer of the QGIS sample
dataset.

Rule-based rendering

The rule-based renderer is used to render all the features from a layer, using rule based symbols, whose color
reflects the classification of a selected feature’s attribute to a class. The rules are based on SQL statements. The
dialog allows rule grouping by filter or scale and you can decide if you want to enable symbol levels or use only
first matched rule.

The example in figure_symbology_5 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

To create a rule, activate an existing row by clicking on it or click on ‘+’ and click on the new rule. Then press the

[Edit] button. In the Rule properties dialog you can define a label for the rule. Press the button to open the
Expression builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to
be searched. To add an attribute to the Field calculator Expression field, double click its name in the Fields and
Values list. Generally you can use the various fields, values and functions to construct the calculation expression
or you can just type it into the box (seeフィールド演算).
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Figure 11.11: Rule-based Symbolizing options

Point displacement

The point displacement renderer offers to visualize all features of a point layer, even if they have the same location.
To do this, the symbols of the points are placed on a displacement circle around a center symbol.

Figure 11.12: Point displacement dialog

Symbol Properties

The symbol properties dialog allows the user to specify different properties of the symbol to be rendered. In the
bottom left part of the dialog, you find a preview of the current symbol as it will be displayed in the map canvas.
Above the preview is the list of symbol layers. To start the Symbol properties dialog, click the [ Change...]
button in the Style tab of the Layer Properties dialog.

The buttons allow adding or removing layers, changing the position of layers, or locking layers for color changes.
In the right part of the dialog, there are shown the settings applicable to the single symbol layer selected in the

symbol layer list. The most important is the Symbol Layer Type combobox, which allows you to choose
the layer type. The available options depend on the layer type (Point, Line, Polygon). The symbol layer type
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options are described in section vector_symbol_types. You can also change the symbol layer properties in the
right part of the dialog. For example if you have chosen an SVG marker for a point layer it is now possible to
change its color using Color button.

Figure 11.13: Line composed from three simple lines

11.2.2 Style Manager

The Style Manager is a small helper application, that lists symbols and color ramps available in a style. It also
allows you to add and/or remove items. To launch the Style Manager, click on Settings → Style Manager in the
main menu. Alternatively, you can access it via the Style tab.

Figure 11.14: Style Manager to manage symbols and color ramps

11.2.3 Old Symbology

ノート: QGIS 1.8. still supports the usage of the old symbology, although it is recommended to switch to the
new symbology, described in section vector_new_symbology, because the old symbology will be removed in one
of the next releases.
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If you want or need to switch back to the old symbology you can click on the [Old symbology] button in the Style
tab of the Layer Properties dialog.

You can also make the old symobolgy the default, deactivating Use new generation symbology for rendering
in the Rendering tab under Settings → Options.

The old QGIS symbology supports the following renderers:

• Single symbol - a single style is applied to every object in the layer.

• Graduated symbol - objects within the layer are displayed with different symbols classified by the values
of a particular field.

• Continuous color - objects within the layer are displayed with a spread of colours classified by the numer-
ical values within a specified field.

• Unique value - objects are classified by the unique values within a specified field with each value having a
different symbol.

To change the symbology for a layer, simply double click on its legend entry and the vector Layer Properties
dialog will be shown.

Style Options

Within this dialog you can style your vector layer. Depending on the selected rendering option you have the
possibility to also classify your map features.

At least the following styling options apply for nearly all renderers:

• Fill style - Style for filling. Beside the given brushes you can select Fill style: ‘Texture’ and

click the button for selecting your own texture file. Currently the fileformats *.jpeg, *.xpm, and
*.png are supported.

• Fill color - fill-color of your features.

• Outline options

– Outline style - Pen-style for your outline of your feature. You can also set this to ‘no Pen’.

– Outline color - color of the ouline of your feature.

– Outline width - width of your features.

Once you have styled your layer you also could save your layer-style to a separate file (ending with *.qml). To
do this, use the button [Save Style...]. No need to say that [Load Style...] loads your saved layer-style-file.

If you wish to always use a particular style whenever the layer is loaded, use the [Save As Default] button to
make your style the default. Also, if you make changes to the style that you are not happy with, use the [Restore
Default Style] button to revert to your default style.

Vector transparency

QGIS allows to set a transparency for every vector layer. This can be done with the slider Transparency

inside the Style tab. This is very useful for overlaying several vector layers.

11.2.4 Labels Tab

As for the symbology QGIS 1.8 currently provides an old and a new labeling engine in parallel. The Labels
tab still contains the old labeling. The new labeling is implemented as a core application and will replace the
features of the old labels tab in one of the next versions.

We recommend to switch to the new labeling, described in section New Labeling.
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The old labeling in the Labels tab allows you to enable labeling features and control a number of options related
to fonts, placement, style, alignment and buffering. We will illustrate this by labeling the lakes shapefile of the
QGIS sample dataset:

1. Load the Shapefile alaska.shp and GML file lakes.gml in QGIS

2. Zoom in a bit to your favorite area with some lake

3. Make the lakes layer active

4. Open the Layer Properties dialog

5. Click on the Labels tab

6. Check the Display labels checkbox to enable labeling

7. Choose the field to label with. We will use Field containing label NAMES

8. Enter a default for lakes that have no name. The default label will be used each time QGIS encounters a
lake with no value in the NAMES field.

9. If you have labels extending over several lines, check Multiline labels?. QGIS will check for a true line
return in your label field and insert the line breaks accordingly. A true line return is a single character \n,
(not two separate characters, like a backlash \ followed by the character n). To insert line returns in an
attribute field configure the edit widget to be text edit (not line edit).

10. Click [Apply].

Now we have labels. How do they look? They are probably too big and poorly placed in relation to the marker
symbol for the lakes.

Select the Font entry and use the [Font] and [Color] buttons to set the font and color. You can also change the
angle and the placement of the text-label.

To change the position of the text relative to the feature:

1. Beneath the Basic label options change the placement by selecting one of the radio buttons in the Placement
group. To fix our labels, choose the Right radio button.

2. the Font size units allows you to select between Points or Map units.

3. Click [Apply] to see your changes without closing the dialog.

Things are looking better, but the labels are still too close to the marker. To fix this we can use the options on the
Offset entry which is on the bottom of the menu. Here we can add offsets for the X and Y directions. Adding an
X offset of 5 will move our labels off the marker and make them more readable. Of course if your marker symbol
or font is larger, more of an offset will be required.

The last adjustment we’ll make is to Buffer the labels. This just means putting a backdrop around them to make
them stand out better. To buffer the lakes labels:

1. Click the Buffer Labels checkbox to enable buffering.

2. Choose a size for the buffer using the spin box.

3. Choose a color by clicking on [Color] and choosing your favorite from the color selector. You can also set
some transparency for the buffer if you prefer.

4. Click [Apply] to see if you like the changes.

If you aren’t happy with the results, tweak the settings and then test again by clicking [Apply].

A buffer of 1 points seems to give a good result. Notice you can also specify the buffer size in map units if that
works out better for you.

The advanced entries inside the Label tab allow you control the appearance of the labels using attributes stored
in the layer. The entries beginning with Data defined allow you to set all the parameters for the labels using
fields in the layer.
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Note that the Label tab provides a preview-box where your selected label is shown.

11.2.5 New Labeling

The new Labeling core application provides smart labeling for vector point, line and polygon layers and only
requires a few parameters. This new application will replace the current QGIS labeling, described in section
Labels Tab and also supports on-the-fly transformated layers.

Using new labeling

1. Start QGIS and load a vector point, line or polygon layer.

2. Activate the layer in the legend and click on the Labeling icon in the QGIS toolbar menu.

Labeling point layers

First step is to activate the Label this layer checkbox and select an attribute column to use for labeling. Click

if you want to define labels based on expressions. After that you can define the text style and the scale-based
visibility in the Label settings tab (see Figure_labels_1 ). Choose the Advanced tab for the label placement and the
labeling priority. You can define if every part of a multipart feature is to be labeled here. With the wrap label on
character function you can define a character for a line break in the labels. The Data defined settings tab provides
you with the attribute-based definition of Font properties, Buffer properties and Position.

Figure 11.15: Smart labeling of vector point layers

Labeling line layers

First step is to activate the Label this layer checkbox in the Label settings tab and select an attribute column to
use for labeling. Here you can also define labels based on expressions. After that you can define the text style and
the scale-based visibility. Further labeling options are available through the Advanced tab. You can define the label
placement and label distance, a line orientation dependend position and the labeling priority here. Furthermore
you can define if every part of a multipart line is to be labeled, if lines shall be merged to avoid duplicate labels
and if a direction symbol is added (see Figure_labels_2 ). It is also possible to supress labeling of features and
wrap lables on characters. Use Data defined settings for attribute-based or database-connection-based settings.

Labeling polygon layers

First step is to activate the Label this layer checkbox and select an attribute column to use for labeling. Here
you can also define labels based on expressions. In Label settings define the text style and the scale-based visibility
(see Figure_labels_3 ). Use the Advanced tab for label placement, label distance and labeling priority. Define if
every part of a multipart feature is to be labeled, suppress labeling of features and wrap labels on characters here.
Use Data defined settings for attribute-based or database-connection-based settings.

Change engine settings

Additionally you can click the [Engine settings] button and select the search method, used to find the best label
placement. Available is Chain, Popmusic Tabu, Popmusic Chain, Popmusic Tabu Chain and FALP.
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Figure 11.16: Smart labeling of vector line layers

Figure 11.17: Smart labeling of vector polygon layers

Figure 11.18: Dialog to change label engine settings
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Furthermore the number of candidates can be defined for point, line and polygon features, and you can define
whether to show all labels (including colliding labels) and label candidates for debugging.

Keywords to use in attribute columns for labeling

There is a list of supported key words, that can be used for the placement of labels in defined attribute columns.

• For horizontal alignment: left, center, right

• For vertical alignment: bottom, base, half, top

• Colors can be specified in svg notation, e.g. #ff0000

• for bold, underlined, strikeout and italic: 0 = false 1 = true

A combination of key words in one column also works, e.g.: base right or bottom left.

11.2.6 Fields Tab

Within the Fields tab the field attributes of the selected dataset can be manipulated. The buttons New Column

and Delete Column can be used, when the dataset is Editing mode.

At the moment only columns from PostGIS layers can be removed and added. The OGR library supports to add
and remove columns, if you have a GDAL version >= 1.9 installed.

Edit Widget

Figure 11.19: Dialog to select an edit widget for an attribute column

Within the Fields tab you also find an edit widget column. This column can be used to define values or a
range of values that are allowed to be added to the specific attribute table column. If you click on the [edit widget]
button, a dialog opens, where you can define different widgets. These widgets are:

• Line edit: an edit field which allows to enter simple text (or restrict to numbers for numeric attributes).

• Classification: Displays a combo box with the values used for classification, if you have chosen ‘unique
value’ as legend type in the Style tab of the properties dialog.

• Range: Allows to set numeric values from a specific range. The edit widget can be either a slider or a spin
box.

• Unique values: The user can select one of the values already used in the attribute table. If editable is
activated, a line edit is shown with autocompletion support, otherwise a combo box is used.
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• File name: Simplifies the selection by adding a file chooser dialog.

• Value map: a combo box with predefined items. The value is stored in the attribute, the description is
shown in the combo box. You can define values manually or load them from a layer or a CSV file.

• Enumeration: Opens a combo box with values that can be used within the columns type. This is currently
only supported by the postgres provider.

• Immutable: The immutable attribute column is read-only. The user is not able to modify the content.

• Hidden: A hidden attribute column is invisible. The user is not able to see its content.

• Checkbox: Displays a checkbox and you can define what attribute is added to the column when the check-
box is activated or not.

• Text edit: This opens a text edit field that allows multiple lines to be used.

• Calendar: Opens a calendar widget to enter a date. Column type must be text.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column.

• UUID Generator: Generates a read-only UUID (Universally Unique Identifiers) field, if empty.

11.2.7 General Tab

The General tab is essentially like that of the raster dialog. There are several options available:

• Change the display name of the layer

• Set a display field to be used for the Identify Results dialog

• Define a certain Edit User Interface for the vector layer written with the Qt Creator IDE and tools at
http://qt.digia.com/Product/Developer-Tools/

• Create a Spatial Index (only for OGR supported formats)

• Add an Init function for the layer. They will overwrite existing QGIS widget initializations, if applied

• Update Extents information for a layer

• View or change the projection of the specific vector layer, clicking on Specify CRS

Furthermore you can activate and set Use scale dependent rendering, define provider specific options (e.g.
encoding) and with the [Query Builder] button you can create a subset of the features in the layer that will be
visualized (also refer to section選択).

11.2.8 Metadata Tab

The Metadata tab contains general information about the layer, including specifics about the type and lo-
cation, number of features, feature type, and the editing capabilities. The Extents section, providing layer extent
information, and the Layer Spatial Reference System section, providing information about the CRS of the layer.
This is a quick way to get information about the layer.

Additionally you can add/edit a title for the layer and some abtract information. These information will be saved
in the QGIS project file for following sessions and will be used for QGIS server.
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Figure 11.20: General tab in vector layers properties dialog

Figure 11.21: Metadata tab in vector layers properties dialog
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11.2.9 Actions Tab

QGIS provides the ability to perform an action based on the attributes of a feature. This can be used to
perform any number of actions, for example, running a program with arguments built from the attributes of a
feature or passing parameters to a web reporting tool.

Figure 11.22: Overview action dialog with some sample actions

Actions are useful when you frequently want to run an external application or view a web page based on one or
more values in your vector layer. They are devided into 6 types and can be used like this:

• Generic, Mac, Windows and Unix actions start an external process,

• Python actions execute a python expression,

• Generic and Python actions are visible everywhere,

• Mac, Windows and Unix actions are visible only on the respective platform (i.e. you can define three ‘Edit’
actions to open an editor and the users can only see and execute the one ‘Edit’ action for their platform to
run the editor).

There are several examples included in the dialog. You can load them clicking on [Add default actions]. An
example is performing a search based on an attribute value. This concept is used in the following discussion.

Defining Actions

Attribute actions are defined from the vector Layer Properties dialog. To define an action, open the vector Layer
Properties dialog and click on the Actions tab. Select ‘Generic’ as type and provide a descriptive name for the
action. The action itself must contain the name of the application that will be executed when the action is invoked.
You can add one or more attribute field values as arguments to the application. When the action is invoked any
set of characters that start with a % followed by the name of a field will be replaced by the value of that field.
The special characters %% will be replaced by the value of the field that was selected from the identify results or
attribute table (see using_actions below). Double quote marks can be used to group text into a single argument to
the program, script or command. Double quotes will be ignored if preceded by a backslash.

If you have field names that are substrings of other field names (e.g., col1 and col10) you should indicate so,
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent the
%col10 field name being mistaken for the %col1 field name with a 0 on the end. The brackets will be removed
by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded by square
brackets, use a second set like this: [[%col10]].
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Using the Identify Features tool you can open Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by using preceeding the derived field name by (Derived).. For example, a point layer has an X and Y field and
the value of these can be used in the action with %(Derived).X and %(Derived).Y. The derived attributes
are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Two example actions are shown below:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In the first example, the web browser konqueror is invoked and passed a URL to open. The URL performs a
Google search on the value of the nam field from our vector layer. Note that the application or script called by
the action must be in the path or you must provide the full path. To be sure, we could rewrite the first exam-
ple as: /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam. This will ensure
that the konqueror application will be executed when the action is invoked.

The second example uses the %% notation which does not rely on a particular field for its value. When the action
is invoked, the %% will be replaced by the value of the selected field in the identify results or attribute table.
Using Actions

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the record and choose the action from the popup menu. Ac-
tions are listed in the popup menu by the name you assigned when defining the actions. Click on the action you
wish to invoke.

If you are invoking an action that uses the %% notation, right-click on the field value in the Identify Results dialog
or the Attribute Table dialog that you wish to pass to the application or script.

Here is another example that pulls data out of a vector layer and inserts them into a file using bash and the

echo command (so it will only work or perhaps ). The layer in question has fields for a species name
taxon_name, latitude lat and longitude long. I would like to be able to make a spatial selection of a localities
and export these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is
the action to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

After selecting a few localities and running the action on each one, opening the output file will show something
like this:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

As an exercise we create an action that does a Google search on the lakes layer. First we need to determine
the URL needed to perform a search on a keyword. This is easily done by just going to Google and doing a
simple search, then grabbing the URL from the address bar in your browser. From this little effort we see that the
format is: http://google.com/search?q=qgis, where QGIS is the search term. Armed with this information, we can
proceed:

1. Make sure the lakes layer is loaded.

2. Open the Layer Properties dialog by double-clicking on the layer in the legend or right-click and choose
Properties from the popup menu.

3. Click on the Actions tab.

4. Enter a name for the action, for example Google Search.

5. For the action, we need to provide the name of the external program to run. In this case, we can use Firefox.
If the program is not in your path, you need to provide the full path.
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6. Following the name of the external application, add the URL used for doing a Google search, up to but not
included the search term: http://google.com/search?q=

7. The text in the Action field should now look like this: firefox http://google.com/search?q=

8. Click on the drop-down box containing the field names for the lakes layer. It’s located just to the left of
the [Insert Field] button.

9. From the drop-down box The valid attribute names for this layer select ‘NAMES’ and click [Insert
Field].

10. Your action text now looks like this: firefox http://google.com/search?q=%NAMES

11. To finalize the action click the [Insert action] button.

This completes the action and it is ready to use. The final text of the action should look like this:

firefox http://google.com/search?q=%NAMES

We can now use the action. Close the Layer Properties dialog and zoom in to an area of interest. Make sure the
lakes layer is active and identify a lake. In the result box you’ll now see that our action is visible:

Figure 11.23: Select feature and choose action

When we click on the action, it brings up Firefox and navigates to the URL
http://www.google.com/search?q=Tustumena. It is also possible to add further attribute fields to the ac-
tion. Therefore you can add a + to the end of the action text, select another field and click on [Insert Field]. In
this example there is just no other field available that would make sense to search for.

You can define multiple actions for a layer and each will show up in the Identify Results dialog.

You can think of all kinds of uses for actions. For example, if you have a point layer containing locations of
images or photos along with a file name, you could create an action to launch a viewer to display the image. You
could also use actions to launch web-based reports for an attribute field or combination of fields, specifying them
in the same way we did in our Google search example.

We can also make more complex examples, for instance on how to use Python actions.

Usually when we create an action to open a file with an external application we can use absolute paths, or even-
tually relative paths, in the second case the path is relative to the location of the external program executable file.
But what about we need to use relative paths, relative to the selected layer (a file based one, like a shapefile or
spatialite)? The following code will do the trick:

command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
layerpath = layer.source() if layer.providerType() == ’ogr’ else \
(qgis.core.QgsDataSourceURI(layer.source()).database() \
if layer.providerType() == ’spatialite’ else None);
path = os.path.dirname(str(layerpath));
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image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

we have to just remember that the action is one of type Python and to change the command and imagerelpath
variables to fit our needs.

But what about if the relative path need to be relative to the (saved) project file? The code of the Python action
would be:

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) \
if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Another Python actions example if the one that allows us to add new layers to the project. For instance the
following examples will add to the project respectively a vector and a raster. The name of files to be added to the
project and the name to be given to the layer are data driven (filename and layname are column names of the table
of attributes of the vector where the action was created):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’, ’ogr’)

To add a raster (a tif image in this example) it becomes:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]’)

11.2.10 Joins Tab

The Joins tab allows you to join a loaded attribute table to a loaded vector layer. As key columns you have
to define a join layer, a join field and a target field. QGIS currently supports to join non spatial table formats
supported by OGR, delimited text and the PostgreSQL provider (see figure_joins_1).

Additionally the add vector join dialog allows to:

• Cache join layer in virtual memory

• Create attribute index on the join field

11.2.11 Diagrams Tab

The Diagrams tab allows you to add a graphic overlay to a vector layer (see figure_diagrams_1).

The current core implementation of diagrams provides support for piecharts and text diagrams. Text values of
different data columns are displayed one below the other with a circle or a box and dividers. Diagram size is based
on a fixed size or on linear scaling according to a classification attribute. The placement of the diagrams interacts
with the new labeling, so position conflicts between diagrams and labels are detected and solved. In addition to
chart positions can be fixed by the users hand.

We will demonstrate an example and overlay the alaska boundary layer a text diagram showing some temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see Section サンプル
データ).

1. First click on the Load Vector icon, browse to the QGIS sample dataset folder and load the two vector
shape layers alaska.shp and climate.shp.

82 Chapter 11. Working with Vector Data



QGIS User Guide,リリース 1.8

Figure 11.24: Join an attribute table to an existing vector layer

Figure 11.25: Vector properties dialog with diagram tab
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2. Double click the climate layer in the map legend to open the Layer Properties dialog.

3. Click on the Diagrams tab, activate Display diagrams and from Diagram type combobox select
‘Text diagram’

4. As Background color we choose a light blue and set a fixed size to 18 mm.

5. Placement could be set to AroundPoint.

6. In the diagram we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.
First select T_F_JAN as Attributes and click the green [+] button, then T_F_JUL and finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can now adapt the chart size, or change the attribute colors by double clicking on the color values in
the attribute field. Figure_diagrams_2 gives an impression.

9. Finally click [Ok].

Figure 11.26: Diagram from temperature data overlayed on a map

Additionally in the Settings → Options dialog, there is a Overlay tab where it is possible to select the placement
algorithm of the diagrams. The central point method is a generic one, the others use algorithms of the PAL library.
They also consider diagram objects and labels in different layers. Also see section Diagram Overlay Plugin for
additional diagram features.

11.3 編集

QGIS supports various capabilities for editing OGR, PostGIS and SpatiaLite vector layers.

ノート: The procedure for editing GRASS layers is different - see Section Digitizing and editing a GRASS vector
layer for details.

ちなみに: 同時編集
QGISのバージョンは誰があなたと一緒に地物の同時編集を行なっているかは追跡しません。最後に保存し
た人が編集権限を持ちます。
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11.3.1 スナップ許容量と検索半径の設定

Before we can edit vertices, we must set the snapping tolerance and search radius to a value that allows us an
optimal editing of the vector layer geometries.

Snapping tolerance

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying
to connect when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools which work with tolerance.

1. A general, project wide snapping tolerance can be defined choosing Settings → Options. On Mac: go
to QIS → Preferences..., on Linux: Edit → Options. In the Digitizing tab you can select between to
vertex, to segment or to vertex and segment as default snap mode. You can also define a default snapping
tolerance and a search radius for vertex edits. The tolerance an be set either in map units or in pixels.
The advantage of choosing pixels, is that the snapping tolerance doesn’t have to be changed after zoom
operations. In our small digitizing project (working with the Alaska dataset), we define the snapping units
in feet. Your results may vary, but something on the order of 300ft should be fine at a scale of 1:10 000
should be a reasonable setting.

2. A layer based snapping tolerance can be defined by choosing Settings → (or File →) Snapping options... to
enable and adjust snapping mode and tolerance on a layer basis (see figure_edit_1 ).

Note that this layer based snapping overrides the global snapping option set in the Digitizing tab. So if you need
to edit one layer, and snap its vertices to another layer, then enable snapping only on the snap to layer, then
decrease the global snapping tolerance to a smaller value. Furthermore, snapping will never occur to a layer which
is not checked in the snapping options dialog, regardless of the global snapping tolerance. So be sure to mark the
checkbox for those layers that you need to snap to.

Figure 11.27: Edit snapping options on a layer basis

Search radius

Search radius is the distance QGIS uses to search for the closest vertex you are trying to move when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing and it will
pop up an annoying warning to that effect. Snap tolerance and search radius are set in map units or pixels, so you
may find you need to experiment to get them set right. If you specify too big of a tolerance, QGIS may snap to the
wrong vertex, especially if you are dealing with a large number of vertices in close proximity. Set search radius
too small and it won’t find anything to move.

The search radius for vertex edits in layer units can be defined in the Digitizing tab under Settings → Options.
The same place where you define the general, project wide snapping tolerance.
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11.3.2 Zooming and Panning

Before editing a layer, you should zoom in to your area of interest. This avoids waiting while all the vertex markers
are rendered across the entire layer.

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys.

Zooming and panning with the mouse wheel

While digitizing you can press the mouse wheel to pan inside of the main window and you can roll the mouse
wheel to zoom in and out on the map. For zooming place the mouse cursor inside the map area and roll it forward
(away from you) to zoom in and backwards (towards you) to zoom out. The mouse cursor position will be the
center of the zoomed area of interest. You can customize the behavior of the mouse wheel zoom using the Map
tools tab under the Settings → Options menu.

Panning with the arrow keys

Panning the map during digitizing is possible with the arrow keys. Place the mouse cursor inside the map area and
click on the right arrow key to pan east, left arrow key to pan west, up arrow key to pan north and down arrow key
to pan south.

You can also use the spacebar to temporarily cause mouse movements to pan then map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out without interrupting your digitizing session.

11.3.3 Topological editing

Besides layer based snapping options you can also define some topological functionalities in the Snapping op-

tions... dialog in the Settings (or File) menu. Here you can define Enable topological editing and/or for

polygon layers you can activate the column Avoid Int. which avoids intersection of new polygons.

Enable topological editing

The option Enable topological editing is for editing and maintaining common boundaries in polygon mosaics.
QGIS ‘detects’ a shared boundary in a polygon mosaic and you only have to move the vertex once and QGIS will
take care about updating the other boundary.

Avoid intersections of new polygons

The second topological option in the Avoid Int. column, called Avoid intersections of new polygons avoids
overlaps in polygon mosaics. It is for quicker digitizing of adjacent polygons. If you already have one polygon,
it is possible with this option to digitise the second one such that both intersect and QGIS then cuts the second
polygon to the common boundary. The advantage is that users don’t have to digitize all vertices of the common
boundary.

11.3.4 Digitizing an existing layer

By default, QGIS loads layers read-only: This is a safeguard to avoid accidentally editing a layer if there is a
slip of the mouse. However, you can choose to edit any layer as long as the data provider supports it, and the
underlying data source is writable (i.e. its files are not read-only). Layer editing is most versatile when used on
PostgreSQL/PostGIS data sources.
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In general, editing vector layers is divided into a digitizing and an advanced digitizing tool-
bar, described in Section Advanced digitizing. You can select and unselect both under Settings
→ Toolbars →. Using the basic digitizing tools you can perform the following functions:

Icon Purpose Icon Purpose

Toggle editing Adding Features: Capture Point

Adding Features: Capture Line Adding Features: Capture Polygon

Move Feature Node Tool

Delete Selected Cut Features

Copy Features Paste Features

Save edits and continue

Table Editing: Vector layer basic editing toolbar

All editing sessions start by choosing the Toggle editing option. This can be found in the context menu after right
clicking on the legend entry for that layer.

Alternately, you can use the Toggle Editing Toggle editing button from the digitizing toolbar to start or stop the
editing mode. Once the layer is in edit mode, markers will appear at the vertices, and additional tool buttons on
the editing toolbar will become available.

ちなみに: Save Regularly

Remember to Save Edits regularly. This will also check that your data source can accept all the changes.

Adding Features

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to put the QGIS cursor into
digitizing mode.

For each feature, you first digitize the geometry, then enter its attributes. To digitize the geometry, left-click on
the map area to create the first point of your new feature.

For lines and polygons, keep on left-clicking for each additional point you wish to capture. When you have
finished adding points, right-click anywhere on the map area to confirm you have finished entering the geometry
of that feature.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. In the Digitizing tab under the Settings → Options menu,

you can also activate Suppress attributes pop-up windows after each created feature Reuse last entered
attribute values.

With the Move Feature(s) icon on the toolbar you can move existing features.

ちなみに: Attribute Value Types
For editing the attribute types are validated during the entry. Because of this, it is not possible to enter a number
into the text-column in the dialog Enter Attribute Values or vice versa. If you need to do so, you should edit the
attributes in a second step within the Attribute table dialog.

Node Tool

For both PostgreSQL/PostGIS and shapefile-based layers, the Node Tool provides manipulation capabilites of
feature vertices similar to CAD programs. It is possible to simply select multiple vertices at once and to move,
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Figure 11.28: Enter Attribute Values Dialog after digitizing a new vector feature

add or delete them alltogether. The node tool also works with ‘on the fly’ projection turned on and supports the
topological editing feature. This tool is, unlike other tools in Quantum GIS, persistent, so when some operation is
done, selection stays active for this feature and tool. If the node tool couldn’t find any features, a warning will be
displayed.

Important is to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero (i.e. 10). Otherwise QGIS will not be able to tell which vertex is being edited.

ちなみに: Vertex Markers
The current version of QGIS supports three kinds of vertex-markers: Semi transparent circle, Cross and None. To
change the marker style, choose Options from the Settings menu and click on the Digitizing tab and select the
appropriate entry.

Basic operations

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl or Shiftwhen clicking to toggle the selection state of vertices
(vertices that are currently unselected will be selected as usual, but also vertices that are already selected
will become unselected).

• Adding vertices: To add a vertex simply double click near an edge and a new vertex will appear on the
edge near to the cursor. Note that the vertex will appear on the edge, not at the cursor position, therefore it
has to be moved if necessary.

• Deleting vertices: After selecting vertices for deletion, click the Delete key. Note that you cannot use the
Node Tool to delete a complete feature; QGIS will ensure it retains the minimum number of vertices for

the feature type you are working on. To delete a complete feature use the Delete Selected tool.

• Moving vertices: Select all the vertices you want to move. Click on a selected vertex or edge and drag in
the direction you wish to move. All the selected vertices will move together. If snapping is enabled, the
whole selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the undo dialog. Remember that all operations
support topological editing when this is turned on. On the fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.
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Cutting, Copying and Pasting Features

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Features can also be pasted to external applications as text: That is, the features are represented in CSV format
with the geometry data appearing in the OGC Well-Known Text (WKT) format.

However in this version of QGIS, text features from outside QGIS cannot be pasted to a layer within QGIS. When
would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer at a
time and copy/paste features between layers. Why would we want to do this? Say we need to do some work on a
new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer and
use copy/paste to plop the needed lakes into it.

As an example we are copying some lakes to a new layer:

1. Load the layer you want to copy from (source layer)

2. Load or create the layer you want to copy to (target layer)

3. Start editing for target layer

4. Make the source layer active by clicking on it in the legend

5. Use the Select Single Feature tool to select the feature(s) on the source layer

6. Click on the Copy Features tool

7. Make the destination layer active by clicking on it in the legend

8. Click on the Paste Features tool

9. Stop editing and save the changes

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - feature and
its attributes - gets copied, make sure the schemas match.

ちなみに: Congruency of Pasted Features
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However if the destination layer is a different projection then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.

Deleting Selected Features

If we want to delete an entire polygon, we can do that by first selecting the polygon using the regular
Select Single Feature tool. You can select multiple features for deletion. Once you have the selection set, use the

Delete Selected tool to delete the features.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

ちなみに: Feature Deletion Support
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When editing ESRI shapefiles, the deletion of features only works if QGIS is linked to a GDAL version 1.3.2 or
greater. The OS X and Windows versions of QGIS available from the download site are built using GDAL 1.3.2
or higher.

Saving Edited Layers

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Edits button. When you turn editing mode off

with the Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g. disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

ちなみに: Data Integrity
It is always a good idea to back up your data source before you start editing. While the authors of QGIS have
made every effort to preserve the integrity of your data, we offer no warranty in this regard.

11.3.5 Advanced digitizing

Icon Purpose Icon Purpose

Undo Redo

Simplify Feature Add Ring

Add Part Delete Ring

Delete Part Reshape Features

Offset Curve Split Features

Merge Selected Features Rotate Point Symbols

Merge Attributes of Selected Features

Table Advanced Editing: Vector layer advanced editing toolbar

Undo and Redo

The Undo and Redo tools allow the user to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_3). This widget is not displayed by
default; it can be displayed by right clicking on the toolbar and activating the Undo/Redo check box. Undo/Redo
is however active, even if the widget is not displayed.

When Undo is hit, the state of all features and attributes are reverted to the state before the reverted operation
happened. Changes other than normal vector editing operations (for example changes done by a plugin), may or
may not be reverted, depending on how the changes were performed.

To use the undo/redo history widget simply click to select an operation in the history list; all features will be
reverted to the state they were in after the selected operation.
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Figure 11.29: Redo and Undo digitizing steps

Simplify Feature

The Simplify Feature tool allows to reduce the number of vertices of a feature, as long as the geometry doesn’t
change. You need to select a feature, it will be highlighted by a red rubber band and a slider appears. Moving the
slider, the red rubber band is changing its shape to show how the feature is being simplified. Clicking [OK] the
new, simplified geometry will be stored. If a feature cannot be simplified (e.g. MultiPolygons), a message shows
up.

Add Ring

You can create ring polygons using the Add Ring icon in the toolbar. This means inside an existing area it is
possible to digitize further polygons, that will occur as a ‘hole’, so only the area in between the boundaries of the
outer and inner polygons remain as a ring polygon.

Add Part

You can add part polygons to a selected multipolygon. The new part polygon has to be digitized outside the
selected multipolygon.

Delete Ring

The Delete Ring tool allows to delete ring polygons inside an existing area. This tool only works with polygon
layers. It doesn’t change anything when it is used on the outer ring of the polygon. This tool can be used on
polygon and multi-polygon features. Before you select the vertices of a ring, adjust the vertex edit tolerance.

Delete Part

The Delete Part tool allows to delete parts from multifeatures (e.g. to delete polygons from a multipolygon
feature). It won’t delete the last part of the feature, this last part will stay untouched. This tool works with all
multi-part geometries point, line and polygon. Before you select the vertices of a part, adjust the vertex edit
tolerance.
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Reshape Features

You can reshape line and polygon features using the Reshape Features icon on the toolbar. It replaces the line or
polygon part from the first to the last intersection with the original line. With polygons this can sometimes lead to
unintended results. It is mainly useful to replace smaller parts of a polygon, not major overhauls and the reshape
line is not allowed to cross several polygon rings as this would generate an invalid polygon.

For example, you can edit the boundary of a polygon with this tool. First, click in the inner area of the polygon
next to the point where you want to add a new vertex. Then, cross the boundary and add the vertices outside the
polygon. To finish, right-click in the inner area of the polygon. The tool will automatically add a node where the
new line crosses the border. It is also possible to remove part of the area from the polygon, starting the new line
outside the polygon, adding vertices inside, and ending the line outside the polygon with a right click.

ノート: The reshape tool may alter the starting position of a polygon ring or a closed line. So the point that
is represented ‘twice’ will not be the same any more. This may not be a problem for most applications, but it is
something to consider.

Offset Curves

The Offset Curve tool is a new editing tool. It creates parallel shifts of lines and polygon rings. The tool can
be applied to the edited layer (the geometries are modified) or also to background layers (creates copies of the
lines / rings and adds it to the the edited layer). It is thus ideally suited for the creation of distance line layers.The
displacement is shown at the bottom left of the taskbar.

Split Features

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.

Merge selected features

The Merge Selected Features tool allows to merge features that have common boundaries and the same attributes.

Merge attributes of selected features

The Merge Attributes of Selected Features tool allows to merge attributes of features with common boundaries and at-
tributes without merging their boundaries.

Rotate Point Symbols

The Rotate Point Symbols tool is currently only supported by the old symbology engine. It allows to change the
rotation of point symbols in the map canvas, if you have defined a rotation column from the attribute table of the
point layer in the Style tab of the Layer Properties. Otherwise the tool is inactive.

To change the rotation, select a point feature in the map canvas and rotate it holding the left mouse button pressed.
A red arrow with the rotation value will be visualized (see Figure_edit_4). When you release the left mouse button
again, the value will be updated in the attribute table.

ノート: If you hold the Ctrl key pressed, the rotation will be done in 15 degree steps.
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Figure 11.30: Rotate Point Symbols

11.3.6 Creating a new Vector layer

QGIS allows to create new Shapefile layers and new SpatiaLite layers. Creation of a new GRASS layer is sup-
ported within the GRASS-plugin. Please refer to section Creating a new GRASS vector layer for more information
on creating GRASS vector layers.

Creating a new Shapefile layer

To create a new Shape layer for editing, choose New → New Shapefile Layer... from the Layer menu. The
New Vector Layer dialog will be displayed as shown in Figure_edit_5. Choose the type of layer (point, line or
polygon) and the CRS (Coordinate Reference System).

Note that QGIS does not yet support creation of 2.5D features (i.e. features with X,Y,Z coordinates).

Figure 11.31: Creating a new Shapefile layer Dialog

To complete the creation of the new Shapefile layer, add the desired attributes by clicking on the [Add] button
and specifying a name and type for the attribute. A first ‘id’ column is added as default but can be removed, if

not wanted. Only Type: real , Type: integer , and Type: string attributes are supported.
Additionally and according to the attribute type you can also define the width and precision of the new attribute
column. Once you are happy with the attributes, click [OK] and provide a name for the shapefile. QGIS will
automatically add a .shp extension to the name you specify. Once the layer has been created, it will be added to
the map and you can edit it in the same way as described in Section Digitizing an existing layer above.
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Creating a new SpatiaLite layer

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_edit_6.

Figure 11.32: Creating a New SpatiaLite layer Dialog

First step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done with

the browse button to the right of the database field. Then add a name for the new layer and define the layer

type and the EPSG SRID. If desired you can select to Create an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the according column type and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend and you can edit it in the same
way as described in Section Digitizing an existing layer above.

Further management of SpatiaLite-Layers can be done with the DB Manager see DB Managerプラグイン.

11.3.7 Working with the Attribute Table

The attribute table displays features of a selected layer. Each row in the table represents one map feature and
each column contains a particular piece of information about the feature. Features in the table can be searched,
selected, moved or even edited.

To open the attribute table for a vector layer, make the layer active by clicking on it in the map legend area. Then

from the main menu Layer choose Open Attribute Table. It is also possible to rightclick on the layer and

choose Open Attribute Table from the dropdown menu.

This will open a new window which displays the feature attributes in the layer (figure_attributes_1). The number
of features and the number of selected features are shown in the attribute table title.
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Figure 11.33: Attribute Table for Alaska layer

Selecting features in an attribute table

Each selected row in the attribute table displays the attributes of a selected feature in the layer. If the set of
features selected in the main window is changed, the selection is also updated in the attribute table. Likewise, if
the set of rows selected in the attribute table is changed, the set of features selected in the main window will be
updated.

Rows can be selected by clicking on the row number on the left side of the row. Multiple rows can be marked by
holding the Ctrl key. A continuous selection can be made by holding the Shift key and clicking on several
row headers on the left side of the rows. All rows between the current cursor position and the clicked row are
selected. Moving the cursor position in the attribute table, by clicking a cell in the table, does not change the row
selection. Changing the selection in the main canvas does not move the cursor position in the attribute table.

The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort order
(downward pointing means descending values from the top row down, upward pointing means ascending values
from the top row down).

For a simple search by attributes on only one column the Look for field can be used. Select the field (column)
from which the search should be performed from the dropdown menu and hit the [Search] button. The matching
rows will be selected and the total number of matching rows will appear in the title bar of the attribute table, and

in the status bar of the main window. For more complex searches use the Advanced search button , which
will launch the Search Query Builder described in Sectionクエリビルダー.

To show selected records only, use the checkbox Show selected only. To search selected records only, use the

checkbox Search selected only. The Case sensitive checkbox allows to select case sensitive. The other
buttons at the bottom left of the attribute table window provide following functionality:

• Unselect all also with Ctrl+U

• Move selected to top also with Ctrl+T

• Invert selection also with Ctrl+S

• Copy selected rows to clipboard also with Ctrl+C

• Zoom map to the selected rows also with Ctrl+J

• Pan map to the selected rows also with Ctrl+P
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• Toggle editing mode to edit single values and to enable functionalities described below also with Ctrl+E

• Delete selected features also with Ctrl+D

• New Column for PostGIS layers and for OGR layers with GDAL version >= 1.6 also with Ctrl+W

• Delete Column for PostGIS layers and for OGR layers with GDAL version >= 1.9 also with Ctrl+L

• Open field calculator also with Ctrl+I

ちなみに: Skip WKT geometry

If you want to use attribute data in external programs (such as Excel) use the Copy selected rows to clipboard button.

You can copy the information without vector geometries if you deactivate Settings → Options → General tab
Copy geometry in WKT representation from attribute table.

Save selected features as new layer

The selected features can be saved as any OGR supported vector format and also transformed into another Coor-
dinate Reference System (CRS). Just open the right mouse menu of the layer and click on Save selection as → to
define the name of the output file, its format and CRS (see Section地図凡例). It is also possible to specify OGR
creation options within the dialog.

Working with non spatial attribute tables

QGIS allows also to load non spatial tables. This includes currently tables supported by OGR, delimited text and
the PostgreSQL provider. The tables can be used for field lookups or just generally browsed and edited using

the table view. When you load the table you will see it in the legend field. It can be opened e.g. with the
Open Attribute Table tool and is then editable like any other layer attribute table.

As an example you can use columns of the non spatial table to define attribute values or a range of values that are
allowed to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Fields Tab to find out more.

11.4 クエリビルダー

クエリビルダーは SQLのWHERE句を使用してテーブルのサブセットを定義し、メインウィンドウに結果
を表示することを可能とします。そのクエリ結果は、新しいベクタレイヤとして保存することができます。

11.4.1 クエリ

Open the attribute table choosing Open Attribute Table from the menu bar. Click on the [Advanced Search] but-
ton to open the Query builder. For example, if you have a towns layer with a population field you could
select only larger towns by entering population > 100000 in the SQL box of the Query builder. Fig-
ure_attributes_2 shows an example of the Query builder populated with data from a PostGIS layer with attributes
stored in PostgreSQL. The Fields, Values and Operators sections help the user to construct the SQL-like query.

The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to the
SQL where clause field, double click its name in the Fields list. Generally you can use the various fields, values
and operators to construct the query or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
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Figure 11.34: Query Builder

column in the Fields list and click the [Sample] button. To add a value to the SQL where clause field, double click
its name in the Values list.

The Operators section contains all usable operators. To add an operator to the SQL where clause field, click the
appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), logical operators (AND,
OR, ...) are available.

The [Test] button shows a message box with the number of features satisfying the current query, which is usable
in the process of query construction. The [Clear] button clears the text in the SQL where clause text field. The
[Save] and [Load] button allow to save and load SQL queries. The [OK] button closes the window and selects the
features satisfying the query. The [Cancel] button closes the window without changing the current selection.

ちなみに: Changing the Layer Definition
レイヤを定義するのに使われた SQLクエリを変更することでロードされた後に、レイヤ定義を変更する
ことができます。これを行うには、凡例上でレイヤをダブルクリックしベクタの:guilabel:レイヤのプロパ
ティ‘ダイアログを開いてから :guilabel:‘一般情報タブの**[クエリビルダ]**ボタンをクリックします。詳
細については:ref:vector_properties_dialogのセクションを参照してください。

11.4.2 選択

With QGIS it is possible also to select features for visualisation using a similar query builder interface to that
used inクエリビルダー. In the above section the purpose of the query builder is to highlight all selected features
meeting the filter criteria in yellow. The rest of the features do not change their appearance.

もう１つの方法は凡例内のレイヤを右クリックで選択し:guilabel:‘検索...‘を選択することです。ここで SQL
クエリを実行すると選択された地物のみがマップビューで表示されます。SQLクエリにマッチしなかった地
物はマップビューで表示されません。同様の機能ｊは:guilabel:‘レイヤプロパティ‘ダイアログの :guilabel:‘一
般情報 ‘タブからも利用可能です。右下で**[クエリビルダ]**ボタンを見つけることができるでしょう。前
述の選択は、すべてのベクタデータプロバイダで使用することができます。
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11.4.3 選択地物を新規レイヤに保存する

選択した地物は任意の OGRがサポートしたベクタフォーマットとして保存され、別の座標参照系（CRS）
に変換することができます。レイヤのコンテキストメニューを開き選択を名前をつけて保存→をクリッ
ク後、出力ファイルの名称、フォーマット、CRSを定義します。（ :ref:‘label_legend‘のセクションを参照）。
ダイアログ内で OGR作成オプションを指定することも可能です。

11.5 フィールド演算

属性テーブル内の|mActionCalculateField| :sup:‘フィールド計算機 ‘ボタンを使用すると、既存の属性値また
は定義された関数にもとづいて計算を実行することができます。例えば地物のジオメトリの長さや面積を計
算することができます。計算結果は新しい属性カラムに書き込まれるか既存のカラムの値を上書きします。

フィールド計算機アイコンをクリックしてダイアログを開く前にベクタレイヤを編集モードにする必要が
あります（figure_attributes_3を参照）。このダイアログでは最初に、選択した地物のみを更新するかどう
か、計算結果を新しい属性フィールドとして作成するか既存フィールドの更新にするかを選択しなければ
いけません。

Figure 11.35: Field Calculator

If you choose to add a new field, you need to enter a field name, a field type (integer, real or string), the total field
width, and the field precision (see figure_attributes_3). For example, if you choose a field width of 10 and a field
precision of 3 it means you have 6 signs before the dot, then the dot and another 3 signs for the precision.

**フィールドリスト**にはフィールドと値だけでなく関数も含まれます。**選択された関数ヘルプ**で関
数のヘルプを参照することができます。**式**では**関数リスト**で作成した計算式を確認できます。た
いていは演算子を使いますが**演算子**で確認ください。

In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched. To add
an attribute to the Field calculator Expression field, double click its name in the Fields and Values list. Generally
you can use the various fields, values and functions to construct the calculation expression or you can just type it
into the box. To display the values of a field, you just right click on the appropriate field. You can choose between
Load top 10 unique values and Load all unique values. On the right side opens the Field Values list with the
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unique values. To add a value to the Field calculator Expression box, double click its name in the Field Values
list.

The Operators, Math, Conversions, String, Geometry and Record groups provides several functions. In Operators
you find mathematical operators. Find Math for mathematical functions. The Conversions group contains func-
tions that convert one data type to another. The String group provides functions for data strings. In the Geometry
group you find functions for geometry objects. With Record group functions you can add a numeration to your
data set. To add a function to the Field calculator Expression box, click on the > and then doubleclick the function.

A short example illustrates how the field calculator works. We want to calculate the length of the railroads
layer from the QGIS sample dataset:

1. Load the Shapefile railroads.shp in QGIS and press Open Attribute Table.

2. Click on Toggle editing mode and open the Field Calculator dialog.

3. :guilabel:‘新しいフィールドを作る ‘のチェックを選択し、新しいフィールドに計算結果を保存します。

4. 出力フィールド名として ‘‘length‘‘を追加し、出力フィールドタイプを ‘‘real‘‘、フィールド長を 10、
精度を 3に指定します。

5. Now click on function length in the Geometry group to add it as $length into the Field calculator
expression box and click [Ok].

6. 属性テーブルで新規に ‘‘length‘‘カラムを見つけることができます。

The available functions are listed below.

column name "column name" value of the field column name
’string’ a string value
NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed
a OR b a or *b* is true
a AND b a and *b* is true
NOT a inverted truth value of a
sqrt(a) square root of a
sin(a) sinus of a
cos(a) cosinus of b
tan(a) tangens of a
asin(a) arcussinus of a
acos(a) arcuscosinus of a
atan(a) arcustangens of a
to int(a) convert string a to integer
to real(a) convert string a to real
to string(a) convert number a to string
lower(a) convert string a to lower case
upper(a) convert string a to upper case
length(a) length of string a
atan2(y,x) arcustangens of y/x using the signs of the two

arguments to determine the quadrant of the result
replace(*a*, replacethis, withthat) replace this with that in string a
regexp_replace(a,this,that) replace the regular expression this with that
substr(*a*,from,len) len characters of string *a* starting from from

(first character index is 1)
a || b concatenate strings a and b
$rownum number current row
$area area of polygon
$perimeter perimeter of polygon
$length length of line
$id feature id
$x x coordinate of point
$y y coordinate of point
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xat(n) X coordinate of the point of an n-th line (indeces
start at 0; negative values refer to the line end)

yat(n) y coordinate of the point of an n-th line (indeces
start at 0; negative values refer to the line end)

a = b a and b are equal
a != b and a <> b a and b are not equal
a >= b a is larger than or equal to b
a <= b a is less than or equal to b
a > b a is larger than b
a < b a is smaller than b
a ~ b a matches the regular expression b
a LIKE b a equals b
a ILIKE b a equals b (without regard to case-sensitive)
a |wedge| b a raised to the power of b
a * b a multiplied by b
a / b a divided by b
a + b a plus b
a - b a minus b
+ a positive sign
- a negative value of a

フィールド計算機の関数リストにある選択された関数ヘルプ、**演算子**と**式**メニューもまたレイ
ヤプロパティのスタイルタブでのルールに基づいたレンダリングを通して利用可能です。式はコアアプリ
ケーション|mActionLabeling| :sup:‘ラベリング ‘においてラベリング|browsebutton|に基づいています。
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Chapter 12

Working with Raster Data

12.1 ラスターデータの操作

This Section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including Arc/Info Binary Grid, Arc/Info ASCII Grid, GeoTIFF, Erdas Imagine and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

この文書の日付において、GDALライブラリでは100以上のラスターフォーマットがサポートされています（文
献とWeb参照のGDAL-SOFTWARE-SUITEを参照）。完全なリストは http://www.gdal.org/formats_list.html
で利用可能です。

ノート: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries or the GDAL installation of your OS was not built to support the format you want to use.
Only those formats that have been well tested will appear in the list of file types when loading a raster into QGIS.
Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

GRASSラスターデータの操作については ref:‘sec_grass‘のセクションで説明されています。

12.1.1 ラスターデータとは？

GISにおけるラスターデータは地球上表面での上下の特徴を表す個別のセルの行列です。ラスターグリッ
ドの各セルは同じサイズであり、セルはたいてい長方形です（QGISでは、それらは常に矩形でしょう）。
典型的なラスターデータセットは航空写真や衛星画像のようなリモートセンシングデータ、標高マトリク
スとしてモデル化されたデータを含みます。

ベクターデータとは異なり、ラスターデータは、典型的には、各セルに関連付けられたデータベースレコー
ドを持っていません。それらは、そのピクセルの解像度とラスタレイヤの角ピクセルの X/ Y座標によっ
てジオコーディングします。これにより QGISのマップキャンバスに正しくデータを配置することができ
ます。

QGISはラスタレイヤ内部ジオリファレンス情報（例：index:GeoTiff）を利用するか、適切なワールドファ
イルで正しくデータを表示します。

12.1.2 QGISにラスタデータをロードする

Raster layers are loaded either by clicking on the Load Raster icon or by selecting the Layer → Add Raster
Layer menu option. More than one layer can be loaded at the same time by holding down the Control or Shift
key and clicking on multiple items in the dialog Open a GDAL Supported Raster Data Source.
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ラスタレイヤをマップの凡例にロードしたら、マウスの右ボタンでレイヤ名上をクリックし、アクティブ
レイヤの特定の地物を選択したり、レイヤのラスタプロパティを設定するためのダイアログを開くことが
できます。

ラスタレイヤの右マウスボタンメニュー

• レイヤの領域にズーム

• Zoom to Best Scale (100%)

• Show in Overview

• 削除

• Set Layer CRS

• Set Project CRS from Layer

• Properties

• Rename

• Copy Style

• Add New Group

• すべてを展開する

• すべてを折りたたむ

• Update Drawing Order

12.2 ラスタのプロパティダイアログ

ラスタレイヤのプロパティを表示および設定するには、マップの凡例でレイヤ名をダブルクリックするか、
レイヤ名をクリックし、コンテキストメニューから:guilabel:‘プロパティ‘を選択します:

This will open the Raster Layer Properties dialog, (see figure_raster_1).

There are several tabs on the dialog:

• スタイル

• 透過性

• カラーマップ

• 一般情報

• メタデータ

• ピラミッド

• ヒストグラム

12.2.1 スタイルタブ

QGIS can render raster layers in two different ways:

1. 単バンド -画像の 1バンドがグレーとして、あるいは擬似カラーまたはフリークアウトでレンダリン
グされます。

2. ３バンドカラー -画像の３バンドがレンダリングされ、カラー画像を作成するために使用される赤、
緑、青の成分を表す各バンドはカラー画像を作成するために使用されます。
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Figure 12.1: Raster Layers Properties Dialog

両方のレンダリングタイプで、 :guilabel:‘カラーマップを反転 ‘チェックボックスを使ってカラー出力を
反転することができます。

単バンドレンダリング

この選択は 2方法を提供しています。最初に、（データセットが複数のバンドを持っている場合の）レンダ
リングに使用したいバンドを選択することができます。

２つ目のオプションではレンダリングで利用可能なカラーテーブルの選択肢を提供します。

The following settings are available through the dropdownbox Color map

• Grayscale (default)

• Pseudocolor

• Freak Out

• カラーマップ

When selecting the entry ‘Colormap’ from Color map combobox, the tab Colormap becomes available.
For more information seeカラーマップ.

QGISはレイヤの平均の標準偏差の与えられた数の範囲内にあるセルのみを表示するようデータを制限す
ることができます。

ラスタのレンダリングに悪影響を与えるラスターグリッドで以上に高い値を持つセルが１～２個あった場
合に便利です。このオプションは疑似カラーとフリーク愛との場合でのみ利用可能です。

３バンドカラー

この選択はラスタレイヤの見た目を変更する幅広いオプションを提供します。例えば、標準の RGB順から
何か他のものにカラーバンドを切り替えることができます。

同様に色のスケーリングが可能です。
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ちなみに: マルチバンドラスタの単バンドを表示する
もしマルチバンド画像のシングルバンド（例えば赤）を表示したい場合は、あなたは、緑と青を “設定な
し”にすると考えるかもしれません。しかしそれは正しい方法ではありません。赤のバンドを表示するに
は、イメージタイプをグレースケールに設定し、グレーで使用するバンドとして赤を選択します。

コントラスト強調

ノート: When adding GRASS rasters the option Contrast enhancement will be always set to automatically to
stretch to min max regardless if the Quantum GIS general options this is set to another value.

12.2.2 透過性タブ

QGIS has the ability to display each raster layer at varying transparency levels. Use the transparency slider to
indicate to what extent the underlying layers (if any) should be visible though the current raster layer. This is
very useful, if you like to overlay more than one rasterlayer, e.g. a shaded relief map overlayed by a classified
rastermap. This will make the look of the map more three dimensional.

さらに*データなし*として扱うラスタの値を入力することができます。これは手動もしくは|mActionCon-
textHelp| :sup:‘画面から値を追加 ‘アイコンで設定出来ます。

An even more flexible way to customize the transparency can be done in the Custom transparency options section.
The transparency of every pixel can be set here.

As an example we want to set the water of our example raster file landcover.tif to a transparency of 20 %.
The following steps are neccessary:

1. ラスタファイル :file:‘landcover‘をロードします。

2. Open the Properties dialog by double-clicking on the raster name in the legend or by right-clicking and
choosing Properties from the popup menu.

3. 透過性タブを選択します。

4. Click the Add values manually button. A new row will appear in the pixel-list.

5. ラスタ値（ここでは 0を使用）を入力し、透過率を 20％に調節します。

6. **[Apply]**ボタンを押し、マップを見ます。

より多くの値についてカスタムの透過率を調節するには、手順の４と５を繰り返します。

As you can see this is quite easy to set custom transparency, but it can be quite a lot of work. Therefore you

can use the button Export to file to save your transparency list to a file. The button Import from file loads your
transparency settings and applies them to the current raster layer.

12.2.3 カラーマップ

The Colormap tab is only available, when you have selected a singleband rendering within the Style tab (seeスタ
イルタブ).

Three ways of color interpolation are available:

1. Discrete

2. Linear

3. Exact

The button [Add Entry] adds a color to the individual color table. Button [Delete Entry] deletes a color from the
individual color table and the [Sort] button sorts the color table according to the pixel values in the value column.
Double clicking on the value-column lets you insert a specific value. Double clicking on the color-column opens
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the dialog Select color where you can select a color to apply on that value. Further you can also add labels for
each color but this value won’t be displayed when you use the identify feature tool.

You can also click on the button Load color map from band, which tries to load the table from the band (if it has any).

And you can use the buttons Load color map from file or Export color map to file to load an existing color table or to
save the defined color table for other sessions.

The block Generate new color map allows you to create newly categorized colormaps. You only need to select

the number of entries and press the button Classify. Currently only one Classification mode is
supported - ‘Equal interval’

12.2.4 一般情報タブ

The General tab displays basic information about the selected raster, including the layer source and display name
in the legend (which can be modified). This tab also shows a thumbnail of the layer, its legend symbol, and the
palette.

さらに、縮尺に応じた表示設定を行うことができます。チェックボックスにチェックを入れ、データがマッ
プキャンバスに表示される適当な縮尺を入力します。

同様に、座標参照系（CRS）が PROJ.4形式で表示されます。これは**[指定]**ボタンをクリックして変更
できます。

12.2.5 メタデータタブ

メタデータタブでは現在のラスタレイヤの各バンドの統計情報など、ラスタレイヤーに関する多くの情報
を表示します。統計情報は ’必要なときに収集 ’されるので、レイヤーの統計情報が未収集である可能性
もあります。

This tab is mainly for information. You cannot change any values printed inside this tab.

12.2.6 ピラミッドタブ

高解像度のラスタレイヤーは QGIS上での表示が遅くなってしまう可能性があります。そこで、より低解
像度のコピー画像群（ピラミッド）を作成すると、QGISはズームレベルに応じて適切な解像度のコピー画
像を選択して表示するので、パフォーマンスを大幅に改善することができます。

ピラミッドを作成するには、オリジナル画像があるディレクトリへの書き込み権限を持っている必要があ
ります。

Several resampling methods can be used to calculate the pyramids:

• Average

• Nearest Neighbour

When checking the checkbox Build pyramids internally if possible QGIS tries to build pyramids internally.

作成されたピラミッドはオリジナルデータを変更する可能性があり、一旦作成すると消去できない点にご
注意ください。ラスタの’ノンピラミッド’版を保存したい場合は、ピラミッド画像を作成する前にバック
アップを作成しておいてください。

12.2.7 ヒストグラムタブ

The Histogram tab allows you to view the distribution of the bands or colors in your raster. It is generated
automaticaly when you open Histogram tab. All existing bands will be displayed together. You can save the

histogram as an image with the button.
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12.3 ラスタ計算機

The Raster Calculator in the Raster menu (see figure_raster_2) allows to perform calculations on basis of existing
raster pixel values. The results are written to a new raster layer with a GDAL supported format.

Figure 12.2: Raster Calculator

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions or you can just type it into the box.

**結果レイヤ**セクションでは、出力レイヤを定義する必要があります。入力ラスタレイヤに基づいて、ま
たは X、Y座標と出力レイヤの解像度を設定するための行と列に基づいて計算領域を定義することができ
ます。入力レイヤが異なる解像度をもつ場合、値が最近傍アルゴリズムを用いてリサンプリングされます。

The Operators section contains all usable operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Stay tuned for more operators to come!

With the Add result to project checkbox the result layer will automatically added to the legend area and can
be visualized.

12.3.1 Examples

Convert elevation values from meter to feet

Creating an elevation raster feet from a raster in meter, you need to use the conversion factor for meters to feet:
3.28. The expression is:

elevation@1 * 3.28

Using a mask

If you want to mask out parts of a raster, because you are only interested in elevations above 0 meter, you can use
following expression to create a mask and apply the result to a raster in one step.
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(elevation@1 >= 0) * elevation@1

For every cell greater than or equal to 0, set its value to 1, otherwise set it to 0. This creates the mask on the fly.
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Chapter 13

Working with OGC Data

13.1 Working with OGC Data

QGIS supports WMS and WFS as data sources.

13.1.1 What is OGC Data

The Open Geospatial Consortium (OGC), is an international organization with more than 300 commercial, gov-
ernmental, nonprofit and research organizations worldwide. Its members develop and implement standards for
geospatial content and services, GIS data processing and exchange.

Describing a basic data model for geographic features an increasing number of specifications are developed to
serve specific needs for interoperable location and geospatial technology, including GIS. Further information can
be found under http://www.opengeospatial.org/.

Important OGC specifications are:

• WMS — Web Map Service

• WFS — Web Feature Service

• WCS — Web Coverage Service

• CAT — Web Catalog Service

• SFS — Simple Features for SQL

• GML — Geography Markup Language

OGC services are increasingly being used to exchange geospatial data between different GIS implementations
and data stores. QGIS can now deal with three of the above specifications, being SFS (through support of the
PostgreSQL / PostGIS data provider, see Section PostGIS Layers), WFS and WMS as a client.

13.1.2 WMS Client

Overview of WMS Support

QGIS currently can act as a WMS client that understands WMS 1.1, 1.1.1 and 1.3 servers. It has particularly been
tested against publicly accessible servers such as DEMIS.

WMS servers act upon requests by the client (e.g. QGIS) for a raster map with a given extent, set of layers,
symbolization style, and transparency. The WMS server then consults its local data sources, rasterizes the map,
and sends it back to the client in a raster format. For QGIS this would typically be JPEG or PNG.

WMS is generically a REST (Representational State Transfer) service rather than a fully-blown Web Service. As
such, you can actually take the URLs generated by QGIS and use them in a web browser to retrieve the same
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images that QGIS uses internally. This can be useful for troubleshooting, as there are several brands of WMS
servers in the market and they all have their own interpretation of the WMS standard.

WMS layers can be added quite simply, as long as you know the URL to access the WMS server, you have a
serviceable connection to that server, and the server understands HTTP as the data transport mechanism.

Selecting WMS Servers

The first time you use the WMS feature, there are no servers defined.

Begin by clicking the Add WMS layer button inside the toolbar, or through the Layer → Add WMS Layer... menu.

The dialog Add Layer(s) from a Server for adding layers from the WMS server appears. You can add some servers
to play with by clicking the [Add default servers] button. This will add two WMS demo servers for you to use, the
WMS servers of the DM Solutions Group and Lizardtech. To define a new WMS server in the tab Layers, select
the [New] button. Then enter the parameters to connect to your desired WMS server, as listed in table_OGC_1:

Name A name for this connection. This name will be used in the Server Connections drop-down
box so that you can distinguish it from other WMS Servers.

URL URL of the server providing the data. This must be a resolvable host name; the same
format as you would use to open a telnet connection or ping a host.

Username Username to access a secured WMS-server. This parameter is optional.
Password Password for a basic authenticated WMS-server. This parameter is optional.

Ignore GetMap
URI

Ignore GetMap URI reported in capabilities, use given URI from URL-field above.

Ignore
GetFeatureInfo
URI

Ignore GetFeatureInfo URI reported in capabilities , use given URI from URL-field
above

Table OGC 1: WMS Connection Parameters

If you need to set up a proxy-server to be able to receive WMS-services from the internet, you can add your
proxy-server in the options. Choose menu Settings → Options and click on the tab Network & Proxy. There you

can add your proxy-settings and enable them by setting the Use proxy for web access. Make sure that you

select the correct proxy type from the Proxy type dropdown menu.

Once the new WMS Server connection has been created, it will be preserved for future QGIS sessions.

ちなみに: On WMS Server URLs
Be sure, when entering in the WMS server URL, that you have the base URL. For example, you shouldn’t have
fragments such as request=GetCapabilities or version=1.0.0 in your URL.

Loading WMS Layers

Once you have successfully filled in your parameters you can select the [Connect] button to retrieve the capabil-
ities of the selected server. This includes the Image encoding, Layers, Layer Styles and Projections. Since this is
a network operation, the speed of the response depends on the quality of your network connection to the WMS
server. While downloading data from the WMS server, the download progress is visualized in the left bottom of
the WMS dialog.

Your screen should now look a bit like figure_OGR_1, which shows the response provided by the DM Solutions
Group WMS server.

Image Encoding

The Image encoding section now lists the formats that are supported by both the client and server. Choose one
depending on your image accuracy requirements.

ちなみに: Image Encoding
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Figure 13.1: Dialog for adding a WMS server, showing its available layers

You will typically find that a WMS server offers you the choice of JPEG or PNG image encoding. JPEG is a lossy
compression format, whereas PNG faithfully reproduces the raw raster data.

Use JPEG if you expect the WMS data to be photographic in nature and/or you don’t mind some loss in picture
quality. This trade-off typically reduces by 5 times the data transfer requirement compared to PNG.

Use PNG if you want precise representations of the original data, and you don’t mind the increased data transfer
requirements.

Options

The Options field provides a text field where you can add a Layer name for the WMS-layer. This name will be
presented in the legend after loading the layer.

Below the layer name you can define Tile size, if you want to set tile sizes (eg. 256x256) to split up the WMS
request into multiple requests.

The Feature limit for GetFeatureInfo defines what features from the server to query.

If you select a WMS from the list a field with the default projection, provided by the mapserver, appears. If the
[Change...] button is active, you can click on it and change the default projection of the WMS to another CRS,
provided by the WMS server.

Layer Order

The tab Layer Order lists the selected layers available from the current connected WMS server. You may notice
that some layers are expandable, this means that the layer can be displayed in a choice of image styles.

You can select several layers at once, but only one image style per layer. When several layers are selected, they
will be combined at the WMS Server and transmitted to QGIS in one go.

ちなみに: WMS Layer Ordering
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WMS layers rendered by a server are overlaid in the order listed in the Layers section, from top to bottom of the
list. If you want to change the overlay order, you can use the tab Layer Order.

Transparency

In this version of QGIS, the Global transparency setting from the Layer Properties is hard-coded to be always on,
where available.

ちなみに: WMS Layer Transparency
The availability of WMS image transparency depends on the image encoding used: PNG and GIF support trans-
parency, whilst JPEG leaves it unsupported.

Coordinate Reference System

A Coordinate Reference System (CRS) is the OGC terminology for a QGIS Projection.

Each WMS Layer can be presented in multiple CRSs, depending on the capability of the WMS server.

To choose a CRS, select [Change...] and a dialog similar to Figure Projection 3 in投影法の利用方法 will appear.
The main difference with the WMS version of the screen is that only those CRSs supported by the WMS Server
will be shown.

Server-Search

Within QGIS you can search for WMS-servers. Figure_OGC_2 shows the tab Server Search with the Add Layer(s)
from a Server dialog.

Figure 13.2: Dialog for searching WMS servers after some keywords

As you can see it is possible to enter a search-string in the text field and hit the [Search] button. After a short while
the search result will be populated into the list below the text field. Browse the result list and inspect your search
results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS-list]
button and change back to the tab Layers. QGIS automatically has updated your server list and the selected search
result is already enabled in the list of saved WMS-servers in the Layers tab. You only need to request the list of
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layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.

Basically this option is a frontend to the API of http://geopole.org.

Tilesets

When using WMS-C (Cached WMS) Services like http://labs.metacarta.com/wms-c/Basic.py you are able to
browse through the tab Tilesets given by the server. Additional information like tile size, formats and supported
CRS are listed in this table. In combination with this feature you can use the tile scale slider from the View → Tile
scale slider, which gives you the available scales from the tileserver with nice slider docked in.

Using the Identify Tool

Once you have added a WMS server, and if any layer from a WMS server is queryable, you can then use the
Identify tool to select a pixel on the map canvas. A query is made to the WMS server for each selection made. The
results of the query are returned in plain text. The formatting of this text is dependent on the particular WMS
server used. Viewing Properties

Once you have added a WMS server, you can view its properties by right-clicking on it in the legend, and selecting
Properties. Metadata Tab

The tab Metadata displays a wealth of information about the WMS server, generally collected from the Capabil-
ities statement returned from that server. Many definitions can be cleaned by reading the WMS standards (see
OPEN-GEOSPATIAL-CONSORTIUM文献とWeb参照), but here are a few handy definitions:

• Server Properties

– WMS Version — The WMS version supported by the server.

– Image Formats — The list of MIME-types the server can respond with when drawing the map.
QGIS supports whatever formats the underlying Qt libraries were built with, which is typically at least
image/png and image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently QGIS supports the text-plain type.

• Layer Properties

– Selected — Whether or not this layer was selected when its server was added to this project.

– Visible — Whether or not this layer is selected as visible in the legend. (Not yet used in this version
of QGIS.)

– Can Identify — Whether or not this layer will return any results when the Identify tool is used on it.

– Can be Transparent — Whether or not this layer can be rendered with transparency. This version of
QGIS will always use transparency if this is Yes and the image encoding supports transparency

– Can Zoom In — Whether or not this layer can be zoomed in by the server. This version of QGIS
assumes all WMS layers have this set to Yes. Deficient layers may be rendered strangely.

– Cascade Count — WMS servers can act as a proxy to other WMS servers to get the raster data for a
layer. This entry shows how many times the request for this layer is forwarded to peer WMS servers
for a result.

– Fixed Width, Fixed Height — Whether or not this layer has fixed source pixel dimensions. This
version of QGIS assumes all WMS layers have this set to nothing. Deficient layers may be rendered
strangely.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g. UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
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WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.

– Available in CRS — The projections that this layer can be rendered in by the WMS server. These are
listed in the WMS-native format.

– Available in style — The image styles that this layer can be rendered in by the WMS server.

WMS Client Limitations

Not all possible WMS Client functionality had been included in this version of QGIS. Some of the more notable
exceptions follow.

Editing WMS Layer Settings

Once you’ve completed the Add WMS layer procedure, there is no ability to change the settings. A workaround is
to delete the layer completely and start again.

WMS Servers Requiring Authentication

Currently public accessible and secured WMS-services are supported. The secured WMS-servers can be accessed
by public authentication. You can add the (optional) credentials when you add a WMS-server. See section Select-
ing WMS Servers for details.

ちなみに: Accessing secured OGC-layers
If you need to access secured layers with other secured methods than basic authentication, you could use InteProxy
as a transparent proxy, which does support several authentication methods. More information can be found at the
InteProxy manual found on the website http://inteproxy.wald.intevation.org.

ちなみに: QGIS WMS Mapserver
From Version 1.7.0 QGIS has its own implementation of a WMS 1.3.0 Mapserver. Read more about this at chapter
QGIS Server.

13.1.3 WFS and WFS-T Client

In QGIS, a WFS layer behaves pretty much like any other vector layer. You can identify and select features and
view the attribute table. Since QGIS 1.6 editing (WFS-T) is also supported.

In general adding a WFS layer is very similar to the procedure used with WMS. The difference is there are no
default servers defined, so we have to add our own.

Loading a WFS Layer

As an example we use the DM Solutions WFS server and display a layer. The URL is:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Click on the Add WFS Layer tool on the Layers toolbar, the dialog Add WFS Layer from a Server appears

2. Click on [New]

3. Enter ‘DM Solutions’ as name

4. Enter the URL (see above)

5. Click [OK]

6. Choose ‘DM Solutions’ from the Server Connections combobox

7. Click [Connect]

8. Wait for the list of layers to be populated
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9. Select the Parks layer in the list

10. Click [Apply] to add the layer to the map

Note that proxy-settings you have set in your preferences are also recognized.

Figure 13.3: Adding a WFS layer

You’ll notice the download progress is visualized in the left bottom of the QGIS main window. Once the layer is
loaded, you can identify and select a province or two and view the attribute table.

Only WFS 1.0.0 is supported. At this point there have not been many tests against WFS versions implemented in
other WFS-servers. If you encounter problems with any other WFS-server, please do not hesitate to contact the
development team. Please refer to Sectionメーリングリスト for further information about the mailinglists.

ちなみに: Finding WFS Servers
You can find additional WFS servers by using Google or your favorite search engine. There are a number of lists
with public URLs, some of them maintained and some not.

13.2 QGIS Server

QGIS Serverは、オープンソースWMS1.3とWFS1.0.0の実装だけでなく、それに加え、主題マッピングの
ための高度な地図作成機能を実装しています。QGISサーバは webサーバ（例. Apache, Lighttpd）と一緒
に動作する C++で書かれた FastCGI/CGI（Common Gateway Interface）アプリケーションです。これは EU
のプロジェクトオーケストラ、Sanyとスイスウスター市が資金提供しています。

It uses QGIS as backend for the GIS logic and for map rendering. Furthermore the Qt library is used for graphics
and for platform independent C++ programming. In contrast to other WMS software, the QGIS Server uses carto-
graphic rules as a configuration language, both for the server configuration and for the user-defined cartographic
rules.

また、QGIS Serverプロジェクトは、　現在のレイヤとシンボロジーを QGISサーバの webプロジェクト
（SLDで表現された地図作成表現ツールを含む）として出力する QGISデスクトップのためのプラグインで
ある’Publish to Web’プラグインを提供しています。

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS. The ‘Publish to Web’ plugin currently supports basic symbolization, with more
complex cartographic visualization rules introduced manually. As the configuration is performed with the SLD
standard and its documented extensions, there is only one standardised language to learn, which greatly simplifies
the complexity of creating maps for the Web.

次のマニュアルの１つでは、QGISサーバをセットアップするための設定のサンプルを提供します。しか
し、我々は、詳細を得るために次の URLの１つを読むことをお勧めします：
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• http://karlinapp.ethz.ch/qgis_wms/

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

13.2.1 Debian Squeezeのインストールサンプル

この時点で、Debian Squeezeのための HowToとなる短くて簡単なサンプル設定を提供します。他の多くの
OSが QGISサーバのためにパッケージを提供しています。もしソースからすべてを構築する必要がある場
合は、上記のの URLを参照してください。

Apart from qgis and qgis-mapserver you need a webserver, in our case apache2. You can install all pack-
ages with aptitude or apt-get install together with other necessary dependency packages. After installation you
should test, if the webserver and qgis server works as expected. Make sure the apache server is running with
/etc/init.d/apache2 start. Open a web browser and type URL: http://localhost. If apache is
up, you should see the message ‘It works!’.

Now we test the qgis server installation. The qgis_mapserv.fcgi is available at
/usr/lib/cgi-bin/qgis_mapserv.fcgi and provides a standard wms that shows the state boundaries
of Alaska. Add the WMS with the URL http://localhost/cgi-bin/qgis_mapserv.fcgi as
described in Selecting WMS Servers.

Figure 13.4: Standard WMS with USA boundaries included in the qgis server (KDE)

13.2.2 Creating a WMS/WFS from a QGIS project

To provide a new qgis wms/wfs server we have to create a qgis project file with some data. Here we use the
‘alaska’ shapefile from the qgis_sample_dataset. Define the colors and styles of the layers in QGIS and define the
project CRS, if not already done.

Then open the OWS Server tab in the menu Settings → Project Properties and define the general fields under
‘Service Capabilities’. For WMS Capabilities define ‘Coordinate System Restrictions’ and ‘Advertised Ex-

tend’. Additionally you can enable the checkbox Add WKT geometry to feature into response to make the lay-
ers queryable and add a ‘Maximum width’ and height that can be requested. For WFS Capabilities you only
need to select the layers that you want to provide as WFS. Now save the session in a project file alaska.qgs.
To provide the project as a WMS/WFS, we create a new folder /usr/lib/cgi-bin/project with admin
privileges and add the project file alaska.qgs and a copy of the qgis_mapserv.fcgi file - that’s all.

Now we test our project WMS and WFS, add the WMS and WFS as described in Loading WMS Layers and WFS
and WFS-T Client to QGIS and load the WMS. The URL is:
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Figure 13.5: Definitions for a qgis project WMS/WFS server (KDE)

http://localhost/cgi-bin/project/qgis_mapserv.fcgi
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Chapter 14

Working with GPS Data

14.1 GPSプラグイン

14.1.1 GPSとは？

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find
their exact position anywhere in the world. It is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receivers movement over time. Waypoints, routes and
tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers while routes and
tracks are displayed in linestring layers.

14.1.2 ファイルからGPSデータを読み込み

GPSデータの記録フォーマットには,様々なフォーマットが存在します.QGISでは,GPX(GPS eXchange format)
と呼ばれる,ウェイポイントの記録およびデータ交換フォーマットとして一般的なフォーマットに対応して
います.GPXフォーマットは,同一ファイルで,複数のウェイポイント,経路,軌跡を扱うことが可能です

To load a GPX file you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded two buttons with a small handheld GPS
device will show up in the toolbar:

• Create new GPX Layer

• GPS Tools

For working with GPS data we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See Section サンプルデータ for more infor-
mation about the sample data.

1. GPS ツール ‘をクリックし、 :guilabel:‘GPXファイルをロード tab (figure_GPS_1_参照)

2. Browse to the folder qgis_sample_data/gps/, select the GPX file national_monuments.gpx
and click [Open].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.

ノート: GPSユニットは,様々なシステムでデータを蓄積することができます.(GPSユニットやインター
ネットから)GPXファイルをダンロードし,QGISで読み込む際,GPXファイルには,WGS84型式 (緯度経度)

119



QGIS User Guide,リリース 1.8

Figure 14.1: The GPS Tools dialog window

でデータが保存されていることが必要です.QGISで GPXファイルを扱う際,当該ファイルが公式 GPX仕様
に則っているものとして動作します. 公式 GPX仕様については, ‘http://www.topografix.com/GPX/1/1/‘を参
照してください

14.1.3 GPSBabel

Since QGIS uses GPX files you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

14.1.4 GPSデータのインポート

To import GPS data from a file that is not a GPX file, you use the tool Import other file in the GPS Tools dialog.
Here you select the file that you want to import (and the file type), which feature type you want to import from it,
where you want to store the converted GPX file and what the name of the new layer should be. Note that not all
GPS data formats will support all three feature types, so for many formats you will only be able to choose between
one or two types.

14.1.5 GPS装置からGPSデータのダウンロード

QGISは GPSデバイスから新しいベクタレイヤとして直接データをダウンロードするために GPSBabelを
使用します。これを使用するため、GPSツールダイアログ（Figure_GPS_2を参照）の guilabel:‘GPSから
ダウンロード ‘タブを使用します。ここでは、GPSデバイスの種類、接続ポート（または GPSをサポート
している USB）、ダウンロードしたい地物のタイプ、保存された GPSファイルの場所、そして新しいレイ
ヤの名称を選択します。

Figure 14.2: The download tool

120 Chapter 14. Working with GPS Data

http://www.topografix.com/GPX/1/1/
http://www.gpsbabel.org


QGIS User Guide,リリース 1.8

GPSデバイスメニューで選択したデバイスタイプは、GPSBabelが GPSデバイスとどのように接続するか
を決定します。GPSデバイスで動作する利用可能なタイプがない場合、新しいタイプを作成することがで
きます（:ref:‘defining-new-device‘のセクションを参照すること）。

ポートはファイル名、もしくはオペレーティングシステムが GPSデバイスと接続するコンピュータの物理
ポートへの参照として使用する他の名前かもしれません。または usb対応 GPSユニットのために、単純な
usbである場合もあります。

• On Linux this is something like /dev/ttyS0 or /dev/ttyS1

• On Windows it is COM1 or COM2.

**[OK]**をクリックすると、デバイスからデータがダウンロードされｍ QGISのレイヤとして現れます。

14.1.6 GPSデータのデバイスへのアップロード

GPSツールダイアログの:guilabel:‘GPSにアップロード ‘タブを使って QGISのベクタレイヤから直接 GPS
デバイスにデータをアップロードできます。これを行うには、単にアップロードしたいレイヤ（GPXレイ
ヤでなければ行けません）、GPSデバイスの種類、それが接続されているポート（または USB）を選択し
ます。お使いのデバイスがリストにない場合、ダウンロードツールと同じように、新しいデバイスタイプ
を指定することができます。

このツールは、QGISの編集機能と組み合わせるのに非常に便利です。それでマップをロードし、ウェイポ
イントとルートを作成してからそれらをアップロードし、GPSデバイスで使用することを可能とします。

14.1.7 新しいデバイスタイプの定義

GPS デバイスには多くの異なるタイプがある。QGIS 開発者はすべてのものをテストできないため、も
し:guilabel:GPSからダウンロード と :guilabel:‘GPSにアップロード ‘ツールにリストアップされたデバイ
スタイプではあなたのものが動作しない場合は、あなた自身のデバイスタイプを定義できます。あなたは
GPSデバイスエディタを使用することがそれができ、ダウンロードまたはアップロードタブの**[デバイ
スを編集]**ボタンをクリックすることで編集を開始出来ます。

To define a new device you simply click the [New device] button, enter a name, a download command and an
upload command for your device, and click the [Update device] button. The name will be listed in the device
menus in the upload and download windows, and can be any string. The download command is the command that
is used to download data from the device to a GPX file. This will probably be a GPSBabel command, but you can
use any other command line program that can create a GPX file. QGIS will replace the keywords %type, %in,
and %out when it runs the command.

％ typeは、ウェイポイントをダウンロードする場合-w‘‘で、トラックをダウンロードする場合 ‘‘-r‘‘で、
トラックをダウンロードする場合 ‘‘-t‘‘に置き換わります。これらはどの地物タイプをダウンロードするか
を GPSBabelに伝えるためのコマンドラインオプションです。

%in will be replaced by the port name that you choose in the download window and %out will be replaced
by the name you choose for the GPX file that the downloaded data should be stored in. So if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

アップロードコマンドはデバイスにデータをアップロードするために使用されます。同様のキーワードが使
われますが、‘‘%in‘‘はアップロードされるレイヤに対するGPXファイルの名称に置き換えられ、‘‘%out‘‘は
ポート名称に置き換えられます。

GPSBabel と利用可能なコマンドラインオプションについては http://www.gpsbabel.org　でより学習でき
ます。

いったん新しいデバイスタイプを作成すると、ダウンロードおよびアップロードツールのデバイスリスト
に表示されます。
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14.2 Live GPSトラッキング

To activate Live GPS tracking in QGIS you need to select Settings → GPS information. You will get a new
docked window on the left side of the canvas.

There are 4 possible screens in this GPS tracking window:

• |mActionToggleEditing|GPS位置座標と手動で頂点と地物を入力します。

• |gpstrack_barchart|衛星との接続の GPSシグナル長。

• |gpstrack_polarchart|数と衛星の極性位置を示す GPS極性画面。

• GPS options screen (see figure_gps_options).

With a plugged in GPS receiver (has to be supported by your operating system) a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS-receiver from your computer.
For GNU/Linux gpsd support is integrated to support connection to most GPS receivers. Therefore you first have
to configure gpsd properly to connect QGIS to it.

警告: あなたがキャンバスに自分の位置を記録したい場合は、最初に新しいベクタレイヤを作成し、あ
なたのトラックを記録することができるようにステータスを編集可能に切り替えなければいけません。

14.2.1 Position and additional attributes

If the GPS is receiving signals from satellites you will see your position in latitude, longitude and altitude
together with additional attributes.

Figure 14.3: GPS tracking position and additional attributes

14.2.2 GPSシグナル長

Here you can see the signal strenght of the satellites you are receiving signals from.

14.2.3 GPS polarウィンドウ

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.
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Figure 14.4: GPS tracking signal strength

Figure 14.5: GPS tracking polar window

14.2.4 GPSオプション

In case of connection problems you can switch between:

• Autodetect

• Internal,

• Serial device

• gpsd (selecting Host, Port and Device your GPS is connected to).

A click on [Connect] again initiates the connection to the GPS receiver.

You can activate Automatically save added features when you are in editing mode. Or you can can activate

Automatically add points to the map canvas with a certain width and color.

Activating Cursor you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows to decide in which way the canvas will be updated. This includes ‘always’,
‘when leaving’ if your recorded coordinates start either to move out of canvas or ‘never’ to keep map extent.

Finally you can activate Log file and define a path and a file where log messages about the gps tracking a
logged.

If you want to set a feature manually you have to go back to Position and click on [Add Point] or [Add track
point].
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Figure 14.6: GPS tracking options window
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GRASS GISの統合

GRASSプラグインは GRASS GIS (GRASS-PROJECT :ref:‘literature_and_web‘を参照)のデータベースや機
能へのアクセスを提供します。これは GRASSのラスタおよびベクタレイヤの表示、ベクタレイヤのデジ
タイズ、ベクタ属性の編集、新規ベクタレイヤの作成、300個以上の GRASSモジュールを使った GRASS
2Dと 3Dデータの解析を含みます。

このセクションではプラグインの機能と GRASSデータの管理と操作の例を紹介します。以下のメインの
機能は GRASSプラグインを立ち上げた時にツールバーメニューで提供されています。機能については　
GRASSプラグインの起動に記述されています:

• マップセットを開く

• 新しいマップセット

• マップセットを閉じる

• GRASSベクタレイヤを追加

• GRASSラスタレイヤを追加

• 新しい GRASS ベクタを作成する

• GRASS ベクタレイヤを編集す

• GRASS ツールを開く

• 現在の GRASS リージョンを表示

• 現在の GRASS リージョンを編集

15.1 GRASSプラグインの起動

To use GRASS functionalities and/or visualize GRASS vector and raster layers in QGIS, you must select and load

the GRASS plugin with the Plugin Manager. Therefore click the menu Plugins → Manage Plugins, select
GRASS and click [OK].

You can now start loading raster and vector layers from an existing GRASS LOCATION (see section Loading
GRASS raster and vector layers). Or you create a new GRASS LOCATION with QGIS (see section Creating
a new GRASS LOCATION) and import some raster and vector data (see Section Importing data into a GRASS
LOCATION) for further analysis with the GRASS Toolbox (see section The GRASS toolbox).
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15.2 Loading GRASS raster and vector layers

With the GRASS plugin, you can load vector or raster layers using the appropriate button on the toolbar menu.
As an example we use the QGIS alaska dataset (see Sectionサンプルデータ). It includes a small sample GRASS
LOCATION with 3 vector layers and 1 raster elevation map.

1. Create a new folder grassdata, download the QGIS alaska dataset qgis_sample_data.zip from
http://download.osgeo.org/qgis/data/ and unzip the file into grassdata.

2. Start QGIS.

3. If not already done in a previous QGIS session, load the GRASS plugin clicking on Plugins → Manage

Plugins and activate GRASS. The GRASS toolbar appears in the QGIS main window.

4. In the GRASS toolbar, click the Open mapset icon to bring up the MAPSET wizard.

5. For Gisdbase browse and select or enter the path to the newly created folder grassdata.

6. You should now be able to select the LOCATION alaska and the MAPSET demo.

7. Click [OK]. Notice that some previously disabled tools in the GRASS toolbar are now enabled.

8. Click on Add GRASS raster layer, choose the map name gtopo30 and click [OK]. The elevation layer will
be visualized.

9. Click on Add GRASS vector layer, choose the map name alaska and click OK. The alaska boundary vector
layer will be overlayed on top of the gtopo30 map. You can now adapt the layer properties as described
in chapterベクタプロパティダイアログ, e.g. change opacity, fill and outline color.

10. Also load the other two vector layers rivers and airports and adapt their properties.

As you see, it is very simple to load GRASS raster and vector layers in QGIS. See following sections for editing
GRASS data and creating a new LOCATION. More sample GRASS LOCATIONs are available at the GRASS
website at http://grass.osgeo.org/download/data.php.

ちなみに: GRASS Data Loading
If you have problems loading data or QGIS terminates abnormally, check to make sure you have loaded the
GRASS plugin properly as described in section GRASSプラグインの起動.

15.3 GRASS LOCATION and MAPSET

GRASS data are stored in a directory referred to as GISDBASE. This directory often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATION. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics, subregions, or as
workspaces for individual team members (Neteler & Mitasova 2008文献とWeb参照). In order to analyze vector
and raster layers with GRASS modules, you must import them into a GRASS LOCATION (This is not strictly
true - with the GRASS modules r.external and v.external you can create read-only links to external
GDAL/OGR-supported data sets without importing them. But because this is not the usual way for beginners to
work with GRASS, this functionality will not be described here.).

15.3.1 Creating a new GRASS LOCATION

As an example here is how the sample GRASS LOCATION alaska, which is projected in Albers Equal Area
projection with unit feet was created for the QGIS sample dataset. This sample GRASS LOCATION alaska
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Figure 15.1: GRASS data in the alaska LOCATION

will be used for all examples and exercises in the following GRASS GIS related chapters. It is useful to download
and install the dataset on your computerサンプルデータ).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Visualize the alaska.shp Shapefile (see Section Loading a Shapefile) from the QGIS alaska datasetサ
ンプルデータ.

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Select an existing GRASS database (GISDBASE) folder grassdata or create one for the new LOCATION
using a file manager on your computer. Then click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Adding a new
MAPSET) or to create a new LOCATION altogether. Click on the radio button Create new location (see
figure_grass_location_2).

6. Enter a name for the LOCATION - we used alaska and click [Next].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the projector icon in the lower
right-hand corner of the status bar (see Section投影法の利用方法)).

9. In Filter insert 2964 to select the projection.

10. Click [Next].

11. To define the default region, we have to enter the LOCATION bounds in north, south, east, and west direc-
tion. Here we simply click on the button Set current QGIS extent, to apply the extend of the loaded layer
alaska.shp as the GRASS default region extend.

12. Click [Next].

13. We also need to define a MAPSET within our new LOCATION. You can name it whatever you like - we
used demo (When creating a new LOCATION). GRASS automatically creates a special MAPSET called
PERMANENT designed to store the core data for the project, its default spatial extend and coordinate system
definitions (Neteler & Mitasova 2008文献とWeb参照)

14. Check out the summary to make sure it’s correct and click [Finish].
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15. The new LOCATION alaska and two MAPSETs demo and PERMANENT are created. The currently
opened working set is MAPSET demo, as you defined.

16. Notice that some of the tools in the GRASS toolbar that were disabled are now enabled.

Figure 15.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION alaska is now ready for data import (see section Importing data into a GRASS LOCATION). You
can also use the already existing vector and raster data in the sample GRASS LOCATION alaska included in
the QGIS alaska datasetサンプルデータ and move on to Section The GRASS vector data model.

15.3.2 Adding a new MAPSET

A user has only write access to a GRASS MAPSET he created. This means that besides access to his own MAPSET,
each user can read maps in other user’s MAPSETs, but he can modify or remove only the maps in his own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (Neteler & Mitasova 2008文献とWeb参照, see Section The GRASS region tool).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Select the GRASS database (GISDBASE) folder grassdata with the LOCATION alaska, where we
want to add a further MAPSET, called test.

4. Click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_location_2) and click
[Next].

6. Enter the name text for the new MAPSET. Below in the wizard you see a list of existing MAPSETs and
its owners.

7. Click [Next], check out the summary to make sure it’s all correct and click [Finish].

15.4 Importing data into a GRASS LOCATION

This Section gives an example how to import raster and vector data into the alaskaGRASS LOCATION provided
by the QGIS alaska dataset. Therefore we use a landcover raster map landcover.img and a vector GML File
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lakes.gml from the QGIS alaska datasetサンプルデータ.

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS alaska dataset, as LOCATION alaska,
as MAPSET demo and click [OK].

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section The GRASS toolbox) dialog
appears.

5. To import the raster map landcover.img, click the module r.in.gdal in the Modules Tree tab. This
GRASS module allows to import GDAL supported raster files into a GRASS LOCATION. The module
dialog for r.in.gdal appears.

6. Browse to the folder raster in the QGIS alaska dataset and select the file landcover.img.

7. As raster output name define landcover_grass and click [Run]. In the Output tab you see
the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. When it says Succesfully finished click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. To import the vector GML file lakes.gml, click the module v.in.ogr in the Modules Tree tab. This
GRASS module allows to import OGR supported vector files into a GRASS LOCATION. The module dialog
for v.in.ogr appears.

10. Browse to the folder gml in the QGIS alaska dataset and select the file lakes.gml as OGR file.

11. As vector output name define lakes_grass and click [Run]. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes_grass.

12. When it says Succesfully finished click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

15.5 The GRASS vector data model

It is important to understand the GRASS vector data model prior to digitizing.

In general, GRASS uses a topological vector model.

This means that areas are not represented as closed polygons, but by one or more boundaries. A boundary between
two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be connected and closed
without gaps. An area is identified (and labeled) by the centroid of the area.

Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so called ‘layers’ inside one GRASS vector map.
So in GRASS a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully (Although it is possible to mix geometry elements, it is unusual and even in GRASS only used in special
cases such as vector network analysis. Normally you should prefere to store different geometry elements in
different layers.).

It is possible to store several ‘layers’ in one vector dataset. For example, fields, forests and lakes can be stored in
one vector. Adjacent forest and lake can share the same boundary, but they have separate attribute tables. It is also
possible to attach attributes to boundaries. For example, the boundary between lake and forest is a road, so it can
have a different attribute table.

The ‘layer’ of the feature is defined by ‘layer’ inside GRASS. ‘Layer’ is the number which defines if there are
more than one layer inside the dataset, e.g. if the geometry is forest or lake. For now, it can be only a number, in
the future GRASS will also support names as fields in the user interface.

15.5. The GRASS vector data model 129



QGIS User Guide,リリース 1.8

Attributes can be stored inside the GRASS LOCATION as DBase or SQLITE3 or in external database tables, for
example PostgreSQL, MySQL, Oracle, etc.

Attributes in database tables are linked to geometry elements using a ‘category’ value.

‘Category’ (key, ID) is an integer attached to geometry primitives, and it is used as the link to one key column in
the database table.

ちなみに: Learning the GRASS Vector Model
The best way to learn the GRASS vector model and its capabilities is to download one of the many GRASS
tutorials where the vector model is described more deeply. See http://grass.osgeo.org/gdp/manuals.php for more
information, books and tutorials in several languages.

15.6 Creating a new GRASS vector layer

To create a new GRASS vector layer with the GRASS plugin click the Create new GRASS vector toolbar icon. Enter
a name in the text box and you can start digitizing point, line or polygon geometries, following the procedure
described in Section Digitizing and editing a GRASS vector layer.

In GRASS it is possible to organize all sort of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from Shapefile creation with QGIS, because Shapefiles use the Simple Feature vector model (see
Section Creating a new Vector layer).

ちなみに: Creating an attribute table for a new GRASS vector layer
If you want to assign attributes to your digitized geometry features, make sure to create an attribute table with
columns before you start digitizing (see figure_grass_digitizing_5).

15.7 Digitizing and editing a GRASS vector layer

The digitizing tools for GRASS vector layers are accessed using the Edit GRASS vector layer icon on the toolbar.
Make sure you have loaded a GRASS vector and it is the selected layer in the legend before clicking on the edit
tool. Figure figure_grass_digitizing_2 shows the GRASS edit dialog that is displayed when you click on the edit
tool. The tools and settings are discussed in the following sections.

ちなみに: Digitizing polygons in GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon, setting the mode to ‘No
category’. Then you add a centroid (label point) into the closed boundary, setting the mode to ‘Next not used’.
The reason is, that a topological vector model links attribute information of a polygon always to the centroid and
not to the boundary.

Toolbar

In figure_grass_digitizing_1 you see the GRASS digitizing toolbar icons provided by the
GRASS plugin. Table table_grass_digitizing_1 explains the available functionalities.

Figure 15.3: GRASS Digitizing Toolbar
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Icon Tool Purpose

New Point Digitize new point

New Line Digitize new line

New
Boundary

Digitize new boundary (finish by selecting new tool)

New
Centroid

Digitize new centroid (label existing area)

Move vertex Move one vertex of existing line or boundary and identify new position

Add vertex Add a new vertex to existing line

Delete vertex Delete vertex from existing line (confirm selected vertex by another click)

Move
element

Move selected boundary, line, point or centroid and click on new position

Split line Split an existing line to 2 parts

Delete
element

Delete existing boundary, line, point or centroid (confirm selected element by another
click)

Edit
attributes

Edit attributes of selected element (note that one element can represent more features,
see above)

Close Close session and save current status (rebuilds topology afterwards)

Table GRASS Digitizing 1: GRASS Digitizing Tools

Category Tab

The Category tab allows you to define the way in which the category values will be assigned to a new geometry
element.

Figure 15.4: GRASS Digitizing Category Tab

• Mode: what category value shall be applied to new geometry elements.

– Next not used - apply next not yet used category value to geometry element.

– Manual entry - manually define the category value for the geometry element in the ‘Category’-entry
field.

– No category - Do not apply a category value to the geometry element. This is e.g. used for area
boundaries, because the category values are connected via the centroid.

• Category - A number (ID) is attached to each digitized geometry element. It is used to connect each
geometry element with its attributes.

• Field (layer) - Each geometry element can be connected with several attribute tables using different GRASS
geometry layers. Default layer number is 1.
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ちなみに: Creating an additional GRASS ‘layer’ with QGIS
If you would like to add more layers to your dataset, just add a new number in the ‘Field (layer)’ entry box and
press return. In the Table tab you can create your new table connected to your new layer.

Settings Tab

The Settings tab allows you to set the snapping in screen pixels. The threshold defines at what distance new points
or line ends are snapped to existing nodes. This helps to prevent gaps or dangles between boundaries. The default
is set to 10 pixels.

Figure 15.5: GRASS Digitizing Settings Tab

Symbology Tab

The Symbology tab allows you to view and set symbology and color settings for various geometry types and their
topological status (e.g. closed / opened boundary).

Figure 15.6: GRASS Digitizing Symbolog Tab

Table Tab

The Table tab provides information about the database table for a given ‘layer’. Here you can add new columns to
an existing attribute table, or create a new database table for a new GRASS vector layer (see Section Creating a
new GRASS vector layer).

ちなみに: GRASS Edit Permissions
You must be the owner of the GRASS MAPSET you want to edit. It is impossible to edit data layers in a MAPSET
that is not yours, even if you have write permissions.
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Figure 15.7: GRASS Digitizing Table Tab

15.8 The GRASS region tool

The region definition (setting a spatial working window) in GRASS is important for working with raster layers.
Vector analysis is by default not limited to any defined region definitions. But all newly-created rasters will have
the spatial extension and resolution of the currently defined GRASS region, regardless of their original extension
and resolution. The current GRASS region is stored in the $LOCATION/$MAPSET/WIND file, and it defines
north, south, east and west bounds, number of columns and rows, horizontal and vertical spatial resolution.

It is possible to switch on/off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

With the Edit current GRASS region icon you can open a dialog to change the current region and the symbology of
the GRASS region rectangle in the QGIS canvas. Type in the new region bounds and resolution and click [OK].
It also allows to select a new region interactively with your mouse on the QGIS canvas. Therefore click with the
left mouse button in the QGIS canvas, open a rectangle, close it using the left mouse button again and click [OK].

The GRASS module g.region provide a lot more parameters to define an appropriate region extend and reso-
lution for your raster analysis. You can use these parameters with the GRASS Toolbox, described in Section The
GRASS toolbox.

15.9 The GRASS toolbox

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS toolbox you need to open a LOCATION and MAPSET where you
have write-permission (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.

The GRASS Shell inside the GRASS Toolbox provides access to almost all (more than 330) GRASS modules
through a command line interface. To offer a more user friendly working environment, about 200 of the available
GRASS modules and functionalities are also provided by graphical dialogs within the GRASS plugin Toolbox.

15.9.1 Working with GRASS modules

The GRASS Shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 1.8.0 is available in the
GRASS wiki ( http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list).
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Figure 15.8: GRASS Toolbox and Module Tree

It is also possible to customize the GRASS Toolbox content. This procedure is described in Section Customizing
the GRASS Toolbox.

As shown in figure_grass_toolbox_1 , you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.

Clicking on a graphical module icon a new tab will be added to the toolbox dialog providing three new sub-tabs
Options, Output and Manual.

Options

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module specific parameters to run the module.

The provided module parameters are often not complete to keep the dialog clear. If you want to use further module
parameters and flags, you need to start the GRASS Shell and run the module in the command line.

A new feature in QGIS 1.8.0 is the support for a show advanced options button below the simplified module dialog
in the Options tab. At the moment it is only added to the module v.in.ascii as an example use, but will probably
be part of more / all modules in the GRASS toolbox in future versions of QGIS. This allows to use the complete
GRASS module options without the need to switch to the GRASS Shell.

Output

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manual

The Manual tab shows the HTML help page of the GRASS module. You can use it to check further module
parameters and flags or to get a deeper knowledge about the purpose of the module. At the end of each module
manual page you see further links to the Main Help index, the Thematic index and the Full index.
These links provide the same information as if you use the module g.manual.

ちなみに: Display results immediately
If you want to display your calculation results immediately in your map canvas, you can use the ‘View Output’
button at the bottom of the module tab.

15.9.2 GRASS module examples

The following examples will demonstrate the power of some of the GRASS modules.
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Figure 15.9: GRASS Toolbox Module Options

Figure 15.10: GRASS Toolbox Module Output
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Figure 15.11: GRASS Toolbox Module Manual

Creating contour lines

The first example creates a vector contour map from an elevation raster (DEM). Assuming you have the Alaska
LOCATION set up as explained in Section Importing data into a GRASS LOCATION.

• First open the location by clicking the Open mapset button and choosing the Alaska location.

• Now load the gtopo30 elevation raster by clicking Add GRASS raster layer and selecting the gtopo30
raster from the demo location.

• Now open the Toolbox with the Open GRASS tools button.

• In the list of tool categories double click Raster → Surface Management → Generate vector contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above Working with GRASS
modules. The gtopo30 raster should appear as the Name of input raster.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Type into the Name for output vector map the name ctour_100.

• Click [Run] to start the process. Wait for several moments until the message Successfully finished
appears in the output window. Then click [View Output] and [close].

Since this is a large region, it will take a while to display. After it finishes rendering, you can open the layer
properties window to change the line color so that the contours appear clearly over the elevation raster, as inベク
タプロパティダイアログ.

Next zoom in to a small mountainous area in the center of Alaska. Zooming in close you will notice that the
contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps while keeping their
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overall shape. The tool uses several different algorithms with different purposes. Some of the algorithms (i.e.
Douglas Peuker and Vertex reduction) simplify the line by removing some of the vertices. The resulting vector
will load faster. This process will be used when you have a highly detailed vector, but you are creating a very
small scale map, so the detail is unnecessary.

ちなみに: The simplify tool
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms there is Chaikens which does just that (also Hermite
splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even more
slowly.

• Open the GRASS toolbox and double click the categories Vector → Develop map → Generalization, then
click on the v.generalize module to open its options window.

• Check that the ‘ctour_100’ vector appears as the Name of input vector.

• From the list of algorithms choose Chaiken’s. Leave all other options at their default, and scroll down to the
last row to enter in the field Name for output vector map ‘ctour_100_smooth’, and click [Run].

• The process takes several moments. Once Successfully finished appears in the output windows,
click [View output] and then [close].

• You may change the color of the vector to display it clearly on the raster background and to contrast with
the original contour lines. You will notice that the new contour lines have smoother corners than the original
while staying faithful to the original overall shape.

Figure 15.12: GRASS module v.generalize to smooth a vector map

ちなみに: Other uses for r.contour
The procedure described above can be used in other equivalent situations. If you have a raster map of precipitation
data, for example, then the same method will be used to create a vector map of isohyetal (constant rainfall) lines.
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Creating a Hillshade 3D effect

Several methods are used to display elevation layers and give a 3D effect to maps. The use of contour lines as
shown above is one popular method often chosen to produce topographic maps. Another way to display a 3D
effect is by hillshading. The hillshade effect is created from a DEM (elevation) raster by first calculating the slope
and aspect of each cell, then simulating the sun’s position in the sky and giving a reflectance value to each cell.
Thus you get sun facing slopes lighted and the slopes facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS toolbox and under the
Raster category double click to open Spatial analysis → Terrain analysis.

• Then click r.shaded.relief to open the module.

• Change the azimuth angle 270 to 315.

• Enter gtopo30_shade for the new hillshade raster, and click [Run].

• When the process completes, add the hillshade raster to the map. You should see it displayed in grayscale.

• To view both the hill shading and the colors of the gtopo30 together shift the hillshade map below the
gtopo30 map in the table of contents, then open the Properties window of gtopo30, switch to the
transparency tab and set its transparency level to about 25%.

You should now have the gtopo30 elevation with its colormap and transparency setting displayed above the
grayscale hillshade map. In order to see the visual effects of the hillshading, turn off the gtopo30_shade map,
then turn it back on.

Using the GRASS shell

The GRASS plugin in QGIS is designed for users who are new to GRASS, and not familiar with all the modules
and options. As such, some modules in the toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the toolbox tree, and also to some additional options to the modules that are in the toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

Figure 15.13: The GRASS shell, r.shaded.relief module

The module r.shaded.relief can take a parameter zmult which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.

• Load the gtopo30 elevation raster as above, then start the GRASS toolbox and click on the
GRASS shell. In the shell window type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press [Enter].
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• After the process finishes shift to the Browse tab and double click on the new gtopo30_shade2 raster to
display in QGIS.

• As explained above, shift the shaded relief raster below the gtopo30 raster in the Table of Contents, then
check transparency of the colored gtopo30 layer. You should see that the 3D effect stands out more strongly
compared to the first shaded relief map.

Figure 15.14: Displaying shaded relief created with the GRASS module r.shaded.relief

Raster statistics in a vector map

The next example shows how a GRASS module can aggregate raster data and add columns of statistics for each
polygon in a vector map.

• Again using the Alaska data, refer to Importing data into a GRASS LOCATION to import the trees shapefile
from the shapefiles directory into GRASS.

• Now an intermediary step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).

• From the toolbox choose Vector → Manage features, and open the module v.centroids.

• Enter as the output vector map ‘forest_areas’ and run the module.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed -

in different colors: In the layer Properties window, Symbology tab, choose from Legend type
‘Unique value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology
tab :ref:sec_symbology in the vector section).

• Next reopen the GRASS toolbox and open Vector → Vector update by other maps.

• Click on the v.rast.stats module. Enter gtopo30, and forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click [run]. This is a computa-
tionally heavy operation which will run for a long time (probably up to two hours).

• Finally open the forest_areas attribute table, and verify that several new columns have been added
including elev_min, elev_max, elev_mean etc. for each forest polygon.
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15.9.3 Working with the GRASS LOCATION browser

Another useful feature inside the GRASS Toolbox is the GRASS LOCATION browser. In figure_grass_module_7
you can see the current working LOCATION with its MAPSETs.

In the left browser windows you can browse through all MAPSETs inside the current LOCATION. The right
browser window shows some meta information for selected raster or vector layers, e.g. resolution, bounding box,
data source, connected attribute table for vector data and a command history.

Figure 15.15: GRASS LOCATION browser

The toolbar inside the Browser tab offers following tools to manage the selected LOCATION:

• Add selected map to canvas

• Copy selected map

• Rename selected map

• Delete selected map

• Set current region to selected map

• Refresh browser window

The Rename selected map and Delete selected map only work with maps inside your currently selected
MAPSET. All other tools also work with raster and vector layers in another MAPSET.

15.9.4 Customizing the GRASS Toolbox

Nearly all GRASS modules can be added to the GRASS toolbox. A XML interface is provided to parse the pretty
simple XML files which configures the modules appearance and parameters inside the toolbox.

A sample XML file for generating the module v.buffer (v.buffer.qgm) looks like this:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
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<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the toolbox when you select the module. A more
detailed description for adding new modules, changing the modules group, etc. can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox
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Chapter 16

オープンストリートマップ

近年,オープンストリートマップ（OpenStreetMap: OSM）プロジェクトが人気を集めています. 多くの国で
は,自由に利用できる地図データが無いからです. OSMプロジェクトの目的は, GPSデータ,航空写真,そし
て編集者自身が持つ知識を利用して,自由に編集可能な世界地図を作成することです. これをサポートする
ために, QGISでは OSMデータと連携するプラグインを提供しています.

QGISのコアプラグインである OSMプラグインは, OSMデータを扱うための基本機能を提供します. 具体
的には,データの読み込み,インポート,保存,ダウンロード,編集, OSMサーバへのアップロードです. 実装
においては,既存の OSMエディタを参考にしました. 既存 OSMエディタの機能を取り入れることで,最も
良い結果がもたらされると考えました.

次のセクションは, OSMプロジェクトの理念に関する概要紹介です.

いくつかの段落は, OpenStreetMapのWEBサイト http://www.openstreetmap.orgからコピーしたものです.

16.1 オープンストリートマップ（OSM）プロジェクト

オープンストリートマップは,自由に編集可能な世界地図を作るプロジェクトです. 地図は,ポータブルGPS
デバイス,航空写真などの著作権フリーのソース,もしくは単純に編集者自身の地域に関する知識から作成
されます. このプロジェクトがスタートしたのは,一般的な地図のほとんどが利用にあたって法的もしくは
技術的な制約があり, 創造的利用, 生産的利用や予想外の利用が制限されているためです. OSMの描画イ
メージとベクタデータセットはいずれも, Creative Commons Attribution ShareAlike 2.0ライセンスのもとダ
ウンロードできます.

オープンストリートマップは, Wikipediaのようなサイトに触発されました. 地図の表示 (図_OpenStreetMap_1
参照)では「編集」タブが特徴的で,リビジョンの履歴が全て保持されています. 登録ユーザは GPSトラッ
クログをアップロードでき,編集ツールを使ってベクタデータの編集を行うことができます.

OSMデータの大本は, APIによってサーバに保存できるオブジェクトクラスです. サポートされるデータ
は,ノード,ウェイ, **リレーション**の 3種類です.

• **ノード（node）**は,緯度/経度の座標です. 他の地物をつくるためのブロックであったり,地物その
もの (Points Of Interest: POI)であったりします. タグは必要に応じて付けられます.

• **ウェイ（way）**は, 2個以上のノードの組合わせで,道路をはじめとした線形の地物を表現します.
同じノードを複数のウェイに用いることができます.

• **リレーション（relation）**は,ロールと結びついたゼロまたはそれ以上のプリミティブのグループ
です. オブジェクト間の関係を定義する場合に指定します. 抽象オブジェクトを作る場合もあります.

一般的な地図にあるさまざまな地物（POI,道路,鉄道,バス停など)は,これらのプリミティブによって定義
されます. 地図の地物は OSMコミュニティの中では周知のもので,キーと値を利用したタグとして保存さ
れます. OSMは通常, XML形式で配布されます. XMLペイロードは OSMサーバーとの通信にも利用され
ています.
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Figure 16.1: OpenStreetMap data in the web

16.2 QGIS-OSMの接続

このセクションの最初のパートでは, OSMプリミティブが QGISのベクタレイヤでどのように表示される
かを説明します. 上記のように, OSMデータはノード,ウェイ,リレーションで構成されています. QGISで
は,ポイントレイヤ,ラインレイヤ,ポリゴンレイヤの 3種類の異なるレイヤタイプで表示されます. これら
のレイヤはどれも必要ですし,さらに別のレイヤが加わることもありません.

• **ポイント（Point）レイヤ**は,単独のノードタイプの地物を表示します. ウェイに属していないノー
ドはすべてポイントレイヤに属することになります.

• **ライン（Line）レイヤ**は,閉じていないウェイタイプの OSM地物を表示します. 閉じていないと
は,ウェイの始点と終点が異なるノードであるということです.

• **ポリゴン（Polygon）レイヤ**は,ラインレイヤに含まれないすべてのウェイを表示します.

上記の３つに加え、オープンストリートマップはもう１つのプリミティブを持っています。これをリレー
ションと呼びます。リレーションを示すためのベクタレイヤーは意図的には用意されていません。リレー
ションは任意の数のデータ・プリミティブを接続するために定義されます。ポイント、ライン、ポリゴン
が地図上で特定された後、プラグインは、すべてのリレーションのリストを表示します。

これは、OSMのデータと標準的な QGISの編集ツールとの関係をデザインすることを試みていました。ど
のような地物タイプであるかにかかわらず、これらのツールは一度に１つのベクタレイヤーを編集します。
これは、OSMデータがプラグインを通してQGISにロードされる場合、（理論的には）個別にこれらのツー
ルを使って、ポイントレイヤー、ラインレイヤー、ポリゴンレイヤーを編集できることを意味します。

ラインレイヤーは、ウェイトノードという異なる２つのタイプの OSM フィーチャで構成されています。
OSMフォーマットでは、ウェイはノードで構成されます。もしあなたがラインの形状を変えるためにライ
ンレイヤーの編集を開始するなら、あなたのアクションはOSMのウェイだけでなく、その一部であるOSM
のノードだけにも影響します。

QGIS標準の編集ツールは、OSMのプロバイダー、およびどのラインがどのように変更されたかを見分け
ることはできません。これは、どのラインが新しいジオメトリかということを見分けるだけで、OSMデー
タベースに対する変更を正しく伝えるには十分ではありません。ラインレイヤーはラインメンバーの識別
子を知りません。同様の問題は、あなたがポリゴンレイヤーを編集しようとする際にも発生します。
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この理由として、OSMプラグインは OSMデータを編集するための、それ自身のツールが必要です。それ
を使用すると、OSMレイヤは正しく変更されます。編集ツールのプラグインは、ポイント、ライン、ポリ
ゴン、そしてリレーションの作図や削除、移動をするためのツールで構成されます。

ノート: OSMプラグインと標準の編集ツールをリンクするには、QGISコアコードの変更が必要であろう。

16.3 インストール

OpenStreetMapプラグインは QGIS内部のコアプラグインです。ref:‘load_core_plugin‘のセクションで記載
されている通り、その ‘OpenStreetMap’プラグインは、プラグインマネージャで選択出来ます。

16.4 基本的なユーザインタフェース

The first time the OSM plugin is started (and after the first data are loaded), several new OSM plugin icons appear
in the QGIS toolbar menu together with new dock windows as shown in figure_OpenStreetMap_2.

Figure 16.2: OSM plugin user interface

16.4.1 OSMフィーチャーウィジェット

OSMフィーチャーウィジェットは OSMの地物を識別するのに役立ちます。誰によっていつ地物が変更さ
れたかの情報だけでなく、フィーチャータイプや識別子の基礎情報を表示します。OSMフィーチャーウィ
ジェットは、すべての編集ツールを（それの上の部分で）用意されています。これらのツールの詳細につ
いては、以下のセクションで見つけることができます。ウィジェットは最初は無効になっています。OSM
データのロードに成功した後、ウィジェットは有効になります。

16.4.2 OSM Undo/Redoウィジェット

この Undo/Redoウィジェットは編集行為を元に戻す処理と繰り返す処理を行うために使われます。これは
典型的な Undoと Redoのボタンのみで構成されているのではなく、行った編集処理の簡潔な説明もリスト
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表示します。OSM Undo/Redoウィジェットは初期設定では非表示ですが、OSMフィーチャーウィジェット
ボタンを使うことで表示できます。

16.4.3 ツールバーのメニューアイコン

:sup:‘Load OSM from file‘は特定の Opeｎ StreetMap XMLからデータをロードするために使われます。

Show/Hide OSM Feature Manager はOSMフィーチャーウィジェットの表示・非表示を切り替えるために使用され
ます。OSMフィーチャーウィジェットは OSMの地物の特定や OSMのデータ編集を補助するためのパネル
です。

Download OSM data は Opeｎ StreetMapサーバーよりデータをダウンロードする際に使用されます。

:sup:‘Upload OSM data‘は（現状のデータでの）変更をアップロードする際に使用されます。

Import data from a layer はベクタレイヤーからデータをインポートする際に使用されます。少なくとも１つの
ベクタレイヤーがロードされ、現状の OSMデータが選択されます。

Save OSM to file は OSMデータを XMLファイルに戻してから保存する際に使用されます。

すべてのウィジェット、ボタン、ダイアログの詳細については、これらの機能（編集、識別など）に応じ
て、このプラグインの適切なセクションで見つけることができます。

16.5 OSMデータの読み込み

OSMプラグインの開始後にされるべき最初のアクションとしては、OSMファイルからデータを開くこと
です。OSMデータは Shapeファイルとしてインポートされるか、OpenStreetMapサーバーから直接ダウン
ロードします。ここでは、前者の方法に焦点を当てます。

To load data from a file use the Load OSM from file icon. If there is no such button, maybe someone disabled
OpenStreetMap toolbar in your QGIS installation. You can enable it again selecting Settings → Toolbars →
OpenStreetMap.

Figure 16.3: Load OSM data dialog

その要素の目的について説明します。

OpenStreetMap file to load: Click on the button to select the file:.osm file you want to load data from.
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Add columns for tags: このオプションは OSMと QGISデータの接続を決定します。OSMデータの書く要
素はいくつかのタグ（キーと値の組み合わせ）を持っていて、地物の属性を定義しています。QGISベク
ターレイヤーの各地物もまた、その属性（キーと値）を持っています。このオプションで、QGISの地物の
詳細情報をいつ表示し、OSMオブジェクトのどの属性を表示するかを定義することができます。

Replace current data: このオプションのチェックは、新しいデータと、ユーザが作業した現状のデータを
置き換えるかを意味します。現状データのレイヤーは削除され、新しいデータがロードされます。最初に
OSMデータをロードする際は置き換え対象がないため、このオプションはアクティブではありません。

Use custom renderer: This option determines how many details of the map will be used. There are three pre-
defined OSM styles for map displaying. Use ‘Small scale’ if you want to view OSM data at low level, to see all
details and to edit something. If not you can use ‘Medium scale’ or ‘Large scale’. QGIS 1.8.0 doesn’t support
changing the renderer style dynamically.

データを読み込むには**[OK]**をクリックします。初めて OSMファイルがロードされる場合は、プラグ
インは初めてデータベースを解析するに違いありません。これには数秒か数分かかると思いますが、それ
はロードするデータ量に依ります。

16.6 OSMデータの表示

OSMデータをロードした後、適切なツールを使ってマップの地物を特定することができます。OSMフィー
チャーウィジェットの左上にある|osm_identify| Identify feature ボタンを使用します。このツールを使うと、すべ
てのマップオブジェクトを簡単に調べることができます。マウスカーソルをオブジェクト上に配置すると、
OSMフィーチャーウィジェットで直接、そのオブジェクトすべての情報を表示できます。マップ上には動
的なラバーバンドが表示されるため、ユーザは、どの地物が現在識別されているかを決定することができ
ます。

ウィジェットの guilabel:‘Properties‘タブでは、地物のタグすべてが含まれています。guilabel:‘Relation‘タブ
では特定の地物を接続するリレーションのリストが表示されます。

そのプロパティとリレーションを読み込むためにしばらくの間機能を停止するには、同時にマウスカーソ
ルを移動して、地物上で左クリックします。特定プロセスは、次に左クリックするまでの間停止します。

左クリックが行われた時、その地点に複数のちぶつがある場合がある。これは特に、交差点をクリックし
た　場合やマップを十分にズームしないで行った場合に起こる。この状況では１つの地物のみが識別され
る（ラバーバンドが付けられる）。しかし、プラグインはそれらすべてを記憶している。その後（一時停止
モード）は、右クリックで、識別された地物を循環閲覧できる。

16.7 基礎的なOSMデータの編集

‘Basic data’ in this context means non-relational OSM features - nodes and ways. If you prefer to examine how
to perform relational editing, skip this section and move on to the next one.

基礎データの編集は OSMプラグインの重要な部分です。プロパティや、いかなる基礎の地物の位置や形状
を変更することができます。地物の削除または追加ができます。ノードとウェイに対するすべての変更内容
は、Undo/Redoによって記憶され、すべての変更は OpenStreetMapサーバにすぐにアップロードされます。

16.7.1 地物のタグの変更

OSM地物のプロパティ/タグの変更はテーブルの地物タグで直接行うことができます。基本的な地物のタ
グテーブルは OSMフィーチャーウィジェットで見つけることができます。最初に地物を特定することを忘
れないでください。

If you want to change a tag value, just double-click in the appropriate row of column ‘Value’ and type, or select a

new value. If you want to remove a tag, click in the relevant row, then use the button Remove selected tags on the
right bottom under the table.
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Figure 16.4: Changing an OSM feature tag

新しいタグを追加するには、 ‘<next tag value>’と書かれたテーブルの最終行にキーと値をタイプします。
存在しているタグのペアのキーを編集できないことに注意してください。便利なことに、すべての既存の
タグキーと典型的な値のコンボボックスがあります。

16.7.2 点の作図

ポイントを作図するには、OSMフィーチャーウィジェット上にある|osm_createPoint| :sup:‘点の作成 ‘ボタ
ンを使用します。いくつかのポイントを作図するには、そのボタンをクリックし、マップ上のクリックを
開始します。いくつかの地図の地物にマウスカーソルを配置すると、その地物が直ちにマーク/識別されま
す。ラインまたはポリゴンがマークされ地図上をクリックすると、そのラインまたはポリゴンに、それら
の新規メンバーとして、直接的に新しいポイントが作成されます。このような場合、OSMプラグインは、
次のメッセージを表示します：

Figure 16.5: OSM point creation message

ラインまたはポリゴンをヒットするためにユーザーを助ける仕組みはスナップと呼ばれ、デフォルトで有効と
なってます。ラインの非常に近く（ただしライン上ではない）に点を作成したい場合は、最初に kbd:‘Ctrl‘キー
を押すことでスナップを無効にしなければいけません。
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16.7.3 ラインの作図

ラインを作図するには、OSMフィーチャーウィジェットの :sup:‘線の作成 ‘ボタンを使用します。ライ
ンを作成するためそのボタンをクリックし、マップ上の左クリックを開始します。それぞれの左クリック
は新しいラインの頂点として記憶されています。初めて右クリックするとラインの作図が終了します。新
しいラインは直ちにマップ上に表示されます。

ノート: A Line with less than two members cannot be created. In such case the operation is ignored.

スナップは地図上のすべての頂点-ポイントベクターレイヤ由来のポイントとすべてのラインおよびポリゴ
ンのメンバーに対して実行されます。スナップは、kbd:‘Ctrl‘キーを押すことで無効にすることができます。

16.7.4 ポリゴンの作図

ポ リ ゴ ン を 作 成 す る に は 、OSM フィー チャー ウィジェット 上 の|osm_createPolygon|
Create polygon‘ボタンを使用します。ポリゴンを作成するためにこのボタンをボタンをクリックし、マップ上で左クリックを開始します。それぞれの左クリックが、新しいポリゴンのメンバーとなる頂点として記憶されます。初めて右クリックするとポリゴンの作図が終了します。新しいポリゴンは直ちにマップ上に表示されます。３つ未満のメンバーで構成されたポリゴンを作成することはできません。そのような場合、操作が無視されます。スナップはマップ上の頂点すべて-点（ポイントベクターレイヤ由来）やすべてのラインおよびラインのメンバーに対して行われます。スナップは kbd:‘Ctrl

キーを押すことで無効にできます。

16.7.5 マップ上の地物の移動

もし（種類に関係なく）地物を異動したい場合は、OSM地物ウィジェットメニューの|osm_move| Move feature

ボタンを使用してください。それからマップ（あなたがそれを繰り返し行うとき、地物が動的に特定され
る）を表示することができ、移動したい地物をクリックすることができます。適切な地物が特定されるま
で、右クリックを繰り返してください。選択が完了しカーソルを移動すると、何を移動するかを変更する
ことはできません。移動を確認するには、マウスの左ボタンをクリックしてください。移動をキャンセル
するには、別のマウスボタンをクリックします。

別の地物に接続している地物を移動する場合、これらの接続が損傷することはありません。他の地物は、移
動した地物の新しい位置に適応するのみです。

スナップはこの操作においてもサポートされています。これは以下を意味します。

• 単体のポイント（ライン/ポリゴンの一部でないもの）を移動する場合、マップのセグメントと頂点
すべてに対するスナップが行われる。

• ライン/ポリゴンのメンバーであるポイントを移動する場合、ポイントの親の頂点は除くすべてのマッ
プセグメントと頂点に対してスナップが行われる。

• ライン/ポリゴンを移動する場合、すべてのマップの頂点に対してスナップが行われます。OSMプラ
グインは、移動したライン/ポリゴンの持つカーソルに近接した３つの頂点に対してのみスナップを
試みる点にご注意ください。そうでないと動作が非常に遅くなります。操作中に kbd:Ctrlキーを押す
ことでスナップを無効にすることができます。

16.7.6 マップの地物の移動

地物を削除したい場合は、まずそれを特定する必要があります。特定した地物を削除するには OSM地物
ウィジェットの|osm_removeFeat| :sup:‘この地物の削除 ‘ボタンを使用します。ライン/ポリゴンを削除する
と、それ自身のメンバーであって、他のライン/ポリゴンに属していないポイントもすべて削除されます。

ライン/ポリゴンのメンバーであるポイントを削除すると、ポイントが削除され、親であるライン/ポリゴン
の形状は変更されます。新しい親の形状は、古いものよりも頂点が少なくなっています。

もし親地物が３つの頂点を持つポリゴンであれば、その新しい形状は、２つの頂点しか持ちません。２つ
の頂点しか持たないポリゴンは存在し得ないため前述のとおり、その地物タイプは自動的にラインに変更
されます。

もし親地物が２つの頂点を持つラインであれば、新しい形状は１つの頂点しか持ちません。１つのみの頂
点で構成されたラインは存在し得ないため、地物タイプが自動的にポイントに変更されます。
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16.8 リレーションの編集

OSMリレーションが存在するおかげで、グループに OSMの地物を結合し、それらに共通のプロパティを
付与することができます。そのような方法で、地域の境界（ウェイやポイントのグループとして）、バス
ルート等など、私たちは任意のマップオブジェクトをモデル化することができます。リレーションの各メ
ンバーはそれ特有のロールを持ちます。我々のプラグインでは、OSMリレーションに取ってかなり良いサ
ポートがあります。それらをどのように分析し、作成し、更新または削除するか見てみましょう。

16.8.1 リレーションの分析

もしリレーションの属性を参照したいなら、メンバーの１つを特定しましょう。それから、OSM地物ウィ
ジェットの guilabel:‘リレーション ‘タブを表示します。タブの上部で、特定された地物を含むすべてのリ
レーションがリスト表示されます。分析したい１つを選択すると、その情報が下に表示されます。１つ目
のテーブルは’リレーションタグ’と呼ばれ、選択したリレーションの属性を見つけることができます。１
つのメンバーをクリックすると、プラグインは、地図上にラバーバンドを作成します。

16.8.2 リレーションの作成

リレーションの作成方法は２つあります：

1. OSM地物ウィジェットの|osm_createRelation|:sup:‘リレーションの作成 ‘ボタンを使用することができ
ます。

2. OSM地物ウィジェットの guilabel:‘リレーション ‘タブにある|osm_addRelation|:sup:‘リレーションの追
加 ‘ボタンを使用することで、リレーションを作成することができます。

どちらの場合も、ダイアログが表示されます。第二のケースでは、現在特定された地物が自動的に最初の
リレーションメンバーと見なされ、ダイアログでは少々事前入力がなされます。リレーションを作成する
際、そのタイプを選択してください。定義済のリレーションの種類または独自のタイプを記載することが
できます。それからリレーションタグを埋めたりメンバーを選択します。

すでにリレーションのタイプを選択した場合は、 タグの作成 ‘ボタンを使用してください。それにより、リレーションのタイプにとって典型的なタグを生成できます。それから、キーに値を入力することが期待されます。リレーションメンバーの選択はメンバー識別子やタイプ、ロールを書くことか、|osm_identify| :sup:‘地図上でメンバーの選択

ツールを使用してマップ場をクリックすることにより可能です。

タイプ、タグ、メンバーを選択したら、ダイアログの内容を確定できるようになります。その場合、プラグ
インは新しいリレーションを作成します。

16.8.3 リレーションの変更

既存のリレーションを辺既往するには、まずそれを選択します（上記の ref:‘examining_relation‘のセクショ
ンに記載されたステップにしたがってください）。その後|osm_editRelation| :sup:‘リレーションの編集 ‘ボタ
ンをクリックします。それは、OSM地物ウィジェット上にあります。ダイアログが表示されると、 ‘リレー
ションの作成’とほぼ同様でしょう。そのダイアログでは、与えられたリレーションの情報があらかじめ入
力されています。あなたはリレーション、メンバーとそのタイプのタグを変更できます。ダイアログの内
容を確定すると、変更内容がコミットされます。

16.9 OSMデータのダウンロード

To download data from OpenStreetMap server click on the Download OSM data button. If there is no such button,
the OSM toolbar may be disabled in your QGIS instalation. You can enable it again at Settings → Toolbars →
OpenStreetMap . After clicking the button a dialog occurs and provides following functionalities:

範囲：緯度と経度度の間隔からデータをダウンロードする領域を指定します。OpenStreetMapのサーバー上
でダウンロード可能なデータ量の制限があるため、間隔を広げすぎてはいけません。領域の仕様における
より詳細な情報は、右側の|osm_questionMark| :sup:‘ヘルプ ‘ボタンをクリックした後に表示されます。
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Figure 16.6: OSM download dialog

ダウンロード先：ここでは、データが格納されるファイルのパスを記述することが期待されています。あ
なたのディスクの構造を思い出せない場合は、パニックにならないでください。参照ボタン| browsebutton|
があなたを助けるでしょう。

ダウンロード後に自動的にデータを開く：ダウンロードプロセス後にデータのロード処理をを行うかどう

かを決定します。データをロードしたくない場合は、 :sup:‘Load OSM from file‘ボタンを使用して、後
からロードします。

カレントデータの置き換え：このオプションは|radiobuttonon| :guilabel:‘ダウンロード後自動的にデータを開
く ‘にチェックが入っている場合のみ有効です。このオプションにチェックを入れるとダウンロードデータ
が、現在作業しているデータと置き換えられます。現在のデータのレイヤは削除され、新しいものがロー
ドされます。QGISを起動して初めて OSMデータをダウンロードする場合、置き換え対象がないため、こ
のオプションは非アクティブです。

Use custom renderer: This option is active only if the Open data automatically after download checkbox
is checked. It determines how many details will be in the map. There are three predefined OSM styles for map
displaying. Use ‘Small scale’ if you want to view OSM data at low level, to see all details and to edit something.
If not you can use ‘Medium scale’ or ‘Large scale’. QGIS 1.8.0 does not support changing the renderer style
dynamically.

ダウンロード処理を開始するには **[Download]**ボタンをクリックします。

プログレスダイアログが、すでにダウンロードされたデータがどれくらいあるかを継続的に知らせます。ダ
ウンロードプロセス中にエラーが発生した場合、ダイアログが原因を知らせます。アクションが正常に終
了すると、プログレスダイアログとダウンロードダイアログの両方が閉じられます。

16.10 OSMデータのアップロード

Note that the upload is always done on current OSM data. Before opening the OSM Upload dialog, please be sure
that you really have the right active layer with OSM data.

To upload current data to the OSM server click on the Upload OSM data button. If there is no such button, OSM
toolbar in your QGIS installation is disabled. You can enable it again in Settings → Toolbars → OpenStreetMap .
After clicking the [Upload] button a new dialog will appear.

正しいデータをアップロードする場合は、ダイアログの上部でチェックすることができます。現在のデータ
ベースの短い名前があります。テーブルでは、どのくらいの変更がアップロードされるかの情報を見つけ
ます。統計情報は、各地物の種類ごとに個別に表示されます。
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Figure 16.7: OSM upload dialog

‘あなたの変更についてのコメント’ボックスには、アップロード操作の意味について簡単な情報を書き込
むことができます。ちょっと手短に言えば、データに何の変更を行ったかを書くか、ボックスを空にしてお
いてください。サーバがあなたを認証できるように’OSMアカウント’の列を埋めてください。もし OSM
サーバーにアカウントを持っていない場合、 http://www.openstreetmap.orgで作成するのには最高の時です。
最終的に**[アップロード]**を使用してアップロード操作を開始します。

16.11 OSMデータの保存

To save data from a current map extent to an XML file click on the Save OSM to file button. If there is no such
button, the OSM toolbar in your QuantumGIS installation is probably disabled. You can enable it again in Settings
→ Toolbars → OpenStreetMap. After clicking on the button a new dialog appears.

Figure 16.8: OSM saving dialog
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XMLファイルとファイル自体に保存したい地物を選択します。 **[OK]**ボタンを使用して操作を開始し
ます。そのプロセスで、カレントのマップ領域で表現された OSMデータを XMLファイルとして作成しま
す。出力ファイルの OSMバージョンは 0.6です。OSMデータの要素 (<node>, <way>, <relation>)は、その
変更セットと uidの情報を含みません。この情報はまだ必須のものではなく、OSM XMLバージョン 0.6の
DTDを参照してください。出力ファイルでは OSMの要素が順序付けされていません。

現在の範囲外のデータも保存されていることに注意してください。それらのほんの一部が現在の範囲に表
示されている場合でも、それら全体のポリゴンや線が出力ファイルに保存されます。保存されたライン/ポ
リゴンとそのメンバーであるノードすべても同様に保存されます。

16.12 OSMデータのインポート

To import OSM data from an opened non-OSM vector layer follow this instructions. Choose current OSM data

by clicking on one of their layers. Click on the Import data from a layer button. If there is no such button, someone
has probably disabled the OpenStreetMap toolbar in your QGIS installation. You can enable it again in Settings
→ Toolbars → OpenStreetMap.

そのボタンをクリック後に、以下のメッセージが表示されるでしょう：

Figure 16.9: OSM import message dialog

In such case there is no vector layer currently loaded. The import must be done from a loaded layer - please load a
vector layer from which you want to import data. After a layer is opened, your second try should give you a better
result (don’t forget to mark the current OSM layer again):

Figure 16.10: Import data to OSM dialog

OSMデータのインポート処理を開始するにはサブミットダイアログを使用します。あなたが何かをイン
ポートしたいかわからない場合、それを拒否します。
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Chapter 17

SEXTANTE

17.1 はじめに

この章では、QGISにおいて強力な地理的分析のフレームワークである SEXTANTEについて紹介します。
SEXTANTEは QGISからネイティブかつサードパーティのアルゴリズムを呼び出すために使われるジオプ
ロセシング環境です。それにより、空間分析がより生産的に、簡単に達成できるようにします。

次のセクションでは、 SEXTANTEのグラフィカルな要素を使用し、それらの各々を最大限に活用する方法
についてレビューします。

17.1.1 Basic elements of the SEXTANTE GUI

There are four basic elements in the SEXTANTE GUI, which are used to run SEXTANTE algorithms for different
purposes. Choosing one tool or another will depend on the kind of analysis that is to be performed and the
particular characteristics of each user and project. All of them (except for the batch processing interface, which is
called from the toolbox, as we will see) can be accessed from the SEXTANTE menu item (you will see more than
four entries. The remaining ones are not used to execute algorithms and will be explained later in this chapter).

• SEXTANTEツールボックス。SEXTANTE GUIの主な要素は、単一のアルゴリズムを実行するか、そ
のアルゴリズムに基づいてバッチプロセスを実行するために使用される。

Figure 17.1: SEXTANTE Toolbox

• SEXTANTE graphical modeler。いくつかのアルゴリズムをグラフィカルサブプロセスのいくつかを伴
う単一のプロセスを作成し、ワークフローを定義するために、modelerを使用して組み合わせること
ができます。
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Figure 17.2: SEXTANTE Models

• SEXTANTE履歴マネージャ。前述の要素のいずれかを用いて実行されたすべてのアクションが履歴
ファイルに保存され、後で簡単に履歴マネージャを使用して再生することができる。

Figure 17.3: SEXTANTE History

• SEXTANTEバッチプロセシングインタフェースマネージャ。このインタフェースを使用すると、バッ
チ処理を実行し、複数のデータセットに対し単一のアルゴリズムの実行を自動化することができます。

次のセクションに沿って我々は詳細に、この要素のそれぞれをレビューします。

17.2 SEXTANTE toolbox

17.2.1 イントロダクション

Toolboxは SEXTANTE GUIの主な要素であり、最も日常業務で使用できそうなものの１つです。それは異
なったブロックにグループ化されたすべての使用可能なアルゴリズムのリストを示しており、単一のプロ
セスとして、または入力の異なるセットで同じアルゴリズムのいくつかの実行を伴うバッチ処理のように
するかどうか、それらを実行するためのアクセスポイントです。
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Figure 17.4: SEXTANTE Batch Processing

Figure 17.5: SEXTANTE Toolbox
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The toolbox contains all the algorithms available, divided into groups. Each group represents a so-called ‘algo-
rithm provider’, which is a set of algorithms coming from the same source, for instance, from a third-party ap-
plication with geoprocessing capabilities. Some of this groups represent algorithms from one of such third-party
applications (like SAGA, GRASS or R), while other contain algorithms directly coded along with SEXTANTE
elements, not relying on any additional software. Currently, these providers all reuse code from already exist-
ing QGIS plugins (more specifically, from the fTools vector library shiped along with QGIS and the contributed
mmqgis plugin that you can install using the Plugin Manager), making them more useful, since they can be exe-
cuted from elements such as the modeler or the batch processing interface, which we will soon describe.

Additionally, two more providers can be found, namely ‘Models’ and ‘Scripts’. This providers include user-
created algorithms, and allow you to define your own workflows and processing tasks. We will devote a full
section to them a bit later.

In the upper part of the toolbox you can find a text box. To reduce the number of algorithms shown in the toolbox
and make it easier to find the one you need, you can enter any word or phrase on the text box. Notice that, as you
type, the number of algorithms in the toolbox is reduced to just those which contain the text you have entered in
their names.

To execute an algorithm, just double-click on its name in the toolbox.

17.2.2 The algorithm dialog

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to the next one is
shown (in this case, the dialog corresponds to the SAGA ‘Convergence index’ algorithm).

Figure 17.6: Parameters Dialog

This dialog is used to set the input values that the algorithm needs to be executed. It shows a table where input
values and configuration parameters are to be set. It, of course, has a different content depending on the require-
ments of the algorithm to be executed, and is created automatically based on those requirements. On the left side,
the name of the parameter is shown. On the right side the value of the parameter can be set.

Although the number and type of parameters depend on the characteristics of the algorithm, the structure is similar
for all of them. The parameters found on the table can be of one of the following types.

• A raster layer, to select from a list of all the ones available (currently opened) in QGIS. The selector contains
as well a button on its right-hand side, to let you select filenames that represent layers currently not loaded
in QGIS.

• A vector layer, to select from a list of all the ones available in the QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
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selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

You will see a button by each vector layer selector. If the algorithm contains several of them, you will be
able to toggle just one of them. If the button corresponding to a vector input is toggled, the algorithm will
be executed iteratively on each one of its features. We will see more about this kind of execution at the end
of this section.

• A table, to select from a list of all the ones available in QGIS. Non-spatial tables are loaded into QGIS like
vector layers, and in fact they are treated as such by the program. Currently, the list of available tables that
you will see when executing a SEXTANTE algorithm that needs one of them is restricted to tables coming
from files in DBase (.dbf) or Comma-Separated Values (.csv) formats.

• An option, to choose from a selection list of possible options.

• A numerical value, to be introduced in a text box. You will find a button by its side. Clicking on it you
will see a dialog that allows you to enter a mathematical expression, so you can use it as a handy calculator.
Some useful variables related to data loaded into QGIS can be added to your expression, so you can select
a value derived from any of this variables such as the cellsize of a layer or the northern most coordinate of
another one.

Figure 17.7: Number Selector

• A range, with min and max values to be introduced in two text boxes.

• A text string, to be introduced in a text box.

• A field, to choose from the attributes table of a vector layer or a single table selected in another parameter.

• A Coordinate Reference System (CRS). You can type the EPSG code directly in the text box, or select it
from the CRS selection dialog that appear when you click on the button on the right-hand size

• A extent, to be entered by four number representing its xmin, xmax, ymin, ymax limits. Clicking on the
button on the right-hand side of the value selector, a pop-up menu will appear, giving you two option: to
select the value from a layer or the current canvas extent, or to define it by dragging directly onto the map
canvas.

If you select the first option, you will see a window like the next one.

If you select the second one, the parameters window will hide itself, so you can click and drag onto the
canvas. Once you have defined the selected rectangle, the dialog will reappear, containing the values in the
extent text box.
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Figure 17.8: SEXTANTE Extent

Figure 17.9: SEXTANTE Extent List

Figure 17.10: Extent Drag
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• A list of elements (whether raster layers, vector ones or tables), to select from the list of the ones available
in QGIS. To make the selection, click on the small button on the left side of the corresponding row to see a
dialog like the following one.

Figure 17.11: Multiple Selection

• A small table to be edited by the user. These are used to define parameters like lookup tables or convolution
kernels, among others.

Click on the button on the right side to see the table and edit its values.

Figure 17.12: Fixed Table

Depending on the algorithm, the number of rows can be modified or not, using the buttons on the right side
of the window.

You will find a [Help] button in the lower part of the parameters dialog. If a help file is available, it will be
shown, giving you more information about the algorithms and detailed descriptions of what each parameter does.
Unfortunately, most algorithms lack good documentation, but if you feel like contributing to the project, this would
be a good place to start.

A note on projections

SEXTANTE — and also most of the external applications whose algorithms are available from SEXTANTE —
does not perform any reprojection on input layers and assumes that all of them are already in a common coordinate
system and ready to be analized. Whenever you use more than one layer as input to an algorithm, whether vector
or raster, it is up to you to make sure that they are all in the same coordinate system.

Note that, due to QGIS’s ‘on-the-fly’ reprojecting capabilities, although two layers might seem to overlap and
match, that might not be true if their original coordinates are used without reprojecting them onto a common coor-
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dinate system. That reprojection should be done manually and then use the resulting files as input to SEXTANTE.
Also note that the reprojection process can be performed with SEXTANTE, which incorporates tools to do so.

17.2.3 Data objects generated by SEXTANTE algorithms

Data objects generated by SEXTANTE can be of any of the following types:

• A raster layer

• A vector layer

• A table

• An HTML file (used for text and graphical outputs)

They are all saved to disk (there are no in-memory results), and the parameters table will contain a text box
corresponding to each one of these outputs, where you can type the output channel to use for saving it. An output
channel contains the information needed to save the resulting object somewhere. In the most usual case, you will
save it to a file, but the architecture of SEXTANTE allows for any other way of storing it. For instance, a vector
layer can be stored in a database or even uploaded to a remote server using a WFS-T service. Although solutions
like these are not yet implemented, SEXTANTE is prepared to handle them, and we expect to add new kinds of
output channels in a near feature.

To select an output channel, just click on the button on the right side of the text box. That will open a save-file
dialog, where you can select the desired filepath. Supported file extensions are shown in the file format selector of
the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on the ones supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it if you are directly
typing the filepath instead). If the extension of the filepath you entered does not match any of the supported ones,
a default extension (usually .dbf for tables, .tif for raster layers and .shp for vector ones) will be appended
to the filepath and the file format corresponding to that extension will be used to save the layer or table.

If you do not enter any filename, the result will be saved as a temporary file and in the corresponding default file
format, and will be deleted once you exit QGIS (take care with that in case you save your project and it contains
temporary layers).

You can set a default folder for output data objects. Go to the configuration dialog (you can open it from the
SEXTANTE menu), and in the General group you will find a parameter named Output folder. This output folder
is used as the default path in case you type just a filename with no path (i.e. myfile.shp) when executing an
algorithm.

Apart from raster layers and tables, SEXTANTE also generates graphics and texts as HTML files. These results
are shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced
by SEXTANTE during the current session, and can be shown at any time by selecting in menu SEXTANTE →
SEXTANTE results viewer.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those outut files will not be processed by QGIS (opened or included into the
current QGIS project), since most of the times correspond to file formats or elements not supported by QGIS. This
is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see anything
new in your QGIS working session.

For all the other types of outputs, you will find a check box that you can use to tell SEXTANTE not whether to
load the file once it is generated by the algorithm or not. By default, all files are opened.

SEXTANTE does not support optional outputs, so all outputs are created, but you can uncheck the corresponding
check box if you are not interested in a given output, which virtually makes it behave like an optional output
(although the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file and
deleted once you exit QGIS)
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17.2.4 Configuring SEXTANTE

As it has been mentioned, the configuration menu gives access to a new dialog where you can configure how
SEXTANTE works. Configuration parameters are structured in separate blocks that you can select on the left-
hand side of the dialog.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for SEXTANTE layers (that is, layers generated by using algorithms from any of the SEXTANTE
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so SEXTANTE can use it. Whenever a layer is loaded by SEXTANTE and added to the QGIS canvas, it
will be rendered with that style.

Rendering stlyes can be configured individually for each algorithm and each one of its outputs. Just right-click on
the name of the algorithm in the toolbox and select Edit rendering styles. You will see a dialog like the one shown
next.

Figure 17.13: Rendering Styles

Select the style file (.qml) that you want for each output and press [OK].

Other configuration parameters in the General group are explained below:

• Use filename as layer name. The name of each resulting layer created by SEXTANTE is defined by the
algorithm generating it. In some cases, a fixed name might be used, that meaning that the same name will be
used, no matter which input layer is used. In other cases, the name might depend on the name of the input
layer or some of the parameters used to run the algorithm. If this checkbox is checked, the name will be
taken from the output filename instead. Notice, that, if the output is saved to a temporary file, the filename
of this temporary file is usually long and meaningless one intended to avoid collision with other already
existing filenames.

• Use only selected features. If this option is selected, whenever a vector layer is used as input for an
algorithm, only its selected features will be used. If the layer has no selected features, all of them will be
used.

Apart from the General block in the settings dialog, you will also find one for each algorithm provider. They
contain an Activate item that you can use to make algorithms appear or not in the toolbox. Also, some algo-
rithm providers have their own configuration items, that we will explain later when covering particular algorithm
providers.

17.3 SEXTANTE図形モデラー

17.3.1 はじめに
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*図形モデラー*で、シンプルで使いやすいインタフェースを使って複合的なモデルを作成することができ
ます。GISで操作する際、たいていの解析操作は孤立しておらず、一連の操作の連鎖の一部です。図形モデ
ラーを使用すると、プロセスのチェーンは単一のプロセスにラップすることができ、異なる設定を入力し
て単一のプロセスを行うよりもより簡単で便利です。どんなに多くのステップと、それに伴い異なるアル
ゴリズムがあろうと、モデルは単一のアルゴリズムとして実行され、大規模なモデルでは特に、時間と労
力を節約できます。

The modeler can be opened from the SEXTANTE menu, but also from the toolbox. In the Modeler branch of the
algorithms tree you will find a group named Tools, which contains an entry called Create new model.

The modeler has a working canvas where the structure of the model and the workflow it represents are shown. On
the left part of the window, a panel with two tabs can be used to add new elements to the model.

Figure 17.14: Modeler

Creating a model involves two steps:

1. Definition of necessary inputs*. These inputs will be added to the parameters window, so the user can set
their values when executing the model. The model itself is a SEXTANTE algorithm, so the parameters
window is generated automatically as it happens with all the algorithms included in SEXTANTE.

2. Definition of the workflow. Using the input data of the model, the workflow is defined adding algorithms
and selecting how they use those inputs or the outputs generated by other algorithms already in the model.

17.3.2 Definition of inputs

The first step to create a model is to define the inputs it needs. The following elements are found in the Inputs tabs
on the left side of the modeler window:

• Raster layer

• Vector layer

• String

• Table field

• Table

• Numerical value

• Boolean value

Double-clicking on any of them, a dialog is shown to define its characteristics. Depending on the parameter itself,
the dialog will contain just one basic element (the description, which is what the user will see when executing the
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Figure 17.15: Model Parameters

model) or more of them. For instance, when adding a numerical value, as it can be seen in the next figure, apart
from the description of the parameter you have to set a default value and a range of valid values.

For each added input, a new element is added to the modeler canvas.

Figure 17.16: Model Parameters

17.3.3 Definition of the workflow

Once the inputs have been defined, it is time to define the algorithms to apply on them. Algorithms can be found
in the Algorithms tab, grouped much in the same way as they are in the toolbox.

Figure 17.17: Model Parameters

To add an algorithm, double-click on its name. An execution dialog will appear, with a content similar to the
one found in the execution panel that SEXTANTE shows when executing the algorithm from the toolbox. the one
shown next correspond to the SAGA ‘Convergence index’ algorithm, the same one we saw in the section dedicated
to the SEXTANTE toolbox.

17.3. SEXTANTE図形モデラー 165



QGIS User Guide,リリース 1.8

Figure 17.18: Model Parameters

As you can see, some differences exist. Instead of the file output box that was used to set the filepath for output
layers and tables, a simple text box is. If the layer generated by the algorithm is just a temporary result that will
be used as the input of another algorithm and should not be kept as a final result, just do not edit that textbox.
Typing anything on it means that the result is a final one, and the text that you supply will be the description for
the output, which will be the one the user will see when executing the model.

Selecting the value of each parameter is also a bit different, since there are importante differences between the
context of the modeler and the toolbox one. Let’s see how to introduce the values for each type of parameter.

• Layers (raster and vector) and tables. They are selected from a list, but in this case the possible values are
not the layers or tables currently loaded in QGIS, but the list of model inputs of the corresponding type, or
other layers or tables generated by algorithms already added to the model.

• Numerical values. Literal values can be introduced directly on the textbox. But this textbox is also a list
that can be used to select any of the numerical value inputs of the model. In this case, the parameter will
take the value introduced by the user when executing the model.

• String. Like in the case of numerical values, literal strings can be typed, or an input string can be selected.

• Table field. The fields of the parent table or layer cannot be known at design-time, since they depend of the
selection of the user each time the model is executed. To set the value for this parameter, type the name of
a field directly in the textbox, or use the list to select a table field input already added to the model. The
validity of the selected field will be checked by SEXTANTE at run-time.

Once all the parameter have been assigned valid values, click on [OK] and the algorithm will be added to the
canvas. It will be linked to all the other elements in the canvas, whether algorithms or inputs, which provide
objects that are used as inputs for that algorithm.

Elements can be dragged to a different position within the canvas, to change the way the module structure is
displayed and make it more clear and intuitive. Links between elements are update automatically.

You can run your algorithm anytime clicking on the [Run] button. However, in order to use it from the toolbox, it
has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

17.3.4 Saving and loading models

Use the [Save] button to save the current model and the [Open] one to open any model previously saved. Model
are saved with the .model extension. If the model has been previously saved from the modeler window, you will
not be prompted for a filename, since there is already a file associated with that model, and it will be used.
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Figure 17.19: Model Parameters

Before saving a model, you have to enter a name and a group for it, using the text boxes in the upper part of the
window.

Models saved on the models folder (the default folder when you are prompted for a filename to save the model)
will appear in the toolbox in the corresponding branch. When the toolbox is invoked, SEXTANTE searches the
models folder for files with .model extension and loads the models they contain. Since a model is itself a
SEXTANTE algorithm, it can be added to the toolbox just like any other algorithm.

The models folder can be set from the SEXTANTE configuration dialog, under the Modeler group.

Models loaded from the models folder appear not only in the toolbox, but also in the algorithms tree in the
Algorithms tab of the modeler window. That means that you can incorporate a model as a part of a bigger model,
just as you add any other algorithm.

In some cases, SEXTANTE might not be able to load a model because it cannot find all the algorithms included
in its workflow. If you have used a given algorithm as part of your model, it should be available (that is, it
should appear on the toolbox) in order to load that model. Deactivating an algorithm provider in the SEXTANTE
configuration window renders all the algorithms in that provider unusable by the modeler, which might cause
problems when loading models. Keep that in mind when you have trouble loading or executing models.

17.3.5 Editing a model

You can edit the model you are currently creating, redefining the workflow and the relationships between the
algorithms and inputs that define the model itself.

If you right-click on an algorithm in the canvas representing the model, you will see a context menu like the one
shown next:

Figure 17.20: Modeler Right Click
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Selecting the Remove option will cause the selected algorithm to be removed. An algorithm can be removed only
if there are no other algorithms dependind on it. That is, if no output from the algorithm is used in a different one
as input. If you try to remove an algorithm that has others depending on it, SEXTANTE will show you a warning
message like the one you can see below:

Figure 17.21: Cannot Delete ALG

Selecting the Edit option or simply double-clicking on the algorithm icon will show the parameters dialog of the
algorithm, so you can change the inputs and parameter values. Not all input elements available in the model will
appear in this case as available inputs. Layers or values generated at a more advanced step in the workflow defined
by the model will not be available if they cause circular dependencies.

Select the new values and then click on the [OK] button as usual. The connections between the model elements
will change accordingly in the modeler canvas.

17.3.6 Activating and deactivating algorithms

Algorithms can be deactivated in the modeler, so they will not be executed once the model is run. This can be
used to test just a given part of the model, or when you do not need all the outputs it generates.

To deactivate an algorithm, right-click on its icon in the model canvas and select the Deactivate option. You will
see that the algorithm is represented now with a red label under its name indicating that is not active.

Figure 17.22: Deactivate

All algorithms depending (directly or undirectly) on that algorithm will also appear as inactive, since they cannot
be executed now.

To activate an algorithm, just right–click on its icon and select the Activate option.

17.3.7 Editing model help files and meta-information

You can document your models from SEXTANTE. Just click on the [Edit model help] button and a dialog like
the one shown next will appear.

On the right-hand side you will see a simple HTML page, created using the description of the input parameters
and outputs of the algorithm, along with some additional items like a general description of the model or its author.
The first time you open the help editor all those descriptions are empty, but you can edit them using the elements
on the left-hand side of the dialog. Select an element on the upper part and the write its description in the texbox
below.

Model help is saved in a file in the same folder as the model itself. You do not have to worry about saving it, since
it is done automatically.
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Figure 17.23: Help Edition

17.3.8 About available algorithms

You might notice that some algorithms that can be be executed from the toolbox do not appear in the list of
available ones when you are designing a model. To be included in a model, and algorithm must have a correct
semantic, so as to be properly linked to other in the workflow. If an algorithm does not have such well-defined
semantic (for instance, if the number of output layers cannot be know in advance), then it is not possible to use it
within a model, and thus does not appear in the list of them that you can find in the modeler dialog.

Additionaly, you will see some algorithms in the modeler that are not found in the toolbox. This algorithms are
meant to be used exclusively as part of a model, and they are of no interest in a different context. The ‘Calculator’
algorithm is an example of that. It is just a simple arithmetic calculator that you can use to modify numerical
values (entered by the user or generated by some other algorithm). This tools is really useful within a model, but
outside of that context, it doesn’t make too much sense.

17.3.9 SEXTANTE models as Python code

This feature is temporarily unavailable

Along with the tab that contains the graphical design of the model, you will find another one containing a Python
script which performs the same task as the model itself. Using that code, you can create a console script (we
will explain them later in this same manual) and modify it to incorporate actions and methods not available in the
graphical modeler, such as loops or conditional sentences.

This feature is also a very practical way of learning how to use SEXTANTE from the console and how to create
SEXTANTE algorithms using Python code, so you can use it as a learning tool when you start creating your own
SEXTANTE scripts.

You will find a button below the text field containing the Python code. Click on it to directly create a new script
from that code, without having to copy and paste it in the SEXTANTE script editor.

17.4 SEXTANTEバッチプロセシングインタフェース

17.4.1 はじめに

SEXTANTEアルゴリズム（モデルを含む）はバッチプロセスとして実行することができます。すなわち、
それらは単一の入力のセットではなく、それらのいくつかを使用して実行でき、必要に応じて何度でもア
ルゴリズムを実行できます。大量のデータを処理する際には、ツールボックスからアルゴリズムを何回も
起動する必要がないので、これは有用です。
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To execute an algorithm as a batch process, right-click on its name in the toolbox and select the Execute as batch
process option in the pop-up menu that will appear.

Figure 17.24: Batch Processing Right Click

17.4.2 パラメータテーブル

バッチプロセスの実行は、アルゴリズムの単純な実行と類似しています。パラメータ値を定義しなければな
らないが、この場合は、各パラメータに単一の値を設定する必要はありません。値は次に示すようなテー
ブルを使って紹介しています。

Figure 17.25: Batch Processing

このテーブルの各行はアルゴリズム単一の実行を表し、各セルはパラメータの１つを含みます。これはツー
ルボックスからアルゴリズムを実行する際に表示されるパラメータダイアログと類似しており、配列が異
なっています。

デフォるどではテーブルｈは２行のみ含んでいます。ウィンドウの下部にあるボタンを使って、行の追加
や削除ができます。

Once the size of the table has been set, it has to be filled with the desired values.

17.4.3 パラメータテーブルの入力

たいていのパラメータで、その値を設定するのは些細なことです。値を直接入力するか、パラメータタイ
プに応じて、利用可能なオプションのリストから選択するだけです。

主な違いはレイヤやテーブルで代表されるパラメータ、および出力ファイルに対して見られます。入力レイ
ヤとテーブルについて、アルゴリズムがバッチプロセスの一部として実行された時、入力データオブジェ
クトは、QGISですでに開かれたファイルのセットからでなくファイルから直接取得されます。その理由と
して、任意のアルゴリズムがすでに開かれたデータのないオブジェクトに対してバッチプロセスを実行し
て、アルゴリズムをツールボックスから実行できません。

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button on
the right hand of the cell, which shows a typical file chooser dialog. Multiple files can be selected at once. If the
input parameter represents a single data object and several files are selected, each one of them will be put in a
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separate row, adding new ones if needed. If it represents a multiple input, all the selected files will be added to a
single cell, separated by semicolons (;).

ツールボックスからアルゴリズムを実行する時と異なり、出力データオブジェクトは常にファイルとして
保存され、一時的にそれを保存することは許可されていません。名称を直接入力するか、添付のボタンを
クリックして表示されるファイル選択ダイアログを使用します。

いったんファイルを選択すると、新しいダイアログが同じ列（同じパラメータ）内の他のセルの自動補完
を行うために表示されます。

Figure 17.26: Batch Processing Save

If the default value (‘Do not autocomplete’) is selected, SEXTANTE will just put the selected filename in the
selected cell from the parameters table. If any of the other options is selected, all the cells below the selected one
will be automatically filled based on a defined criteria. This way, it is much easier to fill the table, and the batch
process can be defined with less effort.

自動入力は、単に選択したファイルパスに相関的な番号をを追加するか、同じ行で別のフィールドの値を
追加して行うことができます。これは、入力されたものに応じて出力データオブジェクトを命名するのに
特に役立ちます。

Figure 17.27: Batch Processing File Path

17.4.4 バッチプロセスの実行

To execute the batch process once you have introduced all the necessary values, just click on [OK]. SEXTANTE
will show the progress of the global batch process in the progress bar in the lower part of the dialog.

17.5 Using SEXTANTE from the console

17.5.1 はじめに

The console allows advanced users to increase their productivity and perform complex operations that cannot be
performed using any of the other elements of the SEXTANTE GUI. Models involving several algorithms can be
defined using the command-line interface, and additional operations such as loops and conditional sentences can
be added to create more flexible and powerful workflows.
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There is not a SEXTANTE console in QGIS, but all SEXTANTE commands are available instead from QGIS
built-in Python console. That means that you can incorporate those command to your console work and connect
SEXTANTE algorithms to all the other features (including methods from the QGIS API) available from there.

The code that you can execute from the Python console, even if it does call any SEXTANTE method, can be
converted into a new SEXTANTE algorithm that you can later call from the toolbox, the graphical modeler or any
other SEXTANTE component, just like you do with any other SEXTANTE algorithm. In fact, some algorithms
that you can find in the toolbox, like all the ones in the mmqgis group, are simple scripts.

In this chapter we will see how to use SEXTANTE from the QGIS Python console, and also how to write your
own algorithms using Python.

17.5.2 Calling SEXTANTE from the Python console

The first thing you have to do is to import the SEXTANTE functions with the following line:

>>> import sextante

Now, there is basically just one (interesting) thing you can do with SEXTANTE from the console: to execute an
algorithm. That is done using the runalg() method, which takes the name of the algorithm to execute as its first
parameter, and then a variable number of additional parameter depending on the requirements of the algorithm.
So the first thing you need to know is the name of the algorithm to execute. That is not the name you see in
the toolbox, but rather a unique commandline name. To find the right name for your algorithm, you can use the
algslist() method. Type the following line in you console:

>>> sextante.alglist()

You will see something like this.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

That’s a list of all the available algorithms, alphabetically ordered, along with their corresponding command-line
names.

You can use a string as a parameter for this method. Instead of returning the full list of algorithm, it will only
display those that include that string. If, for instance, you are looking for an algorithm to calculate slope from a
DEM, type alglist("slope") to get the following result:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]
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This result might change depending on the algorithms you have available.

It is easier now to find the algorithm you are looking for and its command-line name, in this case
saga:slopeaspectcurvature.

Once you know the command-line name of the algorithm, the next thing to do is to know the right syntax to
execute it. That means knowing which parameters are needed and the order in which they have to be passed when
calling the runalg() method. SEXTANTE has a method to describe an algorithm in detail, which can be used
to get a list of the parameters that an algorithms require and the outputs that it will generate. To do it, you can use
the alghelp(name_of_the_algorithm) method. Use the command-line name of the algorithm, not the
full descriptive name.

Calling the method with saga:slopeaspectcurvature as parameter, you get the following description.

>>> sextante.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Now you have everything you need to run any algorithm. As we have already mentioned, there is only one single
command to execute algorithms: runalg(). Its syntax is as follows:

>>> sextante.runalg{name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

The list of parameters and outputs to add depends on the algorithm you want to run, and is exactly the list that the
alghelp() method gives you, in the same order as shown.

Depending on the type of parameter, values are introduced differently. The next one is a quick review of how to
introduce values for each type of input parameter

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened, but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Selection. If an algorithm has a selection parameter, the value of that parameter should be entered using an
integer value. To know the available options, you can use the algoptions command, as shown in the
following example:

>>> sextante.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In this case, the algorithm has one of such such parameters, with 7 options. Notice that ordering is zero-
based.

• Multiple input. The value is a string with input descriptors separated by semicolons. As in the case of single
layers or tables, each input descriptor can be the data object name, or its filepath.

• Table Field from XXX. Use a string with the name of the field to use. This parameter is case-sensitive.

• Fixed Table. Type the list of all table values separated by commas and enclosed between quotes. Values
start on the upper row and go from left to right. You can also use a 2D array of value representing the table.
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• CRS. Enter the EPSG code number of the desired CRS.

• Extent. You must use a string with xmin, xmax, ymin and ymax values separated by commas.

Boolean, file, string and numerical parameters do not need any additional explanations.

Input parameters such as strings booleans or numerical values have default values. To use them, use None in the
corresponding parameter entry.

For output data objects, type the filepath to be used to save it, just as it is done from the toolbox. If you want to
save the result to a temporary file, use None. The extension of the file determines the file format. If you enter a
file extension not included in the ones supported by the algorithm, the default file format for that output type will
be used, and its corresponding extension appended to the given filepath.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to it, you have to do it yourself after
running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the handy methods
provided by SEXTANTE for such task.

The runalg() method returns a dictionary with the output names (the ones shown in the algorithm description)
as keys and the filepaths of those outputs as values. To add all the outputs generated by an algorithm, pass that
dictionary to the loadFromAlg() method. You can also load an individual layer passing its filepath to the
load() method.

17.5.3 Creating scripts and running them from the toolbox

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed by SEXTANTE. You can find a Create new script under the tools group in
the script algorithms block of the toolbox. Double click on it to open the script edition dialog. That’s where you
should type your code. Saving the script from there in the scripts folder (the default one when you open the
save file dialog), with .py extension, will automatically create the corresponding algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing low hyphens with blank spaces.

Let’s have the following code, which calculates the Topographic Wetness Index (TWI) directly from a DEM

##dem=raster
##twi=output
ret_slope = sextante.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = sextante.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
sextante.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates de TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these ones, but since we have the DEM,
we can calculate them calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
sections in this chapter. The first lines, however, need some additional explanation. They provide SEXTANTE
the information it needs to turn your code into an algorithm that can be run from any of its components, like the
toolbox or the graphical modeler.

These lines start with a double Python comment symbol and have the following structure:

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that SEXTANTE supports in its scripts, their syntax and some examples.

• raster. A raster layer

• vector. A vector layer

• table. A table
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• number. A numerical value. A default value must be provided. For instance, depth=number 2.4

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True

• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• folder. A folder

• file. A filename

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, SEXTANTE will edit it to improve its appearance, replacing
low hyphens with blankspaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the sextante.getObjectFromUri() function. Multiple inputs also have a string value,
which contains the filepaths to all selected object, separated by semicolons.

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

The value assigned to the output variables is always a string with a filepath. It will correspond to a temporary
filepath in case the use has not entered any output filename.

When you declare an output, SEXTANTE will try to add it to QGIS once the algorithm is finished. That is the
reason why, although the runalg() method does not load the layers it produces, the final TWI layer will be
loaded, since it is saved to the file entered by the user, which is the value of the corresponding output.

Do not use the load() method in your script algorithms, but just when working with the console line. If a layer
is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly
use the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, it is you who has to assign a value to them. To
do so, just set the value of a variable with the name you used to declare that output. For instance, if you have used
this declaration,

##average=output number

the following line will set the value of the output to 5:

average = 5
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In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

If you algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two available methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

Several examples are provided with SEXTANTE. Please, check them to see real examples of how to create algo-
rithms using this feature of SEXTANTE. You can right-click on any script algorithm and select Edit script to edit
its code or just to see it.

17.5.4 Documenting your scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to know more about this dialog and
how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated to a filename, saving is done automatically.

17.6 The SEXTANTE history manager

17.6.1 SEXTANTE history

SEXTENTEアルゴリズムを実行するたびに、プロセスに関する情報が SEXTENTE history managerの中に
保存されます。使用されるパラメータと共に、実行した日時も保存されます。

この方法では、追跡し、SEXTANTEを使用して開発されたすべての作業を制御することが容易であり、簡
単に再現することができます。

SEXTANTE history manager　は　実行日時にしたがってグルーピングされたレジストリ入力のセットであ
り、任意の特定の時点で実行されるアルゴリズムの情報を見つけることを容易にします。

Figure 17.28: History

プロセス情報は、アルゴリズムをツールボックスから起動された場合でも、コマンドライン式として保持
されます。ツールボックスを使用してアルゴリズムを呼び出し、それからヒストリーマネージャでコマン
ドラインから呼び出したアルゴリズムを確認するため、それはコマンドラインインタフェースを使い方を
学習するのにも役立ちます。
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レジストリ内のエントリは別として、対応するエントリを単にダブルクリックすることで、プロセスを再
実行することができます。

Along with algorithm executions, SEXTANTE communicates with the user using the other groups of the registry,
namely Errors, Warnings and Information. In case something is not working properly, having a look at the Errors
might help you to see what is happening. If you get in contact with a SEXTANTE developer to report a bug or
error, the information in that group will be very useful for him to find out what is going wrong.

When executing third party algorithms, this is usually done calling their command-line interfaces, which com-
municate with the user using the console. Although that console is not shown, a full dump of it is stored in the
Information group each time you run one of those algorithms. If, for instance, you are having problems executing
a SAGA algorithm, look for an entry name ‘SAGA execution console output’ to check all the messages generated
by SAGA and try to find out where the problem is.

Some algorithms, even if they can produce a result with the given input data, might add comments or additional
information to Warning in case they detect potential problems from that data, in order to warn you about them.
Make sure you check those messages in case you are having unexpected results.

17.7 外部アプリケーションの設定

17.7.1 はじめに

SEXTANTEは SEXTANTE内からそれらを呼び出して、追加のアプリケーションを使用して拡張すること
ができます。現在、SAGA、GRASS、OTB（Orfeo Toolbox）と Rは、空間データ分析機能を提供するいく
つかの他のコマンドラインアプリケーションと一緒に、サポートされています。外部アプリケーションに
依存するアルゴリズムは、独自のアルゴリズムプロバイダによって管理されます。

この章では、これらの追加アプリケーションを含めるための SEXTANTEの設定方法を示し、これらにモ
ドづいたアルゴリズムのいくつかの特定の特徴を説明します。いったんシステムを正しく構成すると、あ
なたが他の SEXTANTEの geoalgorithmで行うと同じように、toolboxまたは graphical modelerのような
SEXTANTEコンポーネントから外部のアルゴリズムを実行することができるようになります。

By default, all algorithms that rely on an external appplication not shipped with QGIS are not enabled. You can
enable them in the SEXTANTE configuration dialog. Make sure that the corresponding application is already
installed in your system. Enabling an algorithm provider without installing the application it needs will cause the
algorithms to appear in the toolbox, but an error will be thrown when you try to execute them.

This is because the algorithm descriptions (needed to create the parameters dialog and give SEXTANTE the
information it needs about the algorithm) are not included with each appllication, but with SEXTANTE instead.
That is,they are part of SEXTANTE, so you have them in your installation even if you have not installed any other
software. Running the algorithm, however, needs the application binaries to be installed in your system.

A note on file formats

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as well
on that other software. In most cases, it can read what you have opened in QGIS, but in some cases, that might not
be the case. When using databases or uncommon file formats, whether for raster of vector layers, problems might
arise. If that happens, try to use well known file formats that you are sure that are understood by both programs,
and check to console output (in the history and log dialog) for knowing more about what is going wrong.

Using GRASS raster layers is, for instance, one case in which you might have trouble and not be able to complete
your work if you call an external algorithm using such a layer as input. For this reason, these layers will not
appear as available to SEXTANTE algorithms (we are currently working on solving this, and expect to have it
ready soon).

You should, however, find no problems at all with vector layers, since SEXTANTE automatically converts from
the original file format to one accepted by the external application before passing the layer to it. This adds an extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more to
process a layer from a DB connection that one of a similar size stored in a shapefile.
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Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis trough QGIS.

Regarding output formats, raster layers can be saved as TIFF (.tif) files, while vector layers are saved as
shapefiles (.shp). These have been chosen as the ‘lingua franca’ between supported third party applications and
QGIS. If the output filename that you select is not one of the above, it will be modified, adding the corresponding
suffix, and the default file format will be used.

In the case of GDAL, the number of supported output formats is larger. When you open the file selection dialog,
you will see that you have more formats (and their corresponding extensions available). For more information
about which formats are supported, check the GDAL documentation.

A note on vector layer selections

By default, when an external algorithm takes a vector layer, it will use all its features, even if a selection exist
in QGIS. You can make an external algorithm aware of that selection by checking the Use selected features in
external applications item in the General settings group. When you do so, each time you execute an external
algorithm that uses a vector layer, the selected features of that layer will be exported to a new layer, and the
algorithm will work with that new layer instead.

Notice that if you select this option, a layer with no selection will behave like a layer with all its features selected,
not like an empty layer.

17.7.2 SAGA

SAGA algorithms can be run from SEXTANTE if you have SAGA installed in your system and you configure
SEXTANTE properly so it can find SAGA executables. In particular, the SAGA command-line executable is
needed to run SAGA algorithms. SAGA binaries are not included with SEXTANTE, so you have to download and
install the software yourself. Please check the SAGA website at for more information. SAGA 2.0.8 is needed.

Once SAGA is installed, and if you are running Windows, open the SEXTANTE configuration dialog. In the
SAGA block you will find a setting named SAGA Folder. Enter the path to the folder where SAGA is installed.
Close the configuration dialog and now you are ready to run SAGA algorithms from SEXTANTE.

In case you are using Linux, there is no need to configure that, and you will not see those folders. Instead, you
must make sure that SAGA is properly installed and its folder is added to the PATH environment variable. Just
open a console and type saga_cmd to check that the system can found where SAGA binaries are located.

About SAGA grid system limitations

Most of SAGA algorithms that require several input raster layers, require them to have the same grid system. That
is, to cover the same geographic area and have the same cellsize, so their corresponding grids match. When calling
SAGA algorithms from SEXTANTE, you can use any layer, regardless of its cellsize and extent. When multiple
raster layers are used as input for a SAGA algorithm, SEXTANTE resamples them to a common grid system and
then passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

The definition of that common grid system is controlled by the user, and you will find several parameters in the
SAGA group of the setting window to do so. There are two ways of setting the target grid system:

• Setting it manually. You define the extent setting the values of the following parameters:

– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Notice that SEXTANTE will resample input layers to that extent, even if they do not overlap with it.
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• Setting it automatically from input layers. To select this option, just check the Use min covering grid system
for resampling option. All the other settings will be ignored and the minimum extent that covers all the
input layers will be used. The cellsize of the target layer is the maximum of all cellsizes of the input layers.

For algorithms that do not use multiple raster layers, or for those that do not need a unique input grid system, no
resampling is performed before calling SAGA, and those parameters are not used.

Limitations for multi-band layers

Unlike QGIS, SAGA has no support for multiband layers. If you want to use a multiband layer (such as
an RGB or multispectral image), you first have to split it into singlebanded images. To do so, you can use
the ‘SAGA/Grid - Tools/Split RGB image’ algorithm (which creates 3 images from an RGB image) or the
‘SAGA/Grid - Tools/Extract band’ algorithm (to extract a single band).

Limitations in cellsize

SAGA assumes that raster layers have the same cellsize in the X and Y axis. If you are working with a layer
with different values for its horizontal and vertical cellsizes, you might get unexcepted results. In this case, a
warning will be added to the SEXTANTE log, indicating that an input layer might not be suitable to be processed
by SAGA.

Logging

When SEXTANTE calls SAGA, it does it using its command-line interface, thus passing a set of commands to
perform all the required operation. SAGA show its progress by writing information to the console, which includes
the percentage of processing already done, along with additional content. This output is filtered by SEXTANTE
and used to update the progress bar while the algorithm is running.

Both the commands sent by SEXTANTE and the additional information printed by SAGA can be logged along
with other SEXTANTE log messages, and you might find them useful to track in detailed what is going on when
SEXTANTE runs a SAGA algorithm. You will find two settings, namely Log console output and Log execution
commands to activate that logging mechanism.

Most other providers that use an external application and call it through the command-line have similar options,
so you will find them as well in other places in the SEXTANTE settings list.

17.7.3 R and R scripts

R integration in SEXTANTE is different from that of SAGA in that there is not a predefined set of algorithms you
can run (except for a few examples). Instead, you should write your scripts and call R commands, much like you
would do from R, and in a very similar manner to what we saw in the chapter dedicated to SEXTANTE scripts.
This chapter shows you the syntax to use to call those R commands from SEXTANTE and how to use SEXTANTE
objects (layers, tables) in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell SEXTANTE where you R binaries are
located. You can do so using the R folder entry in the SEXTANTE configuration dialog. Once you have set that
parameter, you can start creating your own R scripts and executing them.

Once again, this is different in Linux, and you just have to make sure that the R folder is included in the PATH
environment variable. If you can start R just typing R in a console, then you are ready to go.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from SEXTANTE), you have to create a script file that tells SEXTANTE how to
perform that operation and the corresponding R commands to do so.

Script files have the extension .rsx and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can set this folder in the R settings
group (available from the SEXTANTE settings dialog), just like you do with the folder for regular SEXTANTE
scripts.
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Let ’s have a look at a very simple file script file, which calls the R method spsample to create a random grid
within the boundary of the polygons in a given polygon layer. This method belong to the maptools package.
Since almost all the algorithms that you might like to incorporate into SEXTANTE will use or generate spatial
data, knowledge of spatial packages like maptools and, specially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell SEXTANTE the inputs of the algorithm
described in the file and the outputs that it will generate. They work exactly with the same syntax as the SEX-
TANTE scripts that we have already seen, so they will not be described here again. Check the corresponding
section for more information.

When you declare an input parameter, SEXTANTE uses that information for two things: creating the user interface
to ask the user for the value of that parameter and creating a corresponding R variable that can be later used as
input for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
SEXTANTE will open in R the layer selected by the user and store it in a variable also named polyg. So the
name of a parameter is also the name of the variable that we can use in R for accesing the value of that parameter
(thus, you should avoid using reserved R words as parameter names).

Spatial elements such as vector and raster layers are read using the readOGR() and readGDAL() commands
(you do not have to worry about adding those commands to your description file, SEXTANTE will do it) and
stored as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected
field.

Tables are opened using the read.csv() command. If a table entered by the user is not in CSV format, it will
be converted prior to importing it in R.

Knowing that, we can now understand the first line of our example script (the first line not starting with a Python
comment).

pts=spsample(polyg,numpoints,type="random")

The variable polygon already contains a SpatialPolygonsDataFrame object, so it can be used to call the
spsample method, just like the numpoints one, which indicates the number of points to add to the created
sample grid.

Since we have declared an output of type vector named out, we have to create a variable named out and store a
Spatial*DataFrame object in it (in this case, a SpatialPointsDataFrame). You can use any name for
your intermediate variables. Just make sure that the variable storing your final result has the same name that you
used to declare it, and contains a suitable value.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be retuned to SEXTANTE.

If you algorithm does not generate any layer, but a text result in the console instead, you have to tell SEXTANTE
that you want the console to be shown once the execution is finished. To do so, just start the command lines that
produce the results you want to print with the > (‘greater’) sign. The output of all other lines will not be shown.
For instance, here is the description file of an algorithms that performs a normality test on a given field (column)
of the attributes of a vector layer:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])
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The output ot the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by SEXTANTE).

If your algorithm creates any kind of graphics (using the plot() method), add the following line:

##showplots

This will cause SEXTANTE to redirect all R graphical outputs to a temporary file, which will be later opened once
R execution has finished.

Both graphics and console results will be shown in the SEXTANTE results manager.

For more information, please check the script files provided with SEXTANTE. Most of them are rather simple and
will greatly help you understand how to create your own ones.

17.7.4 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionaly, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, SEXTANTE tries to configure its GRASS connector to use the GRASS distribution that ships along
with QGIS. This should work without problems in most systems, but if you experience problems, you might have
to do it manually. Also, if you want to use a different GRASS version, you can change that setting and point to
the folder where that other version is kept. GRASS 6.4 is needed for algorithms to work correctly.

If you are running Linux, you just have to make sure that GRASS is correctly installed, and that it can be run
without problem from a console.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If this is the behaviour you prefer, just check the Use min covering
region option in the GRASS configuration parameters.

GRASS includes help files describing each algorithm. If you set the GRASS help folder parameter, SEXTANTE
will open them when you use the [Show help] button from the parameters window of the algorithm.

The last parameter that has to be configured is related to the mapset. A mapset is needed to run GRASS, and
SEXTANTE creates a temporary one for each execution. You have to tell SEXTANTE if the data you are working
with uses geographical (lat/lon) coordinates or projected ones.

17.7.5 GDAL

No additional configuration is needed to run GDAL algorithms, since it is already incorporated to QGIS and
SEXTANTE can infere its configuration from it.

17.7.6 Orfeo ToolBox

Orfeo ToolBox (OTB) algorithms can be run from SEXTANTE if you have OTB installed in your system and
configured SEXTANTE properly so it can find all necessary files (command-line tools and libraries). Please note
that OTB binaries are not included in SEXTANTE, so you have to download and install the software yourself.
Please check the OTB website for more information.

Once OTB is installed, start QGIS, open the SEXTANTE configuration dialog and configure OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block you will find all settings related to OTB. First ensure that
algorithms are enabled.

Then configure path to the folder where OTB command-line tools and libraries are installed:

• usually OTB applications folder point to /usr/lib/otb/applications and OTB command line
tools folder is /usr/bin
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• if you use OSGeo4W installer, than install otb-bin package and enter
C:\OSGeo4W\apps\orfeotoolbox\applications as OTB applications folder and
C:\OSGeo4W\bin as OTB command line tools folder

17.7.7 TauDEM

To use this provider you need to install TauDEM command line tools.

Windows

Please visit TauDEM homepage for installation instructions and precompiled binaries for 32bit and 64bit systems.
IMPORTANT: you need TauDEM 5.0.6 executables, version 5.2 currently not supported.

Linux

There are no packages for most Linux distribution, so you should compile TauDEM by yourself. As TauDEM
uses MPICH2, first install it using your favorite package manager. Also TauDEM works fine with OpenMPI, so
you can use it instead of MPICH2.

Download TauDEM 5.0.6 source code and extract files in some folder.

Open linearpart.h file and add after line

#include "mpi.h"

add new line with

#include <stdint.h>

so you’ll get

#include "mpi.h"
#include <stdlib.h>

Save changes and close file. Now open tiffIO.h, find line #include "stdint.h" and replace quotes
("") with <>, so you’ll get

#include <stdint.h>

Save changes and close file. Create build directory and cd into it

mkdir build
cd build

Configure your build with command

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

and then compile

make

Finaly, to install TauDEM into /usr/local/bin, run

sudo make install
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Chapter 18

プリントコンポーザ

The print composer provides growing layout and printing capabilities. It allows you to add elements such as the
QGIS map canvas, legend, scalebar, images, basic shapes, arrows and text labels. You can size, group, align and
position each element and adjust the properties to create your layout. The layout can be printed or exported to
image formats, Postscript, PDF or to SVG (export to SVG is not working properly with some recent Qt4 versions.
You should try and check individual on your system). You can save the layout as template and load it again in
another session. See a list of tools in table_composer_1:

アイコ
ン

目的 アイコ
ン

目的

テンプレートからロードする テンプレートとして保存する

イメージ画像として出力する PDF型式で出力する

SVGとして出力する 印刷または Postscriptとして出力す
る

全域表示 拡大

縮小 再読み込み

アンドゥ 最後の変更を元に戻す

QGISマップキャンバスから新規地図を追
加する

印刷構成にイメージ画像を追加

印刷構成にラベルを追加 印刷構成に新規凡例を追加

印刷構成に新規スケールバー追加 印刷構成に基本図形を追加

印刷構成に矢印を追加 印刷構成に属性テーブルを追加

印刷構成でアイテムを選択/移動する アイテム内のコンテンツを移動する

印刷構成内のアイテムをグループ化する 印刷構成内のアイテムグループを解
除する

アイテムを前面に移動 選択アイテムを背面に移動

選択アイテムを最前面に移動 選択アイテムを最背面に移動

選択アイテムを左側で整列 選択アイテムを右側で整列

選択アイテムを中央合わせで整列 選択アイテムを水平方向の中央で整
列

選択アイテムを上側線で整列 選択アイテムを下側線で整列

Table Composer 1: プリントコンポーザツール
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すべてのプリントコンポーザツールはメニューから利用でき,かつツールバーのアイコンから利用できます.
ツールバーはマウスがツールバーの上にあるときにマウス右ボタンで表示と非表示を切り替えできます.

18.1 新しいプリントコンポーザテンプレートを開く

プリントコンポーザで作業を開始する前にいくつかのラスタまたはベクタレイヤを QGISマップキャンバ
スにロードして必要に応じてプロパティを設定しておく必要があります. すべての描画と描画設定が終わっ

たらツールバーの New Print Composer アイコンをクリックするかメニューの File → New Print Composerを
選択して下さい.

18.2 プリントコンポーザを利用する

プリントコンポーザーを開くと、現在の QGISマップキャンバス、凡例、スケールバー、画像、基本図形、

矢印とテキストが追加できる空白のキャンバスを提供します。Figure_composer_1は、 :guilabel:‘グリッ
ドにスナップ ‘モードですが要素が追加される前のプリントコンポーザーの初期ビューを示します。

Figure 18.1: Print Composer

プリントコンポーザには 3個のタブがあります

• The Composition tab allows you to set paper size, orientation, the print quality for the output file in dpi and

to activate snapping to a grid of a defined resolution. Please note, the Snap to grid feature only works,

if you define a grid resolution > 0. Furthermore you can also activate the Print as raster checkbox. This
means all elements will be rastered before printing or saving as Postscript of PDF.

• The Item Properties tab displays the properties for the selected map element. Click the Select/Move item

icon to select an element (e.g. legend, scalebar or label) on the canvas. Then click the Item Properties tab
and customize the settings for the selected element.

• The Command history tab displays a history of all changes applied to the print composer layout. With a
mouse click it is possible to undo and redo layout steps back and forth to a certain status.

You can add multiple elements to the composer. It is also possible to have more than one map view or legend or
scalebar in the print composer canvas. Each element has its own properties and in the case of the map, its own
extent. If you want to remove any elements from the composer canvas you can do that with the Delete or the
Backspace key.
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18.3 カレントQGISマップキャンバスをプリントコンポーザに追加する

Click on the Add new map toolbar button in the print composer toolbar, to add the QGIS map canvas. Now drag a
rectangle on the composer canvas with the left mouse button to add the map. To display the current map, you can
choose between three different modes in the map Item Properties tab:

• Rectangle is the default setting. It only displays an empty box with a message ‘Map will be printed here’.

• Cache renders the map in the current screen resolution. If case you zoom in or out the composer window,
the map is not rendered again but the image will be scaled.

• Render means, that if you zoom in or out the composer window, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

キャッシュが新規にプリントコンポーザに地図が追加された時のデフォルトプレビューモードです。

You can resize the map element by clicking on the Select/Move item button, selecting the element, and dragging
one of the blue handles in the corner of the map. With the map selected, you can now adapt more properties in the
map Item Properties tab.

To move layers within the map element select the map element, click the Move item content icon and move the
layers within the map element frame with the left mouse button. After you found the right place for an element,
you can lock the element position within the print composer canvas. Select the map element and click on the right

mouse button to Lock the element position and again to unlock the element. You can lock the map element also

activating the Lock layers for map item checkbox in the Map dialog of the Item Properties tab.

ノート: QGIS is now able to show labels from the new labeling plugin also in the map composer, but it is not yet
scaled correctly. So it might be necessary to switch back to the standard labeling in some cases.

18.3.1 Map item properties tab — Map and Extents dialog

地図ダイアログ

The Map dialog of the map Item Properies tab provides following functionalities (see figure_composer_2):

Figure 18.2: Map Dialog

• The Preview area allows to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. Click on the [Update preview] button to apply changes to the map view.

• The Map area allows to resize the map element specifying the width and height or the scale. The field

Rotation allows to rotate the map element content clockwise in degrees. Note, a coordinate frame

can only be added with the default value 0. Furthermore you can enable the checkboxes Lock layers for

map items and Draw map canvas items.
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QGISマップキャンバスにあるビューを拡大縮小やスクロール、ベクタやラスタのプロパティ変更等を行った
時に更新したい場合はプリントコンポーザビューで更新したい地図エレメントを選択した後に [プレビュー
更新]ボタンをクリックして下さい。

領域ダイアログ

The Extents dialog of the map item tab provides following functionalities (see Figure figure_composer_3)):

Figure 18.3: Extents Dialog

• The Map extent area allow to specify the map extent using Y and X min/max values or clicking the [Set to
map canvas extent] button.

If you change the view on the QGIS map canvas by zooming or panning or changing vector or raster properties,
you can update the print composer view selecting the map element in the print composer and clicking the [Update
preview] button in the map Item Properties tab (see Figure figure_composer_2 a)).

18.3.2 Map item properties tab — Grid and General options dialog

グリッドダイアログ

The Grid dialog of the map Item Properties tab provides following functionalities (see Figure_composer_4):

Figure 18.4: Grid Dialog

• グリッドを表示しますかチェックボックスでは地図エレメントにオーバーレイするグリッドを有
効にします。グリッドタイプとしてソリッドラインと十字を選択できます。その上 Xと Y方向の間
隔、Xと Yのオフセット、幅の十字またはライングリッドタイプについて指定できます。

• 注記を描画するチェックボックスでは地図フレームに座標を追加できます。注記は地図フレーム
の内側または外側に描画できます。注記の描画方向は水平、垂直、水平と垂直、または外枠の方向が
指定できます。またグリッドの色、注記のフォント、地図フレームから注記への距離、描画する座標
の精度を指定できます。

一般情報オプションダイアログ
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The General options dialog of the map Item Properties tab provides following functionalities (see Fig-
ure_composer_5):

Figure 18.5: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the map canvas. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. With the Item ID you can create a relationship to the
other print composer items.

18.4 プリントコンポーザに他のエレメントを追加する

プリントコンポーザにカレント QGISマップキャンバスを追加することに加えて凡例、スケールバー、イ
メージ、ラベルエレメントについて追加、位置の設定、移動、カスタマイズが可能です。

18.4.1 Label item properties tab - Label and General options dialog

To add a label, click the Add label icon, place the element with the left mouse button on the print composer
canvas and position and customize their appearance in the label Item Properties tab.

ラベルダイアログ

The Label dialog of the label item tab provides following functionalities:

Figure 18.6: Label Options Dialog

• The Label dialog offers to add text labels to the composer canvas. You can define the horizontal and vertical
alignment, select font and font color for the text and it is possible to define a text margin in mm.
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一般情報オプションダイアログ

The General options dialog of the label Item Properties tab provides following functionalities:

Figure 18.7: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the label. The Position button opens the Set items position dialog and allows to set the map canvas position
using reference points or coordinates. Furthermore you can select or unselect to display the element frame

with the Show frame checkbox. Use the Item ID to create a relationship to other print composer items.

18.4.2 Image item properties tab - Picture options and General options dialog

To add an image, click the Add image icon, place the element with the left mouse button on the print composer
canvas and position and customize their appearance in the image Item Properties tab.

ピクチャオプションダイアログ

The Picture options dialog of the image Item Properties tab provides following functionalities (see fig-
ure_composer_5 a):

Figure 18.8: Picture Options Dialog Dialog

• The Preloaded Images field then shows all pictures stored in the selected directories.

• The Options area shows the current selected picture and allows to define width, height and clockwise

rotation of the picture. It is also possible to add a user specific SVG path. Activating the Sync with map
checkbox synchronizes the rotation of a picture in the QGIS map canvas (i.e. a rotated north arrow) with
the appropriate print composer image.
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• **ディレクトリ検索**エリアでは、ピクチャデータベースの SVGフォーマットのイメージのディレ
クトリを追加したり削除することができます。

一般情報オプションダイアログ

The General options dialog of the image Item Properties tab provides following functionalities:

Figure 18.9: General Options Dialog Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the picture. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. With the Item ID you can create a relationship to other
print composer items.

18.4.3 Legend item properties tab - General, Legend items and Item option dia-
log

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the print
composer canvas and position and customize their appearance in the legend Item Properties tab.

一般情報ダイアログ

The General dialog of the legend item tab provides following functionalities (see figure_composer_10):

Figure 18.10: General Dialog

• Here you can adapt the legend title. You can change the font of the legend title, layer and item name. You
can change width and height of the legend symbol and you can add layer, symbol, icon label and box space.
Since QGIS 1.8, you can wrap the text of the legend title to a given character.
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凡例アイテムダイアログ

The Legend items dialog of the legend Item Properties tab provides following functionalities (see fig-
ure_composer_11):

Figure 18.11: Legend Items Dialog

• The legend items window lists all legend items and allows to change item order, edit layer names, remove
and restore items of the list. After changing the symbology in the QGIS main window you can click on
[Update] to adapt the changes in the legend element of the print composer. The item order can be changed
using the [Up] and [Down] buttons or with ‘drag and drop’ functionality.

一般情報オプションダイアログ

The General options dialog of the legend Item Properties tab provides following functionalities (see fig-
ure_composer_12):

Figure 18.12: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the legend. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. Use the Item ID to create a relationship to other print
composer items.

18.4.4 Scalebar item properties tab - Scalebar and General options dialog

To add a scalebar, click the Add new scalebar icon, place the element with the left mouse button on the print
composer canvas and position and customize their appearance in the scalebar Item Properties tab.

スケールバーダイアログ
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The Scalebar dialog of the scalebar Item Properties tab provides following functionalities (see fig-
ure_composer_13):

Figure 18.13: Scalebar Options Dialog

• The Scalebar dialog allows to define the segment size of the scalebar in map units, the map units used per
bar units, and how many left and right segments units from 0 should be used.

• スケールバーのスタイルを指定できます。スタイルとしてはシングルとダブルボックス、ライン目盛
を真ん中、上、下に置くかと数字のスタイルの指定ができます。

• Furthermore you can define height, line width, label and box space of the scalebar. Add a unit label and
define the scalebar font and color.

一般情報オプションダイアログ

The General options dialog of the scalebar Item Properties tab provides following features (see figure_composer_7
b)):

Figure 18.14: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the scalebar. The [Position and size] button opens the Set items position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. With the Item ID you can create a relationship to the
other print composer items.

18.5 ナブゲーションツール

プリントコンポーザの地図ナビゲーションのためには 4個のツールが提供されています:

• ズームイン
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• ズームアウト

• 全域へズーム

• 表示のリフレッシュ (もしビューの状態が地図と食い違っている場合)

18.6 取り消しと再実行ツール

レイアウト処理中に、変更の取り消しと再実行することが可能である。これは、取り消しと再実行ツール
で行うことができます：

• 最後の変更を戻す

• 最後の変更を元に戻す

あるいは :guilabel:‘コマンドヒストリ ‘タブでマウスクリックします (figure_composer_9を参照)。

Figure 18.15: Command history in the Print Composer

18.7 基本図形と矢印の追加

プリントコンポーザキャンパスに基本図形 (楕円,四角形,三角形)と矢印を追加できます。

The Shape dialog allows to draw an ellipse, rectangle, or triangle in the print composer canvas. You can define its
outline and fill color, the outline width and a clockwise rotation.

The Arrow dialog allows to draw an arrow in the print composer canvas. You can define color, outline and arrow
width and it is possible to use a default marker and no marker and a SVG marker. For the SVG marker you can
additionally add a SVG start and end marker from a directory on your computer.

18.8 属性テーブル値の追加

ベクタ属性値のテーブルをプリントコンポーザキャンバスに追加することができます。

テーブルダイアログ
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Figure 18.16: Shape Dialog

Figure 18.17: Arrow Dialog

The Table dialog of the attribute table item tab provides following functionalities (see figure_composer_20):

Figure 18.18: Table Dialog

• The Table dialog allows to select the vector layer and columns of the attribute table. Attribute columns can
be sorted and you can define to show its values ascending or descending.

• 最大表示行数を指定することができます。また現在のコンポーザキャンパスに表示されている地物の
属性のみを表示するように指定できます。

• さらにテーブルとヘッダと内容のフォントのようなグリッドの性質を指定することができます。

一般情報オプションダイアログ

The General options dialog of the attribute table item tab provides following functionalities (see fig-
ure_composer_21):

• Here you can define color and outline width for the element frame, set a background color and opacity
for the table. The [Position and size] button opens the Set item position dialog and allows to set the map
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Figure 18.19: General Options Dialog

canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. Use the Item ID to create a relationship to the other print
composeritems.

18.9 エレメントの前面移動,背面移動、整列

エレメントの前面移動または背面移動機能は :sup:‘選択したアイテムを上へ ‘プルダウンメニューの中
にあります。プリントコンポーザキャンバス内のエレメントを選択して、選択したエレメントと他のエレメ
ントの位置関係を比較して前面移動または背面移動の機能を選択してください ( table_composer_1を参照)。

There are several alignment functionalities available within the Align selected items pulldown menu (see ta-
ble_composer_1). To use an alignment functionality , you first select some elements and then click on the matching
alignment icon. All selected will then be aligned within to their common bounding box.

18.10 出力の作成

Figure_composer_22 shows the print composer with an example print layout including each type of map element
described in the sections above.

Figure 18.20: Print Composer with map view, legend, scalebar, coordinates and text added
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プリントコンポーザでは多彩な種類の出力形式を利用でき、それぞれの解像度（印刷品質）と紙のサイズ
を指定できます:

• 印刷 アイコンを使うと接続されたプリンタかインストールされているプリンタドライバに依存し
た Postscriptファイルを出力し、レイアウトを印刷することができます。

• The Export as image icon exports the composer canvas in several image formats such as PNG, BPM, TIF,
JPG,...

• :sup:‘PDFとして出力 ‘では定義されているプリントコンポーザを PDFに直接出力します。

• :sup:‘SVGとして出力 ‘アイコンを使うとプリントコンポーザキャンバスを SVG (Scalable Vector
Graphic)として保存できます。

ノート: 現状の SVG出力は基本的機能しか実装していません。これは QGISの問題ではなく,Qtライブラ
リが内包する問題です。この問題が将来のバージョンで整うことを期待しています。

18.11 プリントコンポーザレイアウトの保存とロード

With the Save as template and Load from template icons you can save the current state of a print composer session
as a .qpt template and load the template again in another session.

The Composer Manager button in the QGIS toolbar and in File → Composer Manager allows to add a new com-
poser template or to manage already existing templates.

Figure 18.21: The Print Composer Manager
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プラグイン

19.1 QGISプラグイン

QGISはプラグインアーキテクチャで設計されています.これによって新しい特徴や機能をアプリケーショ
ンに簡単に追加することが可能です. 実際に QGISの多くの機能はコアまたは**外部プラグイン**によっ
て実装されています.

• コアプラグインは QGIS開発チームによって保守されていて QGISのディストリビューションの一部
を構成しています.これらは C++または Pythonという 2種類の言語で書かれています. コアプラグイ
ンについての詳細な情報はセクション QGISコアプラグインの利用方法に記述されています

• **外部プラグイン**は現在のところすべて Pythonで書かれています.外部プラグインは,外部のリポ
ジトリに保存されており,各製作者によってメンテナンスされています.外部プラグインは,プラグイ
ンインストーラーで QGISに追加することができます. 外部プラグインについての詳細は, :ref:‘外部
プラグインの読み込み ‘セクションを参照してください.

19.1.1 プラグインの管理

プラグインの管理とは:guilabel:プラグインマネージャ‘を使ってプラグインを読み込んだり削除したりする
ことです.外部プラグインは Pythonプラグインインストーラを使ってインストールして有効化でき,またア
ンインストールできます.外部プラグインを無効化したり再度有効化するためには:guilabel:‘プラグインマ
ネージャを再度利用します.

QGISコアプラグインをロードする

QGISコアプラグインはメインメニューの:menuselection:‘プラグイン –>プラグインの管理 ‘を起動すると
読み込むことができます.

The Plugin Manager lists all the available plugins and their status (loaded or unloaded), including all core plugins
and all external plugins that have been installed and automatically activated using the Python Plugin Installer (see
Section QGIS外部プラグインをロードする). Those plugins that are already loaded have a check mark to the
left of their name. Figure_plugins_1 shows the Plugin Manager dialog.

特定のプラグインを有効にするには、プラグイン名の左側にあるチェックボックスをクリックし、**[OK]**
をクリックします。アプリケーションを終了すると、ロードされたプラグインのリストが保持され、次回
QGISを実行した場合に、これらのプラグインが自動的にロードされます。

ちなみに: プラグインのクラッシュ
If you find that QGIS crashes on startup, a plugin may be at fault. You can stop all plugins from loading by editing
your stored settings file (see Options for location). Locate the plugins settings and change all the plugin values to
false to prevent them from loading.
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Figure 19.1: Plugin Manager

For example, to prevent the ‘Delimited text’ plugin from loading, the entry in
$HOME/.config/QuantumGIS/qgis.conf on Linux should look like this: Add Delimited Text
Layer=false.

Do this for each plugin in the [Plugins] section. You can then start QGIS and add the plugins one at a time from
the Plugin Manager to determine which plugin is causing the problem.

QGIS外部プラグインをロードする

External QGIS plugins are written in Python. They are by default stored in either the ‘Official’ QGIS Repository,
or in various other external repositories maintained by individual authors. The ‘Official’ QGIS Repository is added
by default in Python Plugin installer.

Detailed documentation about the usage, minimum QGIS version, homepage, authors, and other important in-
formation are provided for the ‘Official’ QGIS Repository at http://plugins.qgis.org/plugins/. For other external
repositories, they might be available with the external plugins themselves. In general it is not included in this
manual.

ノート: Updates of core python plugins may be available in this repository as external overlays.

ノート: fTools、 Mapserver Export、プラグインインストーラは Python プラグインであるが、それらは
QGISのソースの一部であり、自動的にロードされ QGISプラグインマネージャ内で有効です (QGIS外部
プラグインをロードするのセクションを参照すること)。

Currently there are over 150 external plugins available from the ‘Official’ QGIS Repository. Some of these plugins
offer functionality that will be required by many users (for example: providing the user with the ability to view and
edit OpenStreetMap data, or to add GoogleMap layers) while others offer very specialized functions (for example:
Calculate economic pipe diameters for water supply networks).

しかしながら、提供されたキーワードや名前のリポジトリかつ/またはプラグインの状態（現在システム
にインストールされているいない）でフィルタリングすることを用いて、すべての利用可能なプラグイ
ンから検索するのは容易なことです。検索とフィルタリングは QGIS Python プラグインインストーラー
（ figure_plugins_2を参照）から行います。
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ちなみに: リポジトリを追加する
To add external author repositories, open the Plugin Installer (Plugins → Fetch Python Plugins), go to the tab
Repositories, and click [Add]. If you do not want one or more of the added repositories, they can be disabled via
the [Edit...] button, or completely removed with the [Delete] button.

QGISに外部プラグインを組み入れるために必要な唯一のステップがあります：

• guilabel:Pythonプラグインインストーラー（ ref:‘python_plugin_installer‘を参照)を使用してリポジト
リから外部プラグインをダウンロードします。新しい外部プラグインは guilabel:‘プラグインマネー
ジャ‘の利用可能なプラグインのリストに追加され、自動的にロードされます。

QGIS Pythonプラグインインストーラの利用

In order to download and install an external Python plugin, go to Plugins → Fetch Python Plugins. The Plugin
Installer window will appear (figure_plugins_2) with the tab Plugins, containing a list of all locally installed
Python plugins, as well as plugin available in remote repositories.

Figure 19.2: Installing external python plugins

各プラグインはいずれかです：

• 未インストール -これはリポジトリに利用可能なプラグインがあるが、まだインストールされていない
ことを意味します。それをインストールするにはリストからプラグインを選択して**[Install plugin]**
ボタンをクリックします。

• new - これは、リポジトリにそのプラグインが新しく利用可能なものとして存在することを意味し
ます。

• インストール済 -これはそのプラグインがすでにインストールされていることを示します。任意のリ
ポジトリでも利用可能な場合**[プラグインの再インストール]**ボタンが有効になります。利用可能
なバージョンがインストールされたもののバージョンよりも古い場合、**[プラグインのダウングレー
ド]**ボタンが代わりに表示されます。

• アップグレード可 -これはプラグインがインストールされているが、利用可能な最新のバージョンが
ないことを意味します。この場合**[プラグインのアップグレード]**と**[すべてアップグレード]**
ボタンが使えます。

• 無効 -これはプラグインがインストールされているが、利用できないか壊れていることを示す。その
理由はプラグインの説明フィールドで説明されるでしょう。

プラグインタブ

プラグインをインストールするには,リストで選択をした後に**[プラグインをインストール]**ボタンをク
リックして下さい.選択したプラグインが有効になり,各 OS毎に定められたディレクトリにインストール
されます.
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• Linux and other unices

– /share/qgis/python/plugins

– $HOME/.qgis/python/plugins

• Mac OS X

– /Contents/MacOS/share/qgis/python/plugins

– /Users/$USERNAME/.qgis/python/plugins

• Windows

– C:\Program Files\QGIS\python\plugins

– C:\Documents and Settings\$USERNAME\.qgis\python\plugins

インストールが成功した場合,確認メッセージが表示されます

If the installation fails, the reason for the failure will be displayed in a warning dialog. Most often, errors are the
result of connection problems and/or missing Python modules. In the former case you will likely need to wait
before trying the install again, in the latter case, you should install the missing modules relevant to your operating
system prior to using the plugin. For Linux, most required modules should be available via a package manager.
For install instructions in Windows visit the module home page.

If you are using a proxy, you may need to configure it under Edit → Options (Gnome, OSX) or Settings → Options
(KDE, Windows)‘ on the Proxy tab.

**[プラグインのアンインストール]**ボタンは,選択されているプラグインがインストールされていてコア
プラグインではない場合に利用可能です. ただし,コアプラグインをアップデートしている場合, **[プラグ
インのアンインストール]**で,アップデートしたプラグインをQGISのリリース時のバージョンに戻すこと
ができます. QGISのリリース時のバージョンである場合,コアプラグインはアンインストールできません.

リポジトリタブ

The second tab Repositories, contains a list of plugin repositories available for the Plugin Installer. By default,
only the QGIS Official Repository is enabled. You can add several user-contributed repositories, including the
central QGIS Contributed Repository and other external repositories by clicking the [Add ...] button. The added
repositories contain a large number of useful plugins which are not maintained by the QGIS Development Team.
As such, we cannot take any responsibility for them. You can also manage the repository list manually, that is
add, remove, and edit the entries. Temporarily disabling a particular repository is possible by clicking the [Edit
...] button.

オプションタブ

Optionsタブでは、 :guilabel:‘プラグインインストーラ ‘の設定を行うことができます。 :guilabel:‘起動時
にアップデートをチェックする ‘のチェックで、QGISはプラグインの更新とニュースを自動的に探します。
デフォルドでは、この昨日はすべてのリポジトリリストで有効であり、 :guilabel:‘リポジトリ ‘タブではアッ
プデートをチェックするたびにプログラムが起動します。更新チェックの頻度は、ドロップダウンメニュー
を使用して調整することができ、1日に１回から１日に１回まで調節できます新しいプラグインや更新分
はインストールプラグインんの１つとして利用可能であり、ステータスバーに通知が表示されます。その
チェックボックスが無効の場合、更新とニュースの探知は:guilabel:‘プラグインインストーラ ‘で手動で行っ
た場合のみ実行されます。

プラグインインストーラは 80とは異なるポートを扱うことができますが、自動的に更新をチェックするの
を試みた場合に、インターネットの接続で問題を行う場合があります。これらの場合、*新しいプラグイン
を探す...*インジケーターが全体の QGISセッション中にステータスバーで表示されたままになり、終了時
にプログラムがクラッシュを引き起こす可能性があります。この場合、チェックボックスを無効にしてくだ
さい。

それに加えて、 :guilabel:‘Pythonプラグインインストーラ ‘によって表示されるプラグインのタイプを指定
することができます。*許可されたプラグイン*では、あなたが表示したいプラグインを指定できます。

• Only show plugins from the official repository

• Show all plugins except those marked as experimental
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• Show all plugins, even those marked as experimental

ちなみに: 実験的なプラグインの使用
実験的なプラグインは、制作での利用には一般的に不適当である。これらのプラグインは開発の初期段階
にあり’不完全’または ’コンセプトの証明 ’のツールであることを考慮されなければならない。テスト目
的のためにそれらを使用する場合を除き、QGISの開発チームはこれらのプラグインをインストールするこ
とをお勧めしません。

19.1.2 データプロバイダ

Data Providers are ‘special’ plugins that provides access to a data store. By default, QGIS supports PostGIS layers
and disk-based data stores supported by the GDAL/OGR library. A Data Provider plugin extends the ability of
QGIS to use other data sources.

データプロバイダプラグインは起動時に QGISによって自動的に登録されています。これらは、プラグイ
ンマネージャで管理されておらず、QGISでデータタイプがレイヤとして追加される背景で使われます。
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19.2 QGISコアプラグインの利用方法

アイ
コン

プラグイン 説明 マニュアルの参照

デリミトッドテキスト
レイヤの追加

Loads text files containing x,y
coordinates デリミテッドテキストプラ

グイン

座標取得 マウスで指定した位置の座標を、異
なる CRSで取得します 座標取得プラグイン

DB Manager Manage your databases within QGIS
DB Managerプラグイン

Diagram Overlay Add Diagrams for vectors
Diagram Overlay Plugin

DXF2Shapeコンバー
タ

DXFファイルを Shapefileに変換しま
す Dxf2Shpコンバータープラ

グイン

eVis イベント可視化ツール
eVisプラグイン

fToolsプラグイン A suite of vector tools
fToolsプラグイン

GPSツール GPSデータをロードやインポートす
るツール GPSプラグイン

GRASS GRASS functionality
GRASS GISの統合

GDALツール GDAL raster functionality
GDALツールズプラグイン

ジオレファレンサ
GDAL

Georeference Raster with GDAL
ジオレファレンサプラグイ
ン

Heatmap Create heatmap raster from input vector
points ヒートマッププラグイン

補間プラグイン ベクタレイヤの頂点を利用して補間
を行います データ補間プラグイン

MapServer出力プラグ
イン

Export a QGIS project file to a
MapServer map file MapServer Exportプラグイ

ン

オフライン編集 オフラインでの編集とデータベース
との同期 オフライン編集プラグイン

OpenStreetMap Access OpenStreetMap
オープンストリートマップ

Oracle Spatial
Georaster

Oracle Spatial GeoRaster　へのアク
セス Oracle GeoRasterプラグイ

ン

プラグインインストー
ラ

Pythonプラグインのダウンロードと
インストール QGIS Pythonプラグインイ

ンストーラの利用

Raster Terrain Analysis Compute geomorphological features
from DEMs Raster Terrain Analysis

Plugin
道路グラグプラグイン Shortest path analysis

道路グラフプラグイン

SPIT Shapefile to PostGIS Import Tool
Importing Data into
PostgreSQL

SQL Anywhereプラグ
イン

Access SQL anywhere DB
SQL Anywhereプラグイン

空間クエリ Spatial queries on vectors
空間検索プラグイン

Zonal Statistics Calculate raster statistics for vector
polygons 地域統計プラグイン
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19.3 座標取得プラグイン

座標入力プラグインは使いやすく、選択した 2つの座標参照系（CRS）について地図上のキャンバスに座
標を表示する機能を提供します。

Figure 19.3: Coordinate Capture Plugin

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, OSX) menu

and click on the Projection tab. As an alternative you can also click on the CRS status icon in the lower
right-hand corner of the statusbar.

2. オンザフライ CRS変換を有効にする ‘チェックボックスをクリックし、プロジェクトの座標系を
選択します (:ref:‘label_projectionsも参照すること)。

3. Load the coordinate capture plugin in the Plugin Manager (see QGISコアプラグインをロードする) and

ensure that the dialog is visible by going to View → Panels and ensuring that Coordinate Capture is
enabled. The coordinate capture dialog appears as shown in Figure figure_coordinate_capture_1.

4. Click on the Click to the select the CRS to use for coordinate display icon and select a different CRS from the one you
selected above.

5. 座標入力を開始するには**[入力開始]**をクリックします。それからマップキャンバス上の任意の場
所をクリックすると、プラグインは、あなたの選択した CRSの両方の座標を表示します。

6. マウスの座標追跡を可能にするには、 :sup:‘マウストラッキング ‘アイコンをクリックします。

7. 選択した座標をクリップボードにコピーすることができます。

19.4 DB Managerプラグイン

The DB Manager Plugin is officially part of QGIS core and intends to replace the SPIT Plugin and the PostGIS
Manager Plugin and additionally to integrate all other database formats supported by QGIS in one user interface.

The DB Manager Plugin provides several features. You can drag layers from the QGIS Browser into the DB
Manager and it will import your layer into your spatial database. You can drag and drop tables between spatial
databases and they will get imported. You can also use the DB Manager to execute SQL queries against your
spatial database and then view the spatial output for queries by adding the results to QGIS as a query layer.

The Database menu allows to connect to an existing database, to start the SQL-window and to exit the DB Manager
Plugin. The Schema menu includes tools to create and delete (empty) schemas and, if topology is available (e.g.
PostGIS 2) to start a TopoViewer. The menu Table allows to create and edit tables and to delete tables and views. It
is also possible to empty tables and to move tables from one to another schema. Finally you can also run Vacuum
Analyze and add Versioning Support to a table.

The Tree window lists all existing databases supported by QGIS. With a double-click you can connect to the
database. With the right-mouse button you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.
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Figure 19.4: DB Manager dialog (KDE)

If connected to a database, the main window of the DB Manager offers three tabs. The Info tab provides informa-
tion about the table and its geometry as well as about existing Fields, Constraints and Indexes. It also allows to
run Vacuum Analyze and to create a spatial index on a selected table, if not already done. The Table tab shows all
attributes and the Preview tab renders the geometries as preview.

19.5 デリミテッドテキストプラグイン

デリミテッドテキストプラグインはデリミテッドテキストをQGISのレイヤとして読み込むことができます

19.5.1 Requirements

デリミテッドテキストファイルをレイヤとして表示するためには,テキストファイルが以下の要件を満たす
必要があります:

1. 区切り文字で区切られたフィールド名のヘッダ.ヘッダはテキストファイルの先頭行にあることが必
要です

2. ヘッダ行には X座標と Y座標のフィールドが必要です.フィールド名は任意でかまいません

3. x座標と y座標は数値である必要があります.座標系は重要ではありません.

:file:‘elevp.csv‘は標高ポイントデータをインポートする正しい型式のデリミテッドテキストファイルの例で
す。elevp.csvは QGISサンプルデータセットに付属しています。 (:ref:‘サンプルデータ ‘参照):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

このサンプルテキストファイルについての解説:

1. The example text file uses ; (semicolon) as delimiter. Any character can be used to delimit the fields.

2. The first row is the header row. It contains the fields X, Y and ELEV.

3. No quotes (") are used to delimit text fields.

4. The x coordinates are contained in the X field.

5. The y coordinates are contained in the Y field.
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19.5.2 Using the Plugin

このプラグインを利用するためには,まずセクション:ref:‘プラグインの管理 ‘に記述されているようにプラ
グインを有効にして下さい

Click the new toolbar icon Add Delimited Text Layer to open the Delimited Text dialog as shown in fig-
ure_delimited_text_1.

Figure 19.5: Delimited Text Dialog

First select the file (e.g., qgis_sample_data/csv/elevp.csv) to import by clicking on the [Browse]
button. Once the file is selected, the plugin attempts to parse the file using the last used delimiter, in this case a
semicolon (;). To properly parse the file, it is important to select the correct delimiter. To change the delimiter to
tab use \t (this is a regular expression for the tab character).

Once the file is parsed, choose the X and Y fields from the dropdown lists and if available also the WKT field for
the CRS information. Finally enter a Layer name (e.g., elevp ) as shown in figure_delimited_text_1 . To add the
layer to the map, click [OK]. The delimited text file now behaves as any other map layer in QGIS.

19.6 Diagram Overlay Plugin

The Diagram Overlay Plugin allows you to add a graphic overlay to a vector layer (see figure_overlay_1). It
provides additional and not yet implemented features to the Diagrams tab, described in secion Diagrams Tab.

Before starting, the Diagram Overlay Plugin needs to be activated using the Plugin Manager (see Section QGIS
コアプラグインをロードする). It will then appear as Overlay tab in the Layer Properties dialog next to the
Diagrams tab.

The Overlay tab provides support for Pie charts, Bar charts and proportional SVG symbols.
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Figure 19.6: Vector properties dialog with overlay tab

Similar to the Diagrams tab, we will demonstrate an example and overlay the alaska boundary layer a piechart
diagram showing some temperature data from a climate vector layer. Both vector layers are part of the QGIS
sample dataset (see Sectionサンプルデータ).

1. First click on the Load Vector icon, browse to the QGIS sample dataset folder and load the two vector
shape layers alaska.shp and climate.shp.

2. Double click the climate layer in the map legend to open the Layer Properties dialog.

3. Click on the Overlay tab, activate Display diagrams and select ‘Pie Chart’ from Diagram type
combobox.

4. We want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN. First select
T_F_JAN as Attributes and click the [Add] button, then T_F_JUL and finally T_F_MEAN.

5. Diagram size is based on linear scaling of a classification attribute. We choose T_F_JUL, click on [Find

maximum value] and set size to 20 and Size unit to ‘Millimeter’.

6. Now click [Apply] to display the diagram in the QGIS main window.

7. You can now adapt the chart size, or change the attribute colors double clicking on the color values in the
attribute field. Figure_overlay_2 gives an impression.

8. Finally click [Ok].

Additionally in the Settings → Options dialog, there is a Overlay tab where it is possible to select the placement
algorithm of the diagrams. The ‘Central point’ method is a generic one, the others use algorithms of the PAL
library. They also consider diagram objects and labels in different layers.

19.7 Dxf2Shpコンバータープラグイン

コンバータープラグインはベクタデータを DXFから Shapefile形式に変換します。変換を実行する際に以
下のパラメータが要求されます:

• 入力 DXFファイル: 変換を行う DXFファイルのパスを入力して下さい

• 出力 Shp file: 作成される Shapefileの名前を入力して下さい
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Figure 19.7: Pie chart diagram from temperature data overlayed on a map

Figure 19.8: Dxf2Shape Converter Plugin
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• 出力ファイルタイプ: 出力 Shapefileのジオメトリタイプを指定して下さい。現在サポートされている
タイプはポリライン、ポリゴンとポイントです。

• テキストラベルをエクスポートする: このチェックボックスが有効な場合、追加で Shapefileのポイン
トレイヤが作成されます。 そして関連の dbfテーブルには”TEXT”フィールドに関する情報が含ま
れ、テキスト文字列そのものもファイルの中にできます。

19.7.1 Using the Plugin

1. QGISを起動して, ([プラグイン]メニューにある)[プラグインの管理]で Dxf2Shapeを有効にして下
さい (セクション QGISコアプラグインをロードする 参照)。そして QGISツールバーメニューにあ

る :sup:‘Dxf2Shape Converter‘アイコンをクリックして下さい。 Dxfインポーターダイアログが
Figure_dxf2shape_1のように表示されます。

2. DXFファイル、出力ファイルの名前、Shapefileのタイプを入力して下さい。

3. レイヤのラベル表示のためのポイントレイヤを追加で作成する場合は、 :guilabel:‘テキストラベ
ルの出力 ‘チェックボックスを有効にして下さい。

4. **[OK]**をクリックします。

19.8 eVisプラグイン

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) (this section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0)
User’s Guide. American Museum of Natural History, Center for Biodiversity and Conservation. Available from
http://biodiversityinformatics.amnh.org/, and released under the GNU FDL.) has developed the Event Visualiza-
tion Tool (eVis), another software tool to add to the suite of conservation monitoring and decision support tools for
guiding protected area and landscape planning. This plugin enables users to easily link geocoded (i.e., referenced
with latitude and longitude or X and Y coordinates) photographs, and other supporting documents, to vector data
in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (Seeプラグインの管理).

The eVis plugin is made up of three modules: the ‘Database Connection tool’, ‘Event ID tool’, and the ‘Event
Browser’. These work together to allow viewing of geocoded photographs and other documents that are linked to
features stored in vector files, databases, or spreadsheets.

19.8.1 Event Browser

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Launch the Event Browser module

To launch the Event browser module either click on the eVis Event Browser icon or click on Database → eVis →
eVis Event Browser. This will open the Generic Event Browser window.

The Generic Event Browser window has three tabs displayed at the top of the window. The Display tab is used
to view the photograph and its associated attribute data. The Options tab provides a number of settings that can
be adjusted to control the behavior of the eVis plugin. Lastly, the Configure External Applications tab is used to
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maintain a table of file extensions and their associated application to allow eVis to display documents other than
images.

Understanding the Display window

To see the Display window click on the Display tab in the Generic Event Browser window. The Display window
is used to view geocoded photographs and their associated attribute data.

Figure 19.9: The eVis display window

1. Display window: A window where the photograph will appear.

2. Zoom in button: Zoom in to see more detail. If the entire image cannot be displayed in the display window,
scroll bars will appear on the left and bottom sides of the window to allow you to pan around the image.

3. Zoom out button: Zoom out to see more area.

4. Zoom to full extent button: Displays the full extent of the photograph.

5. Attribute information window: All of the attribute information for the point associated with the photo-
graph being viewed is displayed here. If the file type being referenced in the displayed record is not an
image but is of a file type defined in the Configure External Applications tab then when you double-click
on the value of the field containing the path to the file the application to open the file will be launched to
view or hear the contents of the file. If the file extension is recognized the attribute data will be displayed in
green.

6. Navigation buttons: Use the Previous and Next buttons to load the previous or next feature when more
than one feature is selected.

7. Feature indicator: This heading indicates which feature is being displayed and how many features are
available for display.

Understanding the Options window

1. File path: A dropdown list to specify the attribute field that contains the directory path or URL for the
photographs or other documents being displayed. If the location is a relative path then the checkbox must
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Figure 19.10: The eVis Options window

be clicked. The base path for a relative path can be entered in the Base Path text box below. Information
about the different options for specifying the file location are noted in the section Specifying the location
and name of a photograph below.

2. Compass bearing display field: A dropdown list to specify the attribute field that contains the compass
bearing associated with the photograph being displayed. If compass bearing information is available it is
necessary to click the checkbox to the left of the dropdown menu title.

3. Compass offset setting: Compass offsets can be used to compensate for declination (adjust bearings col-
lected using magnetic bearings to true north bearings). Click the Manual radiobutton to enter the offset
in the text box or click the From Attribute radiobutton to select the attribute field containing the offsets.
For both of these options east declinations should be entered using positive values and west declinations
should use negative values.

4. Directory base path: The base path onto which the relative path defined in Figure_eVis_2 (A) will be
appended.

5. Replace path: If this checkbox is checked, only the file name from the A will be appended to the Base Path.

6. Apply rule to all documents: If checked, the same path rules that are defined for photographs will be used
for non-image documents such as movies, text documents, and sound files. If not checked the path rules
will only apply to photographs and other documents will ignore the Base Path parameter.

7. Save settings: If the checkbox is checked the values for the associated parameters will be saved for the next
session when the window is closed or when the [Save] button below is pressed.

8. Reset values: Resets the values on this line to the default setting.

9. Restore faults: This will reset all of the fields to their default settings. It has the same effect as clicking all
of the [Reset] buttons.

10. Save: This will save the settings without closing the Options pane.
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Figure 19.11: The eVis External Applications window

Understanding the Configure External Applications window

1. File reference table: A table containing file types that can be opened using eVis. Each file type needs a
file extension and the path to an application that can open that type of file. This provides the capability of
opening a broad range of files such as movies, sound recordings, and text documents instead of only images.

2. Add new file type: Add a new file type with a unique extension and the path for the application that can
open the file.

3. Delete current row: Delete the file type highlighted in the table and defined by a file extension and a path
to an associated application.

19.8.2 Specifying the location and name of a photograph

The location and name of the photograph can be stored using an absolute or relative path or a URL if the pho-
tograph is available on a web server. Examples of the different approaches are listed in Table evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinform.org/testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.test.com/attach.php?attachment_id-12 76

19.8.3 Specifying the location and name of other supporting documents

Supporting documents such as text documents, videos, and sound clips can also be displayed or played by eVis.
To do this it is necessary to add an entry in the file reference table that can be accessed from the Configure External
Applications window in the Generic Event Browser that matches the file extension to an application that can be
used to open the file. It is also necessary to have the path or URL to the file in the attribute table for the vector
layer. One additional rule that can be used for URLs that don’t contain a file extension for the document you want
to open is to specify the file extension before the URL. The format is — file extension:URL. The URL
is preceded by the file extension and a colon, and is particularly useful for accessing documents from Wikis and
other web sites that use a database to manage the web pages (see Table evis_examples).

19.8.4 Using the Generic Event Browser

When the Event Browser window opens a photograph will appear in the display window if the document refer-
enced in the vector file attribute table is an image and if the file location information in the Options window is
properly set. If a photograph is expected and it does not appear it will be necessary to adjust the parameters in the
Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is referenced in the
attribute table the field containing the file path will be highlighted in green in the attribute information window if
that file extension is defined in the file reference table located in the Configure External Applications window. To
open the document double-click on the green-highlighted line in the attribute information window. If a supporting
document is referenced in the attribute information window and the file path is not highlighted in green then it
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will be necessary to add an entry for the file’s filename extension in the Configure External Applications window.
If the file path is highlighted in green but does not open when double-clicked it will be necessary to adjust the
parameters in the Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window a red asterisk will be displayed on top of the vector
feature that is associated with the photograph being displayed. If a compass bearing is provided then an arrow
will appear pointing in the direction indicated by the value in the compass bearing display field in the Generic
Event Browser window. The arrow will be centered over the point that is associated with the photograph or other
document.

To close the Generic Event Browser window click on the [Close] button from the Display window.

19.8.5 Event ID Tool

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name
of the file containing the photograph and optionally the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Launch the Event ID module

To launch the ‘Event ID’ module either click on the Event ID icon or click on Plugins → eVis → Event ID Tool.
This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Generic
Event Browser window is opened and the photographs on or near the clicked locality are available for display
in the browser. If more than one photograph is available, you can cycle through the different features using the
[Previous] and [Next] buttons. The other controls are described in the ref:evis_browser section of this guide.

19.8.6 Database connection

The ‘Database Connection’ module provides tools to connect to and query a database or other ODBC resource,
such as a spreadsheet.

eVis can directly connect to four types of databases: Microsoft Access, PostgreSQL, MySQL, SQLite, and can
also read from ODBC connections. When reading from an ODBC database (such as an Excel spreadsheet) it is
necessary to configure your ODBC driver for the operating system you are using.

Launch the Database Connection module

To launch the ‘Database Connection’ module either click on the appropriate icon eVis Database Connection or click
on Plugins → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Connect to a database

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combobox to select the type of database that you want to connect to. If a password or username is
required, that information can be entered in the Username and Password textboxes.

Enter the database host in the Database Host textbox. This option is not available if you selected “MS Access” as
the database type. If the database resides on your desktop you should enter “localhost”.
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Enter the name of the database in the Database Name textbox. If you selected “ODBC” as the database type, you
need to enter the data source name.

When all of the parameters are filled in, click on the [Connect] button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established you will need to check that the correct parameters were entered above.

Figure 19.12: The eVis Database connection window

1. Database Type: A dropdown list to specify the type of database that will be used.

2. Database Host: The name of the database host.

3. Port The port number if a MySQL or PostgreSQL database type is selected.

4. Database Name The name of the database.

5. Connect A button to connect to the database using the parameters defined above.

6. Output Console The console window where messages related to processing are displayed.

7. Username: Username for use when a database is password protected.

8. Password: Password for use when a database is password protected.

9. Predefined Queries: Tab to open the “Predefined Queries” window.

10. Database Connection: Tab to open the “Database Connection” window.

11. SQL Query: Tab to open the “SQL Query” window.

12. Help: Displays the on line help.

13. OK: Close the main “Database Connection” window.
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Running SQL queries

SQL queries are used to extract information from a database or ODBC resource. In eVis the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Click on the [Run Query] button to execute the command. If the query is successful a Database File Selection
window will be displayed. If the query is not successful an error message will appear in the Output Console
window.

In the Database File Selection window, enter the name of the layer that will be created from the results of the
query in the Name of New Layer textbox.

Figure 19.13: The eVis SQL query tab

1. SQL Query Text Window: A screen to type SQL queries.

2. Run Query: Button to execute the query entered in the SQL Query Window.

3. Console Window: The console window where messages related to processing are displayed.

4. Help: Displays the on line help.

5. OK: Closes the main Database Connection window.

Use the X Coordinate and Y Coordinate comboboxes to select the field from the database that
store the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

ちなみに: Creating a vector layer from a Microsoft Excel Worksheet
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When creating a vector layer from a Microsoft Excel Worksheet you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data.This can be caused by deleting the values for these cells
in Excel using the Backspace key. To correct this problem you need to open the Excel file (you’ll need to close
QGIS if there if you are connected to the file to allow you to edit the file) and then use Edit → Delete to remove
the blank rows from the file. To avoid this problem you can simply delete several rows in the Excel Worksheet
using Edit → Delete before saving the file.

Running predefined queries

With predefined queries you can select previously written queries stored in XML format in a file. This is partic-
ularly helpful if you are not familiar with SQL commands. Click on the Predefined Queries tab to display the
predefined query interface.

To load a set of predefined queries click on the Open File icon. This opens the Open File window which is used
to locate the file containing the SQL queries. When the queries are loaded their titles, as defined in the XML
file, will appear in the dropdown menu located just below the Open File icon, the full description of the query is
displayed in the text window under the dropdown menu.

Select the query you want to run from the dropdown menu and then click on the SQL Query tab to see that the
query has been loaded into the query window. If it is the first time you are running a predefined query or are
switching databases, you need to be sure to connect to the database.

Click on the [Run Query] button in the SQL Query tab to execute the command. If the query is successful a
Database File Selection window will be displayed. If the query is not successful an error message will appear in
the Output Console window.

Figure 19.14: The eVis Predefined queries tab

1. Open Query File: Launches the “Open File” file browser to search for the XML file holding the predefined
queries.

2. Predefined Queries: A dropdown list with all of the queries defined by the predefined queries XML file.
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3. Query description: A short description of the query. This description is from the predefined queries XML
file.

4. Console Window: The console window where messages related to processing are displayed.

5. Help: Displays the on line help.

6. OK: Closes the main “Database Connection” window.

XML format for eVis predefined queries

The XML tags read by eVis

Tag Description
query Defines the beginning and end of a query statement.
shortde-
scription

A short description of the query that appears in the eVis dropdown menu.

descrip-
tion

A more detailed description of the query displayed in the Predefined Query text window.

database-
type

The database type as defined in the Database Type dropdown menu in the Database Connection
tab.

database-
port

The port as defined in the Port textbox in the Database Connection tab.

database-
name

The database name as defined in the Database Name textbox in the Database Connection tab.

databaseuser-
name

The database username as defined in the Username textbox in the Database Connection tab.

databasep-
assword

The database password as defined in the Password textbox in the Database Connection tab.

sqlstate-
ment

The SQL command.

autocon-
nect

A flag (“true”” or “false”) to specify if the above tags should be used to automatically connect to
database without running the database connection routine in the Database Connection tab.

A complete sample XML file with three queries is displayed below:

<?xml version="1.0"?>
<doc>
<query>

<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
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<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

19.9 fToolsプラグイン

fToolプラグインの目的は、追加のソフトウェアやライブラリ、複雑な手順を必要とせず、ベクタデータに
関する多くの解析や調査、演算を処理することです. そのために必要な、一連の地理空間データの解析や調
査機能を提供しています.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be
disabled and enabled using the Plugin Manager (See Section QGISコアプラグインをロードする). When enabled,
the fTools plugin adds a Vector menu to QGIS, providing functions ranging from Analysis and Research Tools to
Geometry and Geoprocessing Tools, as well as several useful Data Management Tools.
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19.9.1 Analysis tools

アイ
コン

ツール 目的

距離マト
リックス

2つの点レイヤ間の距離を計測し、a)距離行列、b)線形距離行列、c)距離統計行
列といった出力が可能です。また、最近傍点（k）の点群のみに限定して計測する
ことも可能です。

線長の合
計

ポリゴンベクタレイヤの各ラインについて、線長の合計値を計算することができ
ます。

ポリゴン
内の点

ベクタレイアに含まれる点の数をカウントすることができます。

ユニーク
値のリス
ト

ベクタレイア中のユニーク値のリストを抽出することができます。

基本統計 ベクタレイアの基本的な統計値 (平均値,標準偏差,分散,総数,総計,中央値等)

最小近傍
分析

ポイントベクタレイヤにおいて、最小近傍分析を行います。

平均座標
(群)

ベクタレイヤ全体またはユニーク IDをもつ複数の地物について、平均座標あるい
は重み付き平均座標の計算を行います。

ラインの
交差

ラインとラインの交差を特定し,ポイントとして Shapefile型式で出力します。道
路や軌跡の交差の特定に利用できます.線長が 0のラインは無視されます.

Table Ftools 1: fTools解析ツール

19.9.2 Research tools

アイ
コン

ツール 目的

ランダム選択 n個の地物または n％の地物をランダムに選択します

ランダムセット
のランダム選択

ユニークな IDを持つサブセットをランダムに選択します

ランダム点群 選択レイヤの中からランダムな点群を発生させます

規則的な点群 選択レイアの中から,設定した規則的な範囲で点群を発生させ,ポイントの
Shapefileを出力します.

ベクタグリッド ユーザーが設定した領域内に,ポリゴンまたはラインのグリッドを発生さ
せ,Shapefileとして出力します

場所による選択 地物を指定した場所に基づいて選択します.指定した場所は,他のレイヤで新
しい選択を行うか,あるいは現在の選択に追加または削除が行えます

レイア領域のポ
リゴン

指定したラスタまたはベクタレイヤの領域から,新たなポリゴンを作成
し,Shapefileで出力する

Table Ftools 2: fTools調査ツール
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19.9.3 Geoprocessing tools

アイ
コン

ツー
ル

目的

凸包 選択したレイヤまたは入力された IDフィールドに基づいた凸包を作成し,Shapefileと
して出力します

バッ
ファ

バッファ距離またはバッファ距離の入ったフィールドを指定し,入力したベクタに
バッファ(群)を発生させ,Shapefileで出力します

交差 指定したベクタレイヤの交差しているポリゴン,ライン,ポイントを出力し,Shapefile
で出力します

統合 指定したベクタレイヤの交差しているポリゴン,ライン,ポイントを出力し,Shapefile
で出力します

対称
差分

指定したベクタレイヤの交差していないポリゴン,ライン,ポイントを出力し、
Shapefileで出力します

ク
リッ
プ

レイヤをオーバーレイし,クリップレイヤと重なる部分のみを Shapefileとして出力し
ます

差分 レイヤをオーバーレイさせてクリップレイヤと重ならない部分のみを Shapefileとし
て出力します

融合 Merge features based on input field. All features with identical input values are combined
to form one single feature.

Table Ftools 3: fToolsジオミトリツール

19.9.4 Geometry tools

アイ
コン

ツール 目的

ジオミトリの整合性
をチェック

ポリゴンを交差や穴のクロスをチェックし,ノードの順序を修正します

ジオミトリカラムの
出力/追加

ベクタレイヤのジオメトリ情報に点 (X座標、Y座標)、線 (長さ)また
はポリゴン (面積、周囲の長さ)を追加します

ポリゴン重心 ポリゴンから重心を計算し出力します

ドロネ－三角形分割 指定点ベクタレイヤでドロネー三角形分割を行い,結果を (ポリゴンと
して)Shapefileに出力します

ボロノイ分割 点データからボロノイポリゴンを生成します

ジオミトリを簡素化
する

Douglas-Peuckerアルゴリズムでラインまたはポリゴンを間引いて簡素
化します

Densify geometry Densify lines or polygons by adding vertices

マルチパートをシン
グルパートへ

マルチパート地物をシングルパート地物に変換します.シンプルポリゴ
ン群とライン群を作成します

シングルパートをマ
ルチパートへ

複数の地物をユニーク IDフィールドで結合し,単一のマルチパート地
物に変換します

ポリゴンをラインに ポリゴンをラインに変換します.マルチパートポリゴンは複数のシング
ルパートラインに変換します

ラインをポリゴンに ラインをポリゴンに変換します.マルチパートラインは複数のシングル
パートポリゴンに変換します

ノードの展開 ラインまたはポリゴンレイヤからポイントとしてノードを出力します
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Table Ftools 4: fToolsジオミトリツール

ノート: Simplify geometry　ツールは、ラインやポリゴンの重複ノードを削除します。単純化の許容値を
0に設定するだけでその操作を行います。

19.9.5 Data management tools

アイ
コン

ツール 目的

投影法の定義 CRSが定義されていない Shapefileの投影法を定義します

属性の結合 属性をベクタに結合し,追加します. ベクタレイヤの属性と他の属性テーブル
を結合し,Shapefileとして出力します

ベクタレイヤ
の分割

ベクタレイヤを指定したフィールドに基づいて複数の Shapefileに分割します

Merge
shapefiles to
one

Merge several shapefiles within a folder into a new shapefile based on the layer
type (point, line, area).

Create spatial
index

Create a spatial index for OGR supported formats.

Table Ftools 5: fToolsデータマネジメントツール

19.10 GDALツールズプラグイン

19.10.1 GDALツールプラグインとは？

The GDAL Tools plugin offers a GUI to the collection of tools in the Geospatial Data Abstraction Library,
http://gdal.osgeo.org . These are raster management tools to query, re-project, warp and merge a wide variety
of raster formats. Also included are tools to create a contour (vector) layer, or a shaded relief from a raster DEM,
and to make a vrt (Virtual Raster Tile in XML format) from a collection of one or more raster files. These tools
are available when the plugin is installed and activated.

GDALライブラリ

GDALライブラリはコマンドラインプログラムのセットで構成されており、それぞれがオプションの大き
なリストです。ターミナルからコマンドを実行して満足しているユーザはオプションのフルセットへのア
クセスでコマンドラインを好むかもしれません。GDALツールズプラグインは最も人気のあるオプション
のみ見えるようにし、ツールへの簡単なインターフェースを提供しています。
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Figure 19.15: The GDALTools menu list

19.10.2 List of GDAL tools

Projections

Warp
(Reproject)

This utility is an image mosaicing, reprojection and warping utility. The program can
reproject to any supported projection, and can also apply GCPs stored with the image if the
image is “raw” with control information. For more information you can read on the GDAL
website http://www.gdal.org/gdalwarp.html

Assign
projection

This tool allows to assign projection to rasters that already georeferenced but miss projection
information. Also with it help it is possible to alter existing projection definition. Both single
file and batch mode are supported. For more information please visit utility page at GDAL site
http://www.gdal.org/gdalwarp.html

Extract
projection

This utility helps you to extract projection information from an input file. If you want to
extract projection from a whole directory you can use the Batch mode. It creates both .prj
and .wld files.
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Conversion

Rasterize
This program burns vector geometries (points, lines and polygons) into the raster band(s) of a
raster image. Vectors are read from OGR supported vector formats. Note that the vector data
must in the same coordinate system as the raster data; on the fly reprojection is not provided. For
more information see http://www.gdal.org/gdal_rasterize.html

Poly-
gonize

This utility creates vector polygons for all connected regions of pixels in the raster sharing a
common pixel value. Each polygon is created with an attribute indicating the pixel value of that
polygon. The utility will create the output vector datasource if it does not already exist,
defaulting to ESRI shapefile format. See also http://www.gdal.org/gdal_polygonize.html

Translate
This utility can be used to convert raster data between different formats, potentially performing
some operations like subsettings, resampling, and rescaling pixels in the process. For more
information you can read on http://www.gdal.org/gdal_translate.html

RGB
to PCT

This utility will compute an optimal pseudo-color table for a given RGB image using a median
cut algorithm on a downsampled RGB histogram. Then it converts the image into a
pseudo-colored image using the color table. This conversion utilizes Floyd-Steinberg dithering
(error diffusion) to maximize output image visual quality. The utility is also desribed at
http://www.gdal.org/rgb2pct.html

PCT
to RGB

This utility will convert a pseudocolor band on the input file into an output RGB file of the
desired format. For more information see http://www.gdal.org/pct2rgb.html

Extraction

Con-
tour

This program generates a vector contour file from the input raster elevation model (DEM). On
http://www.gdal.org/gdal_contour.html you can find more information.

Clip-
per

This utility allows to clip (extract subset) raster using selected extent or based on mask layer
bounds. More information can be found at http://www.gdal.org/gdal_translate.html.
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Analysis

Sieve This utility removes raster polygons smaller than a provided threshold size (in pixels) and
replaces them with the pixel value of the largest neighbor polygon. The result can be written
back to the existing raster band, or copied into a new file. For more information see
http://www.gdal.org/gdal_sieve.html .

Near
Black

This utility will scan an image and try to set all pixels that are nearly black (or nearly white)
around the edge to exactly black (or white). This is often used to “fix up” lossy compressed
aerial photos so that color pixels can be treated as transparent when mosaicing. See also
http://www.gdal.org/nearblack.html .

Fill
nodata

This utility fills selection raster regions (usually nodata areas) by interpolation from valid
pixels around the edges of the area. On http://www.gdal.org/gdal_fillnodata.html you can
find more information.

Proximity This utility generates a raster proximity map indicating the distance from the center of each
pixel to the center of the nearest pixel identified as a target pixel. Target pixels are those in
the source raster for which the raster pixel value is in the set of target pixel values. For more
information see http://www.gdal.org/gdal_proximity.html .

Grid This utility creates regular grid (raster) from the scattered data read from the OGR
datasource. Input data will be interpolated to fill grid nodes with values, you can choose from
various interpolation methods. The utility is also described on the GDAL website
http://www.gdal.org/gdal_grid.html .

DEM
terrain
models

Tools to analyze and visualize DEMs. It can create a shaded relief, a slope, an aspect, a color
relief, a Terrain Ruggedness Index, a Topographic Position Index and a roughness map from
any GDAL-supported elevation raster. For more information you can read on
http://www.gdal.org/gdaldem.html

Miscellaneous

Build
Virtual
Raster

This program builds a VRT (Virtual Dataset) that is a mosaic of the list of input gdal datasets.
See also http://www.gdal.org/gdalbuildvrt.html .

Merge This utility will automatically mosaic a set of images. All the images must be in the same
coordinate system and have a matching number of bands, but they may be overlapping, and at
different resolutions. In areas of overlap, the last image will be copied over earlier ones. The
utility is also described on http://www.gdal.org/gdal_merge.html .

Information
This utility lists various information about a GDAL supported raster dataset. On
http://www.gdal.org/gdalinfo.html you can find more information.

Build
Overviews

The gdaladdo utility can be used to build or rebuild overview images for most supported file
formats with one of several downsampling algorithms. For more information see
http://www.gdal.org/gdaladdo.html .

Tile
Index

This utility builds a shapefile with a record for each input raster file, an attribute containing
the filename, and a polygon geometry outlining the raster. See also
http://www.gdal.org/gdaltindex.html .
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19.11 ジオレファレンサプラグイン

The Georeferencer Plugin is a tool for generating world files for rasters. It allows you to reference rasters to
geographic or projected coordinate systems by creating a new GeoTiff or by adding a world file to the existing
image. The basic approach to georeferencing a raster is to locate points on the raster for which you can accurately
determine their coordinates.

Features
Icon Purpose Icon Purpose

Open raster Start georeferencing

Generate GDAL Script Load GCP Points

Save GCP Points As Transformation settings

Add Point Delete Point

Move GCP Point Pan

Zoom In Zoom Out

Zoom To Layer Zoom Last

Zoom Next Link Georeferencer to QGIS

Link QGIS to Georeferencer

Table Georeferencer 1: Georeferencer Tools

19.11.1 Usual procedure

As X and Y coordinates (DMS (dd mm ss.ss), DD (dd.dd) or projected coordinates (mmmm.mm) which corre-
spond with the selected point on the image, two alternative procedures can be used:

• The raster itself sometimes provides crosses with coordinates “written” on the image. In this case you can
enter the coordinates manually.

• Using already georeferenced layers, this can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and the projection you want to
have your image. In this case you can enter the coordinates by clicking on the reference dataset loaded in
QGIS map canvas.

The usual procedure for georeferencing an image involves selecting multiple points on the raster, specifying their
coordinates, and choosing a relevant transformation type. Based on the input parameters and data, the plugin will
compute the world file parameters. The more coordinates you provide, the better the result will be.

The first step is to start QGIS, load the Georeferencer Plugin (see Section QGISコアプラグインをロードする)

and click on the Georeferencer icon which appears in the QGIS toolbar menu. The Georeferencer Plugin dialog
appears as shown in figure_georeferencer_1.

For this example, we are using a topo sheet of South Dakota from SDGS. It can later be visualized to-
gether with the data from the GRASS spearfish60 location. You can download the topo sheet here:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Entering ground control points (GCPs)

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.
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Figure 19.16: Georeferencer Plugin Dialog

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_2). For this procedure you have three options:

• Click on a point in the raster image and enter the X and Y coordinates manually.

• Click on a point in the raster image and choose the button from map canvas to add the X and Y coordi-
nates with the help of a georeferenced map already loaded in the QGIS map canvas.

• With the button, you can move the GCPs in both windows, if they are at the wrong place.

3. Continue entering points. You should have at least 4 points, and the more coordinates you can provide, the
better the result will be. There are additional tools on the plugin dialog to zoom and pan the working area
in order to locate a relevant set of GCP points.

Figure 19.17: Add points to the raster image

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP Points and Save GCP Points buttons to manage the files.

Within the GCP table you can click on a column header and therewith enable e.g. numerical sorting. The GCP list
is automatically updated.

Defining the transformation settings

After you have added your GCPs to the raster image, you need to define the transformation settings for the
georeferencing process.
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Figure 19.18: Defining the georeferencer transformation settings

Available Transformation algorithms

Depending on how many ground control point you have captured, you may want to use different transformation
algorithms. Choice of transformation algorithm is also dependent on the type and quality of input data and the
amount of geometric distortion that you are willing to introduce to final result.

Currently, following algorithms are available:

• The Linear algorithm is used to create a world-file, and is different from the other algorithms, as it does
not actually transform the raster. This algorithm likely won’t be sufficient if you are dealing with scanned
material.

• The Helmert transformation performs simple scaling and rotation transformations.

• The Polynomial algorithms 1-3 are among the most widely used algorithms for georeferencing, and each
one differs by the degree of distortion introduced to match source and destination ground control points.
The most widely used polynomial algorithm is the second order polynomial transformation, which allows
some curvature. First order polynomial transformation (affine) preserves colliniarity and allows scaling,
translation and rotation only.

• The Thin plate spline (TPS) algorithm is a more modern georeferencing method, which is able to intro-
duce local deformations in the data. This algorithm is useful when very low quality originals are being
georeferenced.

• The Projective transformation is a linear rotation and translation of coordinates.

Define the Resampling method

The type of resampling you choose will likely depending on your input data and the ultimate objective of the
exercise. If you don’t want to change statistics of the image, you might want to choose ‘Nearest neighbour’,
whereas a ‘Cubic resampling’ will likely provide a more smoothed result.

It is prossible to choose between five different resampling methods.

1. Nearest neighbour

2. Linear

3. Cubic
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4. Cubic Spline

5. Lanczos

Define the transformation settings

There are several options that need to be defined for the georeferenced output raster.

• The checkbox Create world file is only available, if you decide to use the linear transformation type,
because this means that the raster image actually won’t be transformed. In this case, the field Output raster
is not activated, because only a new world-file will be created.

• For all other transformation type you have to define an Output raster. As default a new file ([file-
name]_modified) will be created in the same folder together with the original raster image.

• As a next step you have to define the Target SRS (Spatial Reference System) for the georeferenced raster
(see section投影法の利用方法).

• If you like, you can generate a pdf map and also a pdf report. The report includes information about the
used transformation parameters. An image of the residuals and a list with all GCPs and their RMS errors.

• Furthermore you can activate the Set Target Resolution checkbox and define pixel resolution of the
output raster. Default horizontal and vertical resolution is 1,

• The Use 0 for transparency when needed can be activated, if pixels with the value 0 shall be visualized
transparent. In our example toposheet all white areas would be transparent.

• Finally Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Show and adapt raster properties

Clicking on the Raster properties dialog in the Settings menu opens the raster properties of the layer that you want
to georeference.

Configure the georeferencer

• You can define if you want to show GCP coordiniates and/or IDs.

• As residual units pixels and map units can be chosen.

• For the PDF report a left and right margin can be defined and you can also set the paper size for the PDF
map.

• Finally you can activate to show georeferencer window docked.

Running the transformation

After all GCPs have been collected and all transformation settings are defined, just press the button
Start georeferencing to create the new georeferenced raster.

19.12 データ補間プラグイン

この補間プラグインは、ポイントベクタレイヤの TINまたは IDW補間を生成するために使用されます。こ
れは扱いがとてもシンプルで、内挿されたラスタレイヤを作成するための直感的なグラフィカルユーザ・
インタフェースを提供します ( Figure_interpolation_1を参照すること)。プラグインは、実行前に次のパラ
メータを必要とします。
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• Input vector layer: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combobox.

• 補間する属性:補間に使用する属性カラムを選択するか、格納された Z値を使用するには|checkbox|
:guilabel:‘Z座標を使用する ‘チェックを有効にします。

• Interpolation Method: Select interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’.

• カラム/行の数:出力するラスタファイルの行またはカラムの数を指定します。

• 出力ファイル: 出力するラスタファイルの名称を指定します。

Figure 19.19: Interpolation Plugin

19.12.1 Using the plugin

1. QGISを起動し、ポイントベクタレイヤ（e.g., elevp.csv）をロードします。

2. Load the Interpolation plugin in the Plugin Manager (see Section QGISコアプラグインをロードする) and

click on the Interpolation icon which appears in the QGIS toolbar menu. The Interpolation plugin dialog
appears as shown in Figure_interpolation_1.

3. 補間のための入力レイヤ (e.g., elevp )とカラム (e.g., ELEV)を選択します。

4. Select an interpolation method (e.g. ‘Triangulated Irregular Network (TIN)’), and specify a cellsize of 5000
as well as the raster output filename (e.g., elevation_tin).

5. **[OK]**をクリックします。

6. For the current example, double click elevation_tin in the layer list to open the raster Layer Properties

dialog and select ‘Pseudocolor’ as Color Map in the Symbology tab. Or you can define a new color
table as described in section Working with Raster Data.

19.13 MapServer Exportプラグイン

あなたは、レイヤを追加そして調整したり、それらをシンボライズしたり、色をカスタマイズしMapServer
としてマップファイルを作成することで、地図を ’compose ’することができます。

ノート: Currently the plugin only works when you use ‘Old Symbology’ in QGIS. ‘New Symbology’ is not yet
supported.
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19.13.1 プロジェクトファイルの作成

The MapServer Export Plugin operates on a saved QGIS project file and not on the current contents of the map
canvas and legend. This has been a source of confusion for a number of users. As described below, before you start
using the MapServer Export Plugin, you need to arrange the raster and vector layers you want to use in MapServer
and save this status in a QGIS project file.

Figure 19.20: Arrange raster and vector layers for QGIS project file

In this example, we demonstrate the four steps required to create a simple project file which can be used to create
the MapServer map file. We use raster and vector files from the QGIS sample datasetサンプルデータ.

1. Add the raster layer landcover.tif clicking on the Add Raster Layer icon.

2. Add the vector Shapefiles lakes.shp, majrivers.shp and airports.shp from the QGIS sample

dataset clicking on the Add Vector Layer icon.

3. Change the colors and symbolize the data as you like (for example see figure_mapserver_export_1)

4. Save a new project named mapserverproject.qgs using File → Save Project.

19.13.2 Creating the Map File

To use the Mapserver Export plugin from within QGIS, you need to enable the MapServer Export Plugin first
using the Plugin Manager (see QGISコアプラグインをロードする).
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Figure 19.21: Export to MapServer Dialog

Map file Enter the name for the map file to be created. You can use the button at the right to browse for
the directory where you want the map file created.

Qgis
project
file

Enter the full path to the QGIS project file (.qgs) you want to export. You can use the button at
the right to browse for the QGIS project file.

Map
Name

A name for the map. This name is prefixed to all images generated by the mapserver.

Map
Width

Width of the output image in pixels.

Map
Height

Height of the output image in pixels.

Map
Units

Units of measure used for output.

Image
type

Format for the output image generated by MapServer

Web
Template

Full path to the MapServer template file to be used with the map file

Web
Header

Full path to the MapServer header file to be used with the map file

Web
Footer

Full path to the MapServer footer file to be used with the map file

Only the inputs Map file and QGIS project file are required to create a map file, however by omitting the other
parameters, you may end up creating a non-functional map file, depending on your intended use. Although QGIS
is good at creating a map file from your project file, it may require some tweaking to get the results you want. For
this example, we will create a map file using the project file mapserverproject.qgs we just created (see
Figure_mapserver_export_2):

1. Click the MapServer Export icon in the toolbar menu to start the MapServer dialog (see Fig-
ure_mapserver_export_2).

2. Enter the name (e.g., qgisproject.map) for your new map file.

3. Browse and find the QGIS project file (e.g., mapserverproject.qgs) you previously saved.

4. Enter a name (e.g., MyMap) for the map.

5. Enter the width and height (e.g., 600 for the width and 400 for the height) for your output image.

6. For this example, the layers are in meters, so we change the units to meters.
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7. Choose png for the image type.

8. Click [OK] to generate the new map file qgisproject.map. QGIS displays the success of your efforts.

Figure 19.22: Export to MapServer Succesfull Dialog

You can view the map file in any text editor or visualizer. If you take a look, you’ll notice that the export tool adds
the metadata needed to enable our map file for WMS.

19.13.3 Troubleshooting

If you get error messages from mapserver like:

loadSymbolSet(): Unable to access file. (./symbols/symbols.txt)

or:

msLoadFontset(): Unable to access file. Error opening fontset ./fonts/fonts.txt.

This means that that the map file is requesting for fonts or symbol definition files but that Mapserver cannot find
those.

Either comment the lines containing those names in the map file (this is possible if you do not have labels or use
styles from the symbols.txt). Or create those files (see below).

The most simple fonts.txt file (because arial is used in the QGIS generated map files) contains the following
line

# either relative to the map file or a full path:
arial /usr/share/fonts/truetype/msttcorefonts/arial.ttf

The most simple symbols.txt file contains the definition of a circle symbol (because a circle symbol is used
for point layers)

SYMBOLSET
SYMBOL
NAME "circle"
TYPE ellipse
FILLED true
POINTS
1 1
END
END

END
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19.13.4 Testing the Map File

We can now test our work.

If the map file is accessible for you mapserver cgi you can use the one of the url’s from the success dialog.

Another option is using the shp2img tool to create an image from the map file. The shp2img utility is part of
MapServer and FWTools. To create an image from our map:

• Open a terminal window

• If you didn’t save your map file in your home directory, change to the folder where you saved it.

• Run shp2img -m qgisproject.map -o mapserver\_test.png and display the image

This creates a PNG with all the layers included in the QGIS project file. In addition, the extent of the PNG will be
the same as when we saved the project. As you can see in figure_mapserver_export_4, all information except the
airport symbols are included.

Figure 19.23: Test PNG created by shp2img with all MapServer Export layers

19.13.5 Using Map File

If you plan to use the map file to serve WMS requests, you probably don’t have to tweak anything. If you plan to
use it with a mapping template or a custom interface, you may have a bit of manual work to do. To see how easy
it is to go from QGIS to serving maps on the web, take a look at Christopher Schmidt’s 5 minute flash video. He
used an older version of QGIS (version 0.8), but the demo applies equally well to newer versions.

19.14 オフライン編集プラグイン

データ収集のために、ノートパソコンやフィールドでオフラインの携帯電話で作業するのは一般的な状況
です。ネットワークへの復帰後、変更内容はマスターデータソース（e.g. a PostGISデータベース）と同期
する必要があります。複数の人が同じデータセットを同時に作業している場合、それは人々が同じ地物を
変更していない場合でも、手作業で編集内容をマージするのは困難です。

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.
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19.14.1 Using the plugin

• ベクタレイヤ（e.g. PostGIS or WFS-Tデータソース由来）を開きます。

• プロジェクトとして保存します。

• Press the Convert to offline project icon and select the layers to save. The content of the layers is saved to
SpatiaLite tables.

• オフラインでレイヤを編集します。

• After being connected again, upload the changes with the Synchronize button.

Figure 19.24: Create an offline project from PostGIS or WFS layers

19.15 Oracle GeoRasterプラグイン

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the OracleGeoRasterPlugin is supported by GDAL, and depends on Oracle’s database product
being installed and working on your machine. While Oracle is proprietary software, they provide their software
free for development and testing purposes. Here is one simple example of how to load raster images to GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

This will load the raster into the default GDAL_IMPORT table, as a column named RASTER.

19.15.1 接続の管理

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see Section QGISコアプラグ
インをロードする). The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle

database that contains the data. To do this, begin by clicking on the Select GeoRaster toolbar button, it will open
the Select Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the
connection parameters (See Figure_oracle_raster_1):

• Name: Enter a name for the database connection
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• Database instance: Enter the name of the database that you will connect to

• Username: Specify your own username that you will use to access the database

• Password: The password associated with your username that is required to access the database

Figure 19.25: Create Oracle connection dialog

Now, back on the main Oracle Spatial GeoRaster dialog window (see Figure_oracle_raster_2), use the drop-down
list to choose one connection, and use the [Connect] button to establish a connection. You may also [Edit] the
connection by opening the previous dialog and making changes to the connection information, or use the [Delete]
button to remove the connection from the drop-down list.

19.15.2 Selecting a GeoRaster

いったん接続が確立されると、サブデータセットウィンドウには GDALサブデータセット名の形式でデー
タベースに GeoRasterカラムを含むすべてのテーブルの名称が表示されます。

リストアップされたサブデータセットのいずれかをクリックし、 **[選択]**をクリックしてテーブル名を
選択します。今サブデータセットの別のリストは、そのテーブルの GeoRaster列の名称で表示されていま
す。ほとんどのユーザは同じテーブルに１つまたは２つ以上の GeoRaster列を持たないため、これはたい
てい短いリストです。

リストアップされたサブデータセットをクリックし、テーブル/列の組み合わせの１つを選択するために**[選
択]**をクリックします。ダイアログでは GeoRasterを含むすべての行を表示します。サブデータセットリ
ストは Raster Data Tableと RasterIDのペアが表示される点に注意してください。

いつでも選択エントリは既知の GeoRasterに直接移動するか、最初に戻って、別のテーブル名を選択する
ために編集することができます。

選択データエントリは、例えば ‘‘geor:scott/tiger@orcl,gdal_import,raster,geoid=‘‘のように識別文字列の末尾に
Where句を入力するために使用することができます。詳細については http://www.gdal.org/frmt_georaster.html
を参照してください。

19.15.3 GeoRasterの表示

最終的に、ラスタデータテーブルと RasterIDのリストから GeoRasterとを選択することによって、ラスタ
イメージが QGISにロードされます。

The Select Oracle Spatial GeoRaster dialog can be closed now and next time it opens it will keep the same
connection, and will show the same previous list of subdataset making it very easy to open up another image from
the same context.

ノート: ピラミッドを含む GeoRaster はより速く表示できますが、ピラミッドは Oracle PL/SQL または
gdaladdoを使用して QGISの外部から生成する必要があります。
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Figure 19.26: Select Oracle GeoRaster dialog

The following is example using gdaladdo:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 \
-r nearest 2 4 6 8 16 32

This is an example using PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

19.16 Raster Terrain Analysis Plugin

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (See Figure_raster_terrain_1).

分析の説明：

• 傾斜：各セルの傾斜角を度単位で計算する（一時導関数の推定に基づく）。

• 傾斜方位：説明（反時計回りに、北方向は 0から始まる）。

• Hillshade: Create shaded map using light and shadow to provide a more three-dimensional appearance for
a shaded relief map.

• Ruggedness Index: A quantitative measurement of terrain heterogeneity as described by Riley et al. (1999).
It is calculated for every location, by summarizing the change in elevation within the 3x3 pixel grid.

• Relief: Creating a shaded relief map from digital elevation data. Implemented is a method to choose the
elevation colors analysing the frequency distribution.
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Figure 19.27: Raster Terrain Modelling Plugin (slope calculation)

19.16.1 プラグインの利用

1. Start QGIS and load the gtopo30 raster layer from the GRASS sample location.

2. Load the Raster Terrain Analysis plugin in the Plugin Manager (see Section QGISコアプラグインをロー
ドする)

3. Select an analysis method from menu (e.g. Raster → Terrain Analysis → Slope). The Slope dialog appears
as shown in Figure_raster_terrain_1.

4. 出力ファイルパスおよび出力ファイルタイプを指定します。

5. **[OK]**をクリックします。

19.17 ヒートマッププラグイン

:sup:‘ヒートマップ ‘プラグインはポイントのベクタレイヤからヒートマップを作成することを可能と
します。ヒートマップとはポイントに関連した情報の密度や大きさを示すラスタマップです。この結果か
ら “ホットスポット”を用意に特定することができます。

19.17.1 ヒートマッププラグインの有効化

まず、プラグインマネージャ(QGISコアプラグインをロードするのセクションを参照)を利用して、この
プラグインを有効化する必要があります。すると、有効になったヒートマップアイコン|heatmap|をラスタ
ツールバーで見つけることができます。

Select from menu View → Toolbars → Raster to activate the Raster Toolbar when it is not yet activated.

19.17.2 ヒートマッププラグインの利用

The Heatmap toolbutton starts the dialog of the Heatmap plugin (see figure_heatmap_2).
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ダイアログには次のオプションがあります：

• Input Point Vector dialog: Provides a selection of loaded point vector maps.

• Output Raster: Using the button you select the folder and the name of the output raster the Heatmap
plugin will generate. It is not necessary to give a file extension

• Output Format: Selection of the output format. Although all formats supported by GDAL can be choosen,
GeoTIFF is most in cases the best format to choose.

• 半径: メートルまたはマップの単位で半径を与えるために使用できます。選択された半径が小さすぎ
る場合、あなたは良いヒートマップを得ることはありません。ポイントの周りの多くのサークルがお
互いに重なっ場所では明るいホットスポットが発生します！

• 減衰率: 中心からのヒートが減衰する率を示すのに使用します。

– When 0 is given (=minimum) the heat will be concentrated in the centre of given radius and be com-
pletely extinguished at the edge.

– 10が指定された場合（=最大）ヒートがエッジで濃縮し、中央では完全に消滅する。与えられた
値が高いと、効果がありません。

– When 1 is given the heat is spread evenly over the whole circle.

– 負の減衰率を指定した場合、ヒートマップではなくクールマップを作成できるでしょう！

When the Advanced checkbox is checked it will give acces to additional advanced options.

• 行と列は出力ラスタのピクセルサイズを変更するのに使います。行数と列数を多くすることは、ピ
クセルサイズを小さくすることを意味し、出力ファイルのサイズはより大きくなり、プロセスがやや
ゆっくり行われます。行数を２倍にすると自動的に列のサイズも二倍になり、セルサイズも二分割さ
れます。出力ラスタの領域は同じのままです！

• セルサイズ X と セルサイズ Y は出力ラスタのピクセルサイズに影響を及ぼし行と列の数を変更し
ます。

点ベクタレイヤはヒートマップを作成するために用いられる属性フィールドを持つかもしれません。

• 半径にフィールド値を使う:属性フィールドから半径を設定します。

• 重みにフィールド値を使う:属性フィールドから重み要因を設定します。

出力ラスタを与えたら**[OK]**ボタンを使ってヒートマップを作成することができます。この最初の結果
はグレーのサーフェスであり、ヒートマップを作成するための追加の処理が必要です。

警告: ラスタサイズプロパティの変更
ラスタライズプロパティを変更する場合、出力結果も変わります。ホットスポットエリアがより大きく
なります。

19.17.3 ヒートマップの作成

次の例では、QGISサンプルデータセット (サンプルデータを参照)の ‘‘airports‘‘点ベクタレイヤを使っていま
す。ヒートマップを作成するためのもう１つの優れたQGISチュートリアルは ‘http://qgis.spatialthoughts.com
<http://qgis.spatialthoughts.com/2012/07/tutorial-making-heatmaps-using-qgis-and.html>‘_で見つけることがで
きます。

Figure_Heatmap_1ではアラスカの空港が示されてます。

1. :sup:‘ヒートマップ ‘ツールボタンを押すことで、ヒートマッププラグインのダイアログが表示さ
れます (figure_heatmap_2を参照)　。

2. In field Input Point Vector select airpoirt from the list of point layers loaded in current project.
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Figure 19.28: Airports of Alaska

3. In field Output Raster give the name and location using the button of the output raster. Give the
output raster file the name heatmap_airports to give an file extension is not necessary.

4. :guilabel:‘出力形式 ‘では ‘‘GeoTIFF‘‘を選択します。

5. :guilabel:‘半径 ‘では ‘‘1000000‘‘メートルを設定します。

6. オリジナルの:guilabel:‘減衰率 ‘は ‘‘0.1‘‘が適当でしょう。

7. **[OK]**をクリックし、新しいラスタマップを作成してロードします ( Figure_Heatmap_3を参照)。

Figure 19.29: The Heatmap Dialog

ヒートマップを読み込んだ後の結果は、おそらく期待していたものと異なるでしょう。これはグレーのサー
フェスであり、（色に）バリエーションがありません。最初に、このレイヤのいくつかの追加設定は、ヒー
トマップが自分自身を表示するために行われる必要があります。

1. Open the properties dialog of layer heatmap_airports (select the layer heatmap_airports, open
context menu with right mouse button and select Properties).

2. Select the Symbology tab.

3. Change Color map from ‘Grayscale’ to ‘Pseudocolor’.

4. Press the [Apply] button.

5. Switch to the Transparency tab and set Global transparency to 40%.

6. **[OK]**を選択します。
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Figure 19.30: The heatmap after loading looks like a grey surface

最終的な結果は Figure_Heatmap_4に示してあります。

Figure 19.31: Final result of heatmap created of airports of Alaska

19.18 道路グラフプラグイン

道路グラグプラグインは C++で書かれた QGIS用のプラグインで,ポリライン上の任意の 2地点間の最短経
路を計算し,道路ネットワーク上にポリラインとプロットを作成し出力します

Main features:

• 経路,距離,旅行時間を計算する

• 距離または旅行時間で最適化する

• 経路をベクタレイヤとして出力する

• 道路の方向にハイライトを入れる (動作が遅いため,主にデバッグや設定確認目的に利用します)

QGISがサポートしているフォーマットでは、どんなポリラインのベクターレイヤでも道路のレイヤーとし
て使用することができます。共通のポイントを持つ２本のラインは接続していると見なされます。注意点
は、道路レイヤーを編集中にレイヤーの CRSをプロジェクトの CRSとして使用する必要があります。こ
れは、異なる CRS間の座標の再計算が、スナップを用いた場合でさえも不連続性をもたらし、エラーを引
き起こす事実によるものです。

次に示すレイヤ属性テーブルのフィールドが利用可能です
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Figure 19.32: Road Graph Plugin

• 道路の速度—数値フィールド;

• direction — any type, that can be casted to string. Forward and reverse directions are correspond to the
one-way road, both directions — two-way road

If some fields don’t have any value or do not exist — default values are used. You can change defaults and some
plugin settings in plugin settings dialog.

19.18.1 Using the plugin

After plugin activation you will see an additional panel on the left side of the main QGIS window. Now make
some definitions to the Road graph plugin settings dialog in the menu Vector → Road Graph.

道路ネットワークレイヤ上に始点と終点を設定し,**[計算]**をクリックしてください

19.19 空間検索プラグイン

空間検索プラグインは、他のレイヤを参照して、ターゲットレイヤで空間クエリを作成する（地物を選択
する）ことを可能とします。この機能は GEOSライブラリにもとづいており、選択したソースフィーチャ
レイヤに依存します。

利用可能な演算子：

• 含む

• 一致する

• 重複する

• 横切る

• 交差する

• 離れている

• 接する

• 範囲内
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19.19.1 Using the plugin

例として、我々は空港が含まれているアラスカのデータセット内の領域を見つけたい。次の手順が必要です：

1. QGISを起動してベクタレイヤ regions.shpと airports.shpをロードします。

2. Load the Spatial Query plugin in the Plugin Manager (see Section QGISコアプラグインをロードする)

and click on the Spatial Query icon which appears in the QGIS toolbar menu. The plugin dialog appears.

3. ソースレイヤとして regionsを選択し、参照する地物レイヤとして airportsを選択します。

4. 地物の場所で ‘範囲内’を選択し**[Apply]**をクリックします。

Now you get a list of feature IDs from the query and you have several options as shown in figure_spatial_query_1.

• :sup:‘リスト内のアイテムでレイヤを作成する ‘をクリックします。

• リストから IDを選択し|selectcreatelayer| :sup:‘選択からレイヤを作成する ‘をクリックします。

• Select the ‘Remove from current selection’ in the field And use the result to .

• さらに :guilabel:‘アイテムにズームする ‘か :guilabel:‘ログメッセージ ‘の表示を利用できます。

Figure 19.33: Spatial Query analysis - regions contain airports

19.20 SPITプラグイン

QGIS comes with a plugin named SPIT (Shapefile to PostGIS Import Tool). SPIT can be used to load multiple
shapefiles at one time and includes support for schemas. To use SPIT, open the Plugin Manager from the Plugins

menu, check the box next to the SPIT plugin and click [OK]. The SPIT icon will be added to the plugin
toolbar.

To import a shapefile, click on the SPIT tool in the toolbar to open the SPIT - Shapefile to PostGIS Import
Tool dialog. Select the PostGIS database you want to connect to and click on [Connect]. If you want, you can
define or change some import options. Now you can add one or more files to the queue by clicking on the [Add]
button. To process the files, click on the [OK] button. The progress of the import as well as any errors/warnings
will be displayed as each shapefile is processed.
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Figure 19.34: Using SPIT Plugin to import Shape files to PostGIS

ちなみに: Importing Shapefiles Containing PostgreSQL Reserved Words
If a shapefile is added to the queue containing fields that are reserved words in the PostgreSQL database a dialog
will popup showing the status of each field. You can edit the field names prior to import and change any that are
reserved words (or change any other field names as desired). Attempting to import a shapefile with reserved words
as field names will likely fail.

19.21 SQL Anywhereプラグイン

SQL Anywhere は、Sybase の独自のリレーショナルデータベース管理システム（RDBMS）です。 SQL
Anywhereは、OGCを含め、Shapeファイルなどの空間データをサポートしており、 KML, GMLと SVG
フォーマットへの出力機能が組み込まれています。

Figure 19.35: SQL Anywhere dialog (KDE)

The SQL Anywhere allows to connect to spatialy enabled SQL Anywhere databases. The Add SQL Anywhere
layer dialog is similar in functionality to the dialogs for PostGIS and SpatiaLite.

19.22 地域統計プラグイン

With the Zonal Statistics Plugin you can analyze the results of a thematic classification. It allows to calculate several
values of the pixels of a raster layer with the help of a polygonal vector layer (see figure_zonal_statistics). You can
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calculate the sum, the mean value and the total count of the pixels that are within a polygon. The plugin generates
output columns in the vector layer with a user-defined prefix.

Figure 19.36: Zonal statistics dialog (KDE)
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ヘルプとサポート

20.1 メーリングリスト

QGISは活発な開発が続けられています。それゆえいつもあなたが期待した通りに動作するとは限りませ
ん。推奨されるヘルプは QGISユーザメーリングリストへの加入です。あなたの質問は多くの人に届けら
れ、回答は他の人の利益になるでしょう。

20.1.1 qgis-users

このメーリングリストは QGIS 一般について、とりわけインストールや利用方法について
の話題が中心になります。 以下の URL から qgis-users メーリングリストに参加できます:
http://lists.osgeo.org/mailman/listinfo/qgis-user

20.1.2 fossgis-talk-liste

ドイツ語をしゃべる人のためにはドイツの FOSSGIS e.V.が fossgis-talk-listeメーリングリストを提供していま
す。このメーリングリストではQGISを含むオープンソースGIS一般について論議されます。fossgis-talk-liste
メーリングリストには以下のURLから参加できます: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

20.1.3 qgis-developer

もしあなたが開発者で技術的な問題に直面しているなら、ここの qgis-developerメーリングリストに参加
するといいでしょう :http://lists.osgeo.org/mailman/listinfo/qgis-developer

20.1.4 qgis-commit

QGIS コードレポジトリにコミットが行われるたびにこのリストにメールが送られます。あなた
がカレントコードベースを最新の状態にしておきたいならば、ここでこのリストに参加できま
す:http://lists.osgeo.org/mailman/listinfo/qgis-commit

20.1.5 qgis-trac

このリストはプロジェクト管理に関連した通知を提供します、そこにはバグレポート、タスク、リクエスト
機能が含まれます。ここでリストに参加できます:http://lists.osgeo.org/mailman/listinfo/qgis-trac
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20.1.6 qgis-community-team

このリストでは文書、コンテキストヘルプ、ユーザガイド、webサイト、ブログ、メーリングリスト、フォー
ラムを含むオンラインの情報や翻訳についての話題が交わされます。もしユーザーガイドについてなにか
をしたい場合はこのリストがあなたの質問をあつかう適切な場所です。このリストにはここで参加できま
す:http://lists.osgeo.org/mailman/listinfo/qgis-community-team

20.1.7 qgis-release-team

このリストではリリースプロセス、様々な OS 向けのバイナリのパッケージングの話題と
世界に向けての新リリースアナウンスを行います。以下の場所でこのリストに参加できま
す:http://lists.osgeo.org/mailman/listinfo/qgis-release-team

20.1.8 qgis-tr

このリストでは翻訳作業についての情報を扱います。マニュアルやグラフィカルユーザーインターフェー
ス (GUI)の翻訳作業を行いたい場合、このリストがあなたの質問に適したスタートポイントです。ここか
らリストに参加出できます： http://lists.osgeo.org/mailman/listinfo/qgis-tr

20.1.9 qgis-edu

このリストは QGIS の教育についての情報を扱います。もし QGIS 教育用マテリアルを作成したい場
合はこのリストがあなたの質問に適したスタートポイントです。ここからこのリストに参加できます：
http://lists.osgeo.org/mailman/listinfo/qgis-edu

20.1.10 qgis-psc

このリストは運営委員会の討議に利用されます。ここでは Quantum GIS のプロジェクト管理
や方針に関するすべてのことが議論されます。このリストには以下の場所で参加できます:
http://lists.osgeo.org/mailman/listinfo/qgis-psc

あなたはどのリストに参加しても歓迎されます。質問に回答してあなたの経験を共有することで貢献でき
ることを覚えておいてください。 qgis-commitと qgis-tracは通知専用にデザインされており、ユーザの投
稿用ではないことに注意して下さい。

20.2 IRC

私たちは IRCも維持しています - irc.freenode.netの#qgisチャンネルに加わってみてください。チャンネル
に参加している人達は他のことをやっているのであなたの質問にレスポンスがあるまでしばらくお待ちく
ださい。それは他の人があなたの質問に気づくまでの時間です。 QGISのコマーシャルサポートもありま
す。詳細については、WEBサイト http://qgis.org/en/commercial-support.htmlの情報を参照して下さい。

もし IRCに失敗した場合でも問題ありません! 私たちはすべての会話をログにとってあります。ですから
あなたは簡単に追いつくことができます。それにはここにいってみて http://logs.qgis.org、 IRC-logsを読ん
で下さい。

20.3 BugTracker

メーリングリストは一般的に ’QGIS で xyz はどうやるのか ’というような質問のためには便利であ
るとともに、あなたは QGIS 内のバグを通知したいと思うでしょう。 はなたは QGIS のバグレポートを
https://trac.osgeo.org/qgis/のトラッカーで登録することができます。新しいバグのチケットを作成した時は
追加情報をリクエストできるように emailアドレスを提供して下さい。
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あなたの報告したバグがあなたの望む優先順位で処理されないことがあることを、どうか気になさらない
でください (そのバグの重大性に依存します)。いくつかのバグは開発者に対して多大な労力かけるのでい
つもそのようにできるわけではありません。

将来実装してほしい要望についてもバグと同じようにチケットで登録できます。 ‘‘Feature‘‘というタイプ
のチケットを選択して下さい。

もしあなたがバグを発見してご自身で修正した場合はパッチも登録することができます。再度ですが、愛
らしいトラックチケットシステムは https://trac.osgeo.org/qgis/で利用できます。 patchをタイプメニューで
選択して下さい。開発者の誰かがそれをレビューして QGISに適用するはずです。あなたのパッチがすぐ
に適用されないようなことを心配しないでください— 開発者は他のコミットメントで手が離せないので
しょう。

20.4 Blog

QGIS-communityはウェッブログ (ブログ)を http://blog.qgis.orgで運営しています。ここではユーザや開発
者にとって興味深い記事が掲載されています。あなたは登録するとブログへの記事投稿に招待されます！

20.5 Plugins

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.

20.6 Wiki

私たちはWIKIウェッブサイトを http://www.qgis.org/wikiで運営しています。ここでは QGIS開発、リリー
ス計画、ダウンロードサイトへのリンク、 メッセージ翻訳のためのヒント等多彩な有用情報があります。
ここを調べると中にはすばらしいものがありますよ！
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Chapter 21

付録

21.1 GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION
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0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or exe-
cutable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,
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(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and “any later version”, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTH-
ERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGES.

Quantum GIS Qt exception for GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code
of this program with the Qt library, including but not limited to the following versions (both free
and commercial): Qt/Non-commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded
(or with modified versions of Qt that use the same license as Qt), and distribute linked combinations
including the two. You must obey the GNU General Public License in all respects for all of the code
used other than Qt. If you modify this file, you may extend this exception to your version of the file,
but you are not obligated to do so. If you do not wish to do so, delete this exception statement from
your version.

21.2 GNU Free Documentation License

Version 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

<http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying
it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.
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This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers
to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related
matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be
a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical,
ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is
called Opaque.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format,
LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML,
PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF
and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word pro-
cessors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-
generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.)
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To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many
as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses
a copy of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.

3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.
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7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the “History” section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and pre-
serve in the section all the substance and tone of each of the contributor acknowledgements and/or dedica-
tions given therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

13. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

14. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant
Section.

15. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections
as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from
the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections
of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents,
make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author
or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in
the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming
one section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections
Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other respects
regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in
or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the
compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket
the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the
terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright
holders, but you may include translations of some or all Invariant Sections in addition to the original versions of
these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation and the
original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (sec-
tion 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt
of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a
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proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained
in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify this doc-
ument under the terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no
Back-Cover Texts. A copy of the license is included in the section entitled “GNU Free Documentation
License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with ... Texts.” line with
this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and
with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.
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